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Important and general information

1
1.1

Important and general information

Important information

Please follow these instructions before and during the use and application on any IPETRONIK
product!

1.1.1 Safety and Warning instructions

Please follow the instructions and information as contained in the user manual!

1.

The user can influence an electronic system by applying the IPETRONIK product. This might
cause risk of personal injury or property damages.

The use and application of the IPETRONIK product is permitted only to qualified professional
staff, as well as, only in appropriate manner and in the designated use.

Before using an IPETRONIK measurement system in the vehicle it has to be verified that no
function of the vehicle, which is relevant for secure operation, might be influenced:

- by the installation of the IPETRONIK measurement system in the vehicle,

- by an potential malfunction of the IPETRONIK system during the test drive.

In order to avoid possible danger or personal injury and property damages, appropriate actions are
to be taken; such actions have to bring the entire system into a secured condition (e.g. by using a
system for emergency stop, an emergency operation, monitoring of critical values).

Please check the following points to avoid errors:

- Adaption of sensors to components of the electrical system / electronics, brake system, engine
and transmission control, chassis, body.

- Tap of one or several bus systems (CAN, LIN, ETHERNET) including the required electrical
connection(s) for data acquisition.

- Communication with the vehicle’s control units (ECUs), especially with such of the brake system
and/or of the engine and transmission control (power train control system).

- Installation of components for remote data transmission (mobiles, GSM/GPRS modems, WiFi
and Bluetooth components).

IPETRONIK devices are designed for applications in extended temperature ranges > 70 °C

(158 °F). A high environmental temperature and the module’s self-heating may cause burns of the
skin when touching the hot surface. In order to avoid the risk of injury we recommend to take care for
appropriate safety precautions (e.g. contact protection, covering/enclosure, warning sign, ... )..

Before directly or indirectly using the data acquired by an IPETRONIK measurement system to
calibrate control units, please review the data regarding to plausibility.

With regard to the application of IPETRONIK products in vehicles during use on public roads the
manufacturer and/or registered user of the vehicle has to ensure that all changes/modifications
have no influence concerning the license of the vehicle or its license of operation.

User does agree to the instructions and regulations as mentioned above. In case the user does
not agree with the instructions and regulations as mentioned above, he has to notify this expressly
and immediately in writing to IPETRONIK before confirming the sales contract.

1.1.2 Liability, Warranty, Copyright, License agreement

Please refer to http://www.ipetronik.com/en/terms-conditions for detailed contract information:

» Limitation of liability

»  Warranty

» Copyright and Duplication

» Software license agreement

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 71175
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Important and general information

1.2 General information

1.2.1 About this manual

The manual describes the structure of the IPEmeasue data logger devices M-LOG / M-LOG V3, S-LOG,
FLEETIlog / FLEETIog2 and IPElog / IPElog2, as well as, peripheral devices and accessories components.

© 2018 All rights reserved !

IPEmotion Plugin IPETRONIK-LOG

Descriptions in this documentation refer to the current release. Please note, that the logger requires the
corresponding application software TESTdrive.

To run this Plugin an release = IPEmotion 2017 R1 has to be installed on your computer.

IPEmotion

Contents described in this document relates to the release versions IPEmotion 06.00.00 (2016) to IPEmotion
07.02.00 (2017 R3).

IPEmotion 2017 requires Microsoft .NET 4.5.1 Framework. This version is no longer supported by Windows
XP.

1.2.2 Legend of used icons

Tip This icon indicates a useful tip that facilitates the application of the software.

Information This icon indicates additional information for a better understanding.

Attention! This icon indicates important information to avoid potential error messages.
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1.2.3 New features, Changes

Please also refer to the latest release notes at:
c:\Program Files (x86)\IPETRONIK\IPEmotion Plugin IPETRONIK LOG V03.5x.xx\Help\

Plugin IPETRONIK-LOG V03.60
No. Feature
1 Plugin LOG / X in parallel

2 openABK functions

Plugin IPETRONIK-LOG V03.59

No. Feature

1 IPElog2 access point

2 IPEwifi V3

3 Transfer category FTP server

4 Transfer category LOG files

5 XCP: Disconnect Second Tester
6 ECU CCP parameters
7 UDS security access
8 SFTP resume

9 Transmit traffic messages
10 IPElog2 gyro sensor

11 Data transfer parameters
12 Project properties

13 Plugin LOG / X in parallel

Plugin IPETRONIK-LOG V03.58
No. Feature

1 Cisco VPN removed

2 SW filter frequency selection

3 Export of channel comments

4 New OBD channels
Radius calculation (polar)

6 Angle calculation (polar)

IPEmotion Plugln IPETRONIK-LOG

Release January 2018
Description

Activating the Plugin IPETRONIK-LOG and the Plugin
IPETRONIK-X (simultaneous operation) is supported.

Implemented functions of the logger display & control concept
openABK buttons, openABK DHCP server, openABK unique
names

Release November 2017

Description

WiFi access point support

External device for WiFi data transfer with M-LOG V3

Up to 3 categories can be assigned to an FTP server

Up to 3 categories can be assigned to the log file

Delay time after the the second tester will be disconnected
Optionally use CCP parameters from ECU

Security access for the UDS protocol

Resume is active: The data transfer will be continued where it has
been stopped with the previous transfer.

Resume inactive: A corresponding and already existing file on the
FTP server will be overwritten.

Transmit messages in traffic groups

Support of IPElog2 internal gyro sensor

Default values for data transfer parameters have been adapted
Project properties are no longer stored in mea_conf

Plugin IPETRONIK-LOG and IPETRONIK-X activated in parallel
might cause software problems

Release February 2017
Description

Cisco VPN settings will be deleted when loading a former
configuration (GUI access no longer supported).

Software filter frequency now as drop-down menu selection

Activation at Options > Plugins > IPETRONIK LOG > IPEmotion
settings > Options > Extended > IPETRONIK CAN, default =
deactivated

Supported PIDs: 102 - 106, 108 - 110, 112 - 124, 127, 131
Radius = SQRT( "phi_y" * "phi_y" + "phi_z" * "phi_z")
Angle = IF( "phi_z" >=0; ACOS("phi_y" / "Radius" ) * 180/PI; -1 *
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ACOS("phi_y" / "Radius" ) * 180/PI + 360)

Calculation ISNOVSALUE ISNOVALUE (x;y), NoValue detection with delay
External video data storage Storing video data on external USB medium
9 Sign-of-live Connecting status between logger and web interface
10  Measurement status file with New entry wake up reason:
wake up reason Unknown/ Remote/ Wake On CAN/ No Message Lost/ Wake On

RTC/ Modem (SMS)/ low voltage
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Plugin IPETRONIK-LOG V03.58

No.

11

12

Feature
TESTdriveCmd DataTransfer

Remote2 (M-LOG V3, IPElog2)

Plugin IPETRONIK-LOG V03.57

No.

1

10
11

Feature

IPElog2 support

Quickstart data options
Available WLAN networks

New UDS super job
UDS check string
Indication of CAN/LIN bus activity

Hardware description file

Data post processing

Use last value from previous
measurement

Category overview
XCPonUDP import

Plugin IPETRONIK-LOG V03.56

No.

a A WO N -

Feature

Multi CAN-Send

GPS channels added
openABK capable display
Logger status info

IPEconnect access point

J1939 extension

UDS extension Second Tester

IPEmotion Plugln IPETRONIK-LOG

Release February 2017 (continuation)
Description

The new parameter ,transfer” controls the data post processing.
Depending on its status (true/ false) zipped and splitted files will
be copied to the USB stick subsequently.

2nd input in addition to the control input Remote 1 (e.g. ignition
line 15) as OR-conjunction solely supported with the
Power-IN/Remote connector of M-LOG V3 and IPElog2

Release July 2016
Description

Hardware type 10x CAN, 6x LIN, 2x ETH, WLAN
Hardware type 16x CAN, 2x ETH, WLAN

Off, During boot-up, During boot-up + Measurement Stop-Start

Cyclic SSID scan provides latest WLAN status information (logger
with built-in WLAN unit required)

PST_LESEN_UDS 2
Comparing the ,SearchString“ of the UDS job and the ECUs reply

Creating status entry in Log file / Measurement status file once the
timeout delay of the respecitve CAN/LIN input expired

New backup of the HW_descr.xml prevents from illegal access

User configurable Start Delay / Retry Delay time (range 10's ...
5 min) to trigger the parallel data post processing

Using the last value from previous measurement as start value for
a signal calculation within the current measurment

Selection list for the data transfer category

Import of A2L description files using an USB2ETH adapter

Release April 2016

Description

CAN node supporting multiple CAN-Send blocks

GPS latitude in degrees, GPS longitude in degrees

Support of the openABK protocol V1.0 for EMBU-SYS displays
Web interface showing logger status information and signal list

IPEhub2 supports access point operation for online data
visualization with mobile devices (smartphone, tablet)

Event triggert measurement in signal mode

Configuration of an additional tester ID
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Important and general information

Plugin IPETRONIK-LOG V03.55

No.

a A WO N -

10

11

12

13

14

Feature

M-LOG V3
FLEETIog2-03

IPElog 6x CAN, 6x LIN
M-VIEWfleet, scaling
USB video

Mail groups, recipients list
Serial number specific

program/configuration update
(mcf, fcf, rtb, prg)

Import of PDX files
NoValue group

Send category ,NoTransfer*
CCP, XCP second tester

CCP, XCP EPK missmatch

New parameter <meaNumber>
for TESTdriveCmd.xml

IPEconverter

Plugin IPETRONIK-LOG V03.54

No.

1

Feature

M-LOG 6 CAN
M-LOG 3 CAN/1LIN

New CAN devices

Diagnostic measurement

CAN Timeout value

DAQ polling groups (polling list)

Seed&Key file using the XCP
protocol

XCPonCAN extension

CAN-Send extensions

IPEmotion Plugln IPETRONIK-LOG

Release August 2015

Description

Support of new data logger M-LOG V3

Support of FLEETIog2 with D Sub D connector (CAN, DI/O)
Data logger IPElog providing 6 CAN and 6 LIN inputs available
Multipoint scaling for M-VIEWfleet supported

- Support of multiple USB cameras via USB hub
- Support of Logitec QuickCAM VisionPro (DID 0x09A6)

Separate list of mail recipients per mail group

Verification of the logger serial number for program/configuration
update (mcf, fcf, rtb, prg). In case of missmatch, the latest valid file
is used.

One or more PDX files can be imported for each CAN node

Extended NoValue monitoring with with new data group ,NoValue
group® (Logger processing). User defined formulas for trigger
conditions are supported.

Additional send category ,NoTransfer” in order to exclude user
defined data from transfer.

Check for second tester connected to the bus before starting ECU
communication.

Selectable behaviour in case of EPK missmatch. (default setting:
proceed measurement)

The service <dataTransfer> now provides the new paramater
<meaNumber> in order to send defined mea files in advance (per
modem), instead of at the end of the test drive trip.

Refer to manual IPEconverter V03.55 for latest extensions

Release November 2014
Description

Support of new M-LOG measurement interfaces

Support of M-SENS2 250 Hz, M-UNI2, M-THERMO2 HV,
CANpressure 150 bar

Set trigger conditions to start diagnostic jobs

User defined value for the timeout. Without a valid signal value
after the timeout has expired, the system will indicate “NoValue”

ECU signals can be allocated to different polling groups. Up to 4
groups can be defined by user

Set file location for the Seed&Key file.

New Protocol status channel with XCP, CCP, KWP, UDS

New columns bit count and data format added
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Important and general information

Plugin IPETRONIK-LOG V03.54

No.

9

10

11

12

13

14

15

16

15

16

17

18

19

20

21
22

Feature

Statistic Group (Min/Max list)
(STG file)

File transfer categories

Disable USB stick data exchange

Logger reset
IPEcloud

J1939 extensions

DLM

XCPonCAN and XCPonUDP with
additional storage rates

IPElog extensions
WakeOnSMS
Rescue configuration
Provider blacklist

Time zone status information

exFAT format of the SSD card
used with IPElog

S.MAR.T.

Event based measurements in
MDF4 data format

Count ECU data requests

Mail groups

IPEconverter extensions
ASAM ATF/XML export
DIAdem TDM/DAT export
CSV, Excel2003/2010 export

Plugin IPETRONIK-LOG V03.53

No.

1

Feature

LOG2PC (ETH communication)
IP 239.192.0.5 at port 7302

TESTdrive update to V03.53.xx

IPEmotion Plugln IPETRONIK-LOG

Release November 2014 (continuation)
Description

Activation of the min/max list calculation has been modified.
Requested signals can be assigned to max number of 4 statistic
groups.

Storage, traffic and statistic groups can be asigned to a file
transfer category. Each of 3 categories can uses a data transfer
medium (LAN, WLAN or COMgate).

Automatic data download / configuration upload can be
enabled/disabled with the Plugln options settings.

Reset the logger to factory default settings (DIN 01 = active)

Define access parameters for data download from FTP server.
Measurement data can be iported directly using IPEmotion‘s Data
manager and Analysis tools.

Activate J1939 protocol information
DM1 messages conversion methods

Optional path for user operations (DLM)
C:\Users\Public\Documents\IPETRONIK\IPEmotion\Custom\User
Operation

30/min, 12/min, 6/min, 1/min, 2/h, 1/h

Start IPElog per SMS from standby mode
Export rescue configruation
Create provider blacklist to exclude them for data transfer

Enable the use of time zone status information (UTC status) with
the Plugln options settings

Format SSD drive using the exFAT data format which support
memory sizes up to 512 Terra bytes

Support of Self-Monitoring, Analysis and Reporting Technology
with the appropiate storage medium

Channels of a CAN measurement with disabled cyclic acquisition
(Event controlled) will be stored using the MDF4 format.

All ECU data requests (means successful and unsuccessful
attempts) will be logged.

Support of sending e-mails parallel to data post processing.

NoValue handling, grouping mode
new data format types
V-TAB scaling, rounded floating values

Release April 2014
Description

The UPD based protocol uses multicasts now, Firewall settings
must not refuse the use of this port/IP.

Execute inital update of the logger software by USB stick.
Following updates are supported by LOG2PC as usual.
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Important and general information

Plugin IPETRONIK-LOG V03.52

No.

1
2

10
11

12

Feature
FLEETIog2 support

CAN-Send extensions

J1939 extensions

OBD 2 extensions

External storage medium (USB)

Traffic measurement extensions

CAN ID assignment

Measurement stop with
automatic restart

New status signals
New calculation

Hardware license information

Licensing of traffic groups

Plugin IPETRONIK-LOG V03.51

No.

1
2

Feature
PIN assignment
Traffic storage groups

Extension for IPElog
(requires PIC =2 V01.01.07,
FPGA =V01.02.08

CCP
Upload and download

Event controlled measurement

Masks

File name length

Stop date, Stop time
PreTriggerTime, PostTriggerTime

IPEmotion Plugln IPETRONIK-LOG

Release December 2013
Description
Data logger FLEETIogZ2 is supported now

Send counter with individual settings for start bit, bit length, and
data format, Signal output with individual settings for start bit, bit
length, and data format in expert mode

J1939 protocol including DM1 signals
refer to separate documentation J1939_DM1

Single PID, status channel, trigger conditions

Selectable for signal and traffic storage groups
TESTdriveCmd.xml required

Ring buffer, Filter functions

Automatic assignment during system identification > IPEmotion
Options > Plugln specific settings

StopStart event (logger processing) stops the current
measurement and restarts immediately

Video file size, Measurement number, OBD-2 processing
INT_ADD()

Logger context menu Extras shows hardware license information
from the description file (hw_descr.xml)

License verification of storage and traffic groups

Release July 2013

Description

FLEETIlog and IPElog added

Traffic measurement now support different storage groups

NoMessagelLost function (NML)

WakeOnCAN can be activated for each channel

up to 6 ID triggers

Logger restart using WakeOnCAN or remote signal

CAN-ID trigger now StartNotStopTrigger (instead StartOnly)
PIC update per job executable

Status indication of the flap for the storage medium with
M-VIEWfleet

Command CCP_DISCONNECT implemented
Supported with different transfer media (Modem, WiFi)

CAN data acquisition based on traffic measurement but handled
as signal measurement (DAT format)

for CAN identifiers are supported now

Up to 260 characters are allowed for file names of the external
library and configuration files.

Stored as project property with the traffic file
Supported as project property
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Important and general information

Plugin IPETRONIK-LOG V03.50 Release October 2012
No. Feature Description
1 Notes
Version reference Logger Plugin = 3.5x requires IPEmotion = 2.xx
SC1200 M-LOG with SC1200 is no longer supported
IPElog Requires TESTdrive / Plugin IPETRONIK-LOG = 3.5x
2 Status signal "FIFO overrun” Indicates the data processing status.
Output 0 = OK, Ouput 1 = processor overloaded
3 Debounce time of the remote Configurable delay time within a range of 0 ... 5 seconds. The
signal signal status ist valid if the remote signal lasts for this time
without interruption.
4 Extensions TESTdriveCmd.xml New jobs "OnOK" and "OnError" used for audible alarm of the
job "OnConnect"
5 Differnt init modes for module Connected IPETRONIK modules will be initialized on
initialization command: Never, Once-only, Always.
6 Status e-mail with snap shot report  Each time the trigger condition is fulfilled, the current signal
values (configured in the mail group) will be sent per mail.
7 Limit display with M-VIEWvga Indication of limit violation has been revised.
8 V-TABs enable clear text display Individual text can be assigned to different signal values (or

ranges) which is respectively displayed (instead of digits).
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Important and general information

1.2.4 Support
Headquarter:

IPETRONIK GmbH & Co. KG
Im Rollfeld 28

76532 Baden-Baden, Germany

Phone +49 7221 9922 0
Fax +49 7221 9922 100

info@ipetronik.com
www.ipetronik.com

Limited commercial partnership with its head office in Baden-Baden, registry court HRA No. 201313

IPETRONIK Verwaltungs-GmbH Baden-Baden is an individually liable society, registry court Mannheim HRB
No. 202089

CEOs: Andreas Wocke, Christian Buchholz

Technical support and product information

www.ipetronik.com e-mail: support@ipetronik.com

1.2.5 Related documentation

IPEmotion

The documentation IPEmotion.pdf provides you with a description and useful information related to
IPEmotion. This documentation is stored in the following standard language dependent directory:
C:\Programs\IPETRONIK\IPEmotion Vxx.xx.xx\Help

1.2.6 Documentation feedback

At IPETRONIK, the technical publications team strives to produce documentations of the highest quality and
values your feedback as a reader and user. If you have any comments or suggestions regarding our product
manuals, contact us under support@ipetronik.com .

When commenting on our products, please include the following information:
Version number
Name of the guide
Page number or section title

Brief description of the content (e.g. inaccurate instructions, grammatical errors, or information that
require clarification)

Any suggestions for a general documentation improvement

IPEmotion Plugln IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 16/ 175
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System basics

2 System basics

2.1 Data logger applications (extract)
2.1.1 Configuration, Online measurement using Ethernet

2.1.2 Fleet data logger
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System basics

2.2 Connecting devices via CAN bus

2.2.1 CAN bus basics

CAN-Standard

The communication of the IPETRONIK SIM and M devices takes place by using the CAN bus according to
the CAN 2.0 A (11 Bit Identifier) and CAN 2.0 B (29 Bit Identifier) specification. Each software application,
which is able to process CAN data through a suitable interface
can acquire measurement data from IPETRONIK CAN devices.

User data within the CAN message:
A CAN message can transfer 8 values in

Structure of a CAN message Byte format resp. 4 values in Word format.
CAN 2.0A (11 Bit Identifier) CAN 2.0B (29 Bit Identifier)
Bits Description Bits Description
1 SOF Start of Frame 1 SOF Start of Frame
11 ID Identifier 11 ID Identifier
1 RTR Remote Transmission Request 1 SRR
1 IDE Identifier Extension (0) 1 IDE Identifier Extension (1)
18 ID Identifier (extended)
1 RTR Remote Transmission Request
1 r1
r0 1 r0
4 DLC Number of following data bytes 4 DLC Number of following data bytes
64 Data Data bytes —_— 64 Data Data bytes
15 | CRC | Error Identification Code 15 CRC Error Identification Code
2 ACK Acknowledge 2 ACK Acknowledge
10 | EOF End of Frame, Inter frame space 10 | EOFS End of Frame, Inter frame space
110 Total number of bits 130 Total number of bits
\ 4
Word Byte Bit (Message layout in the displaying format ,,Intel Standard*)
0 0 7 6 5 4 3 2 1 0
1 15 14 13 12 11 10 9 8
1 2 23 22 21 20 19 18 17 16
3 31 30 29 28 27 26 25 24
2 4 39 38 37 36 35 34 33 32
5 47 46 45 44 43 42 41 40
3 6 55 54 53 52 51 50 49 48
7 63 62 61 60 59 58 57 56
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System basics

Access to the CAN bus, Transferring properties

The CAN bus allows a safe and effective data transfer of the connected devices (non-destructive bitwise
arbitration = resource distribution to different devices). The CAN bus is therefore used as a standard
communication medium in the automotive area and the industrial automation.

The most important characteristic CAN bus properties are:
» Every bus participant (node) can send, as well as, receive.

» First of all, the node, which wants to send, needs the authorization. All participants become
automatically a recipient (There is no abortion of the data sending process > non-destructive
collision).

» No stations are addressed but messages.
» Every message is characterized by its name (Identifier).
» The less the identifier, the higher the message priority.

» A message can transport up to 8 * 8 Bit = 64 Bit (8 Byte) user data, whereas each message
requires 110 Bit or 130 Bit (Extended ID).

» Depending on the hardware and the bus line length, up to 1 MBit/ s can be transferred.
The following important conclusions result from the properties above:

» The less the bus load, the less the probability of a “Bus access conflict” (you can call this a real- time
capable area).

» A high bus load forces stations to loose messages with a high identifier or to send them more
slowly. Messages with a high identifier can “get lost”.

» Not sent messages are only registered by the “Recipient node” because data are missing. If no
timeout has been defined, the last valid value is generally sent, i.e. a mistakenly constant value.

Transfer rate, Bus line length

The CAN bus supports a max. transfer rate of 1 MBit/s according to Norm ISO 11898-2.
This value is limited in practice by the following points:

» the bus line length

» the branch line length to the CAN stations

» the bus lines quality and the plug contacts

» the bus line design (twisted, single or two-wire bus)
» bus connection structure and

» type and strength of external perturbations

Example

Data rate on the bus 1 MBit/s = 1 us/Bit

Data length of a CAN message 130 Bits total

User data in a message 64 Bit = 4 values with 16 Bit resolution each
Time for a CAN message 130 Bit x 1 ps/Bit = 130 ys/message

i.e. 4 values require 130 ps
Calculating the total sampling rate 130 ys match 7.69 kHz

Converted to one channel 4 x7.69 kHz = 30.76 kHz
Theoretical transfer rate 30 channels with 1 kHz = 30 kHz
Practical experiences 26 channels with1 kHz = 26 kHz

(The value is lower at guaranteed synchronity.)

If CAN messages are not completely used (e.g. only three 16 bit values instead of four per message), less
data can be transferred although the sum sampling rate has not yet reached the maximum. This also applies
if different sampling rates are defined in one system, because the data division to the CAN messages is not
time-optimized (minimum time required).
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System basics

2.3 Ampacity and voltage drop

Besides the fact that the max. bus line length is defined by the desired data transfer rate, the ampacity and
the voltage drop in the system have primarily to be checked. This is especially important for systems with a
high number of devices and/or long connections lines of the devices (e.g. distributed systems with
connection lines of 3 m (9.84 ft) and more between the device groups). Additional actions should be taken
accordingly to the situation.

2.3.1 Ampacity

The maximum current via the M-CAN system cables (e.g. 620-560.xxx) is 4 A (heat generation by transition
resistances of the plug contacts).

The system capacity and therefore the power consumption can approximately be calculated by using the
number of devices (including the sensor supply). A direct power acquisition in the real system provides exact
values.

We recommend one or several of the following actions if the limit value is exceeded:

» Increasing the supply voltage of the devices (e.g. 24 V DC power supply or 42V DC
instead of 12 V)

» Centered voltage supply via T connection or as close as possible to the devices with high
power requirements (rather than at the beginning or end of the system chain)

» Additional system supply via a T connection at a suitable position

2.3.2 Voltage drop

Even if the limit value for the ampacity is not reached, long lines in an extensive system can cause
perturbations in the acquisition process. This mainly applies to devices at the end of the system chain,
because the voltage of the last devices does not exceed the input threshold of 9 V (due to a high voltage
drop in the system).

We recommend one or several of the actions mentioned above.

The voltage drop can be calculated by using the following formula:

U=RxlI
R =2 X Rcable [o/im] X Lengthcapie [m)

1= |:’Devices W] / UDevices V]

For estimating the voltage drop, a resistance of

> 50 mQ/m for the M-CAN cables and
> 35 mQ/m for the SIM-CAN cables

can be used including the transition resistances of the plug contacts. Systems, which are in the limit range of
the voltage drop, should be controlled in individual cases. To do so, our support will be pleased to assist you.

As the power consumption of a device depends on the supply voltage, it is useful to calculate the voltage
drop from the chain end to the feeding point. In this case, a minimum voltage of 9 V is set to the last device
and the required excitation is calculated. The calculated value should be generously rounded upwards for
guaranteeing a safe operation.

Another fact is the variable internal resistance of the input power supplies (low excitation = lower internal
resistance).

In practice, this means: If the net excitation decreases (e.g. because of a weak power supply or a high
resistivity with long cables), the devices have to readjust to cover the current power requirements. This
causes a higher power consumption, which additionally increases the voltage drop.
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Data logger M-LOG, S-LOG, FLEETIlog/FLEETIlog2, IPElog

3 Data logger M-LOG, S-LOG, FLEETlog/FLEETlog2, IPElog

3.1 Overview
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Data logger M-LOG, S-LOG, FLEETIlog/FLEETIog2, IPElog

Device

Driver display system

Interface aption 1

Interface aption 2

Interface option 3
Interface option 4

Interface option 5

Extender boxes

Protocols and traffic
CCP / XCPon CAN
J1939

GW-LAN

OBD

WWH-OBD

KWP on CAN

Ups / ODX / PDX
KCPonETH

FlexRay / XCP on FlexRay
MOST (25 7 150)
openhABK

SOME [P

FlexRay traffic

CAN traffic

LIN traffic

CAN traffic send
Wireless communication
GMNSS [Global Navigation
Satellite System)

Gyro sensar
Wik

Madem

VPN tunnel

IPEcloud / FTP server
Video

IP-Camera (RTSP protocol)

USB Video Class (UVC)

IPElog?2

IPEmetion app /
openABK
10 CAN + 6 LIN +
7 ETH
16 CAN + 2 ETH

FlexRay-Extender

20 Hz (GPS)

100 Hz

2.4 GHz
(WiFi 80211 b/g)
3G (UMTS /HSDPA)

IPEmotion Plugin IPETRONIK-LOG

IPElog

IPEmotion app /
openABK

12 CAN + Z ETH

FlexRay-Extender

1 Hz (GPS)

2.4 GHz
(WIFi 80211 b/ g)
3G {UMTS)

IPETRONIK GmbH & Co. KG

M-LOG V3 FLEETlog2

IPEmation app / IPEmotion app /

openABK opanABK
12 CAN 4 CAN
8 CAN+ 4 LIM
8 CAN + Z ETH
6 CAN + 2 LIN +
ZETH
4 CAN + 2 ETH
FlexRay-Extender ,
COMgate V3,
IPEWiF
| |
| |
] ]
| |
| |
] ]
| |
| |
|
| |
| |
| |
1 Hz (GPS) 1 Hz (GP3)
2.4 GHz
via COMgate V3
(WIFI 80211 b/g)
via COMgate V3 3G (UMTS)
via COMgate V3
| |
| |

ipetronik.com

IPEhub:2

IPEmotion app

7 CAN

2.4 GHz
(WiFi 80211 (b/g)
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Data logger M-LOG, S-LOG, FLEETIog/FLEETIlog2, IPElog

Data transfer range of built-in modems (FLEETIlog, IPElog)
Quad-Band EGSM 850 /900 / 1800 / 1900

Frequency range

Download rate
UMTS/HSDPA (WCDMA/FDD) 2100 MHz

GPRS multi-slot class 12

Edge multi-slot class 12

3.2 Hardware

3.2.1 Block diagram

HSDPA 7,2 Mbps

The block diagram shows the basic structure of the logger board.

9V_42V F— Modem-PWR __ ~g
W) L
Temperatur A
__ REMOTE S| [revperau} iR >
Super — GPS-PWR -
10 = -
Realtime 12C Bus COM 1
COM 2 »
 COM2Z
FLAsH (e X86 UART I*' AN WALAN
Gy i LI —
PCI (32 Bit/33MHz) > & USB Keyboard y,
Bios usB USB Stick
o
USE Stek
Slot1 || Slot2 Slot 3 FLASH
- |V X-Board
<
4 CHN2Z ] DIG OUT 0-3
- — O g DICOUTOS
< CHN3 | & - @Diﬂ
CHN 4 T w 8 3 DIG IN 0-3
“ gl <G
T
e CHNGB (optional) A MIC -
- . — Sound Headset >
Ethemet . (optional) ELASH
- T M-LOG

3.2.2 Enclosure types

M-LOG PRO08

M-LOG with port replicator PR05

IPEmotion Plugln IPETRONIK-LOG

FLEETlog2

S-LOG front view

IPETRONIK GmbH & Co. KG

IPElog

FLEETIog front and rear view

ipetronik.com
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Data logger M-LOG, S-LOG, FLEETIog/FLEETIlog2, IPElog

The M-LOG enclosure is compatible to all M devices. The devices can be easily connected with each other
with a dovetail adapter. M-LOG is available with 6 different port replicators (cable connecting adapter). User
specific port replicators are available on request.

The FLEETIlog2 hardware concept was designed for using the data logger in vehicle fleets, whereas
FLEETIog2 WAN is already equipped with modem, WiFi client, and GPS receiver.

3.2.3 Port replicators and cables

Various cables are available for every port replicator. The complete
PIN configuration, as well as, the appropriate cables of the PR05 and
PRO8 port replicators are shown in the appendix.

3.2.4 Device panel for changing the internal memory card

S-LOG and M-LOG (M-LOG with Upgrade Kit 300) offer a screwed panel for exchanging the cF memory
card if required.

The FLEETIog is equipped with a cF card slot behind the folding front panel.

IPElog has a screwless fixed front panel with open/close contact for exchanging the SSD memory card.

Please note the advice to only change the memory card in exceptional cases because of a
possible intrusion of foreign material, dirt or water into the device and the logger could be
damaged at removing the cF card. The regular data transfer should be done with the USB stick
or the wireless connection (modem or WiFi option).

3.2.5 External fuse for logger protection (IPElog, M-/S-LOG, FLEETIog)

Depending on the number of inputs, capacitor charge, and connected devices (M or SIM
devices, Modem, GPS receiver), the total power consumption (especially at temperatures of —
40 °C /-40 °F) can reach up to approx. 150 Watt. To protect the total system, we recommend
an external overload protection with the following tasks:

» Protection of the supply line in error case
» Overload protection of the current source
» Logger protection.

We recommend using a LittleFuse ATO Fuse Fast Acting Type with a nominal current of 10 A. At using
the maximum charge in ambient temperatures under —40 °C / -40 °F, it can be required to increase the
nominal current to 15 A.

The individual electric circuits (also see M-LOG Port replicators, S-LOG = PR05) are internally
protected. The internal resistance of multifuse types increases exponentially and limits the
current to a minimum. After clearing the cause of error, the resistance decreases to the normal
value (automatic resetting).

The motherboard fuse does not work reversibly and must be replaced in the case of a required
repair.
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Data logger M-LOG, S-LOG, FLEETIog/FLEETIog2, IPElog

3.2.6 Additional short-circuit protection for IPElog and FLEETIlog

As the M-CAN connection is not fused by the logger, we recommend to use the cable M-CAN Cable
M-CAN/PWR-Fuse (No. 620-677.xxx) in order to prevent the logger from damage caused by a short circuit.

5 A regular ATO fuse

3.2.7 LED status display (flashing codes)

LED display

YELLOW

Mode

Ready or
operating

Warning |
Low voltage

Warning Il
Low voltage

Measurement
running

Data medium
access
(post processing)

Data transfer

Error,
Emergency
operation

3.2.8 Power-down at excitation loss

M-LOG, S-LOG, FLEETIog and IPElog are equipped with high-powered capacitors, which guarantee a short
excitation in the case of an excitation loss for regularly shutting the system down without data loss. The
storage capacity of the capacitors depends on several points (e.g. ambient temperature, aging, charge
condition). A data loss can therefore not completely be excluded in the case of a total excitation loss.

M or SIM devices, which are supplied by M-/S-LOG, FLEETIlog C2 or IPElog, are immediately switched-off at

excitation loss.

Meaning

Device is ready
(Operation: see yellow LED)

The excitation is between 6 V and 9 V. M-
LOG shuts down after 2 minutes at
unchanged status.

The excitation is under 6 V. M-LOG is
buffered by the internal supply and normally
shuts down.

The logger writes the data to the internal
memory.

Prepare file transfer (zip, split)

Transfer files via USB, modem, or WiFi

e.g. at invalid configuration, at less memory
capacity, at emergency shut-down due to
less excitation

A restart is required..

We recommend to revise the switching and the buffer capacitors every 2 years for guaranteeing
a clean functionality. The device calibration every 2 years includes this revision.

IPEmotion Plugin IPETRONIK-LOG

IPETRONIK GmbH & Co. KG
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Data logger M-LOG, S-LOG, FLEETIog/FLEETIlog2, IPElog

3.3 Initial start-up

3.3.1 Connecting the logger

»

Connect the red socket using the
Power/Remote cable (e.g. 620-574.xxx)
with an appropriate power supply

(9 Vpg -.- 36 Vpe)

PWR+ = Voltage supply Plus
GND = Voltage supply Minus
Shield = Shield or voltage supply Minus

Connect the white socket using the
LAN cable (e.g. 620-591.xxx) with the
Ethernet interface of a PCs/Notebook,
resp. using the LAN cable

(e.g. 620-355.xx) for connection to

a network.

Switch on the logger
REM = Ignition line 15 or power supply Plus via switch
— green status LED lights continuously

Logger starts up and will enter the measurement mode after a short time.
— yellow status LED lights continuously

Refer to the Flow chart of the measuring
process in the appendix for more details.

Useful notes

If the Ethernet connection to the logger will not work properly, at first transfer the correct IP settings to
the logger using an USB stick. Refer to Add logger system, creating test configuration (USB stick).

Using the cable 620-591.xxx LOG Cable ETHERNET (crosslink) is a point-to-point connection
between logger and PC. A fixed IP address is required for both. Refer to Static and dynamic IP
addresses.

When connecting the logger and the PC used for configuration and data acquisition to a network with
DHCP server, both have to be set to dynamic IP address, in order to receive the individual IP address by
the DHCP server automatically.

In this case use cable 620-355.xxx M-LOG PR05 ETH Cable RJ45.

Please consider the risk of IP conflicts (same IP address may exist twice), if you use static IP address
settings when connected to a network with DHCP support.
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Data logger M-LOG, S-LOG, FLEETIog/FLEETIlog2, IPElog

3.3.2 Detecting the logger, creating test configuration (Ethernet)
» Start IPEmotion at your PC/Notebook.

! Using Logger Plugln version = 3.50, IPEmotion = 2.0 is required.

» Activate the Plugin IPETRONIK-LOG.

Options > Plugins > IPETRONIK LOG

! The Plugin IPETRONIK-LOG version 3.50
and higher requires TESTdrive = 3.50 on
the logger. Please update the logger
application if necessary!

» Select the main tab Signals .

» Click Detect to identify the connected
hardware components.
The / all available logger(s) will be displayed in a select list.
Confirm your selection by activating the corresponding checkbox and
click OK. The configuration settings stored on the logger will be readout
and displayed.

» Activate the status signal
CPU load.

> Mark the logger at the left hand
structure top area and scroll the
signal list downwards to CPU load,
hook Active to enable the
checkbox.

» Select ETH from the left hand
tree structure, right click and
choose > Add components

> XCP service from the context
menu

» Select DAQ list slow from the
left hand tree structure, right click
and choose > Add components
> Channels from the context menu

» Mark CPU load and confirm
by clicking OK.
» Mark the logger from the left hand
tree structure top area. Click Start displaying from the tool bar.

» Once the logger has been initialized, the current value of the CPU load is displayed continuously in the
signal list. Now logger's ETH communication test and online data streaming via XCP service has been
completed succesfully.
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3.3.3 Add logger system, creating test configuration (USB stick)

In case the data acquisition or the Ethernet connection is not working properly (e.g. when using obsolete /
former configurations, incompatible IP address settings, ...), we recommend to transfer a valid (already
succefully tested configuration) per USB stick to the logger.

» Create a logger system:
Select from the main tabs
Signals > Add system > e.g.
M-LOG (4CAN)

» Enter the front number of the
logger you will use:
> Mark the logger at the left
hand structure top area and
choose the Extended tab to set
the last four digits of the logger's
serial number using the field
Front number.

» Select the Data manager tab
and activate the check box
Update connection
parameters and click to
Configuration

» Enter valid settings for the IP
address used for the Ethernet
connection (auto IP or fixed IP) as described at Static and dynamic IP addresses.

» Create a test configuration.
» Save the current configuration settings in the project (*.icf).

» Export the project as measurement configuration (TSTdrive.mcf) to an
individual subdirectory located on your Notebook/PC or direct to an
USB stick.

» Unplug the USB stick from the configuration PC.
»  Switch on the logger.

» Plug in the USB stick while the logger is running in measurement mode (yellow LED lights). The logger
will stop measurement an start data postprocessing, existing data will be moved to the USB stick. This
process lasts as long as the yellow LED is flashing.

» Then the logger will search for a new measurement configuration on the USB
stick. If a new configruation is found, the application on the logger will be
updated and the origin TSTdrive.mcf on the USB stick is deleted.

»  Wait until the yellow LED lights nor flashes not any longer and unplug the stick.
The logger will switch to measurement operation again.

After all necessary connection parameters have been updated with valid settings (logger, PC), a
communication via the LAN cable is supported, including these actions:

» transfer a new configuration to the logger,
» detect the logger and read the configuration from the logger,

» transfer measurement data from the logger to the PC (import measurement files).
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3.3.4 Static and dynamic IP addresses

Basically IPETRONIK data loggers can be connected to other network clients via Ethernet in two different
ways:

» Point to point connection between the logger and the PC/Notebook.
Usually neither the logger nor the PC/Notebook supports DHCP (Dynamic Host Configuration Protocol),
it is necessary to set a fixed IP address for both.

» Client to client connection between logger and PC/Notebook through a local network. In this case the
network server provides DHCP and manages the automatic IP address assignment to all network clients.
Therefore logger and PC have to use dynamic IP address settings.

Use the Data manager tab to enter
the settings for the logger:

» Mark the logger at the left hand
tree structure top area.

» Select the Data manager tab
from the right hand down area
(configuration tabs).and activate
the check box Update
connection parameters.

» Click Configuration.

» Choose the tab Medium
selection and activate LAN.

» Refer to the dialogs below
for dynamic (Get IP address
automatically) and static IP
address settings.

» When using the static IP address
with the logger, it is necessary to
adapt the system control settings
of the PC/Notebook,

For example:
IP address: 192.168.0.100
Subnet mask: 255.255.255.0
1= Data transfer configuration: 80001707 = [ = E 1Pz Data transfer configuration: 80001707 = || [= E
General || Medium selection | LAN General || Medium selection | LAM
Get IP address automatically: I,\@ Get IP address automatically: [
IF address: |0.0.0.0 IP address: [192.168.0.101
Sub net mask: |0.0.0.0 Sub net mask: |255.255.255.0
Standard gateway: |0.0.0.0 Standard gateway: |0.0.0.0
Preferred DNS server: |0.0.0.0 Preferred DNS server: |0.0.0.0
Alternative DNS server: (0.0.0.0 Alternative DNS server: (0.0.0.0
Speed and duplex mode: |Auto - Speed and duplex mode: |Auto -
Import Export oK Cancel Import Export Ok Cancel
Settings for dynamic IP address Settings for static IP address
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3.3.5 Logger web interface for status and signal monitoring

The logger service web site provides status information,
the log file and a listing of all measured signals.

An extra configuration by IPEmotion is not necessary.
To start the site web just enter the logger IP address in
the URL command line. The individual IP address of the
logger is available from the ETH interface settings in the
system structure of the logger configuration

Please also refer to 11.1.2 Status information

Using the logger system with IPEhub2 and a mobile device (smartphone, tablet) or PC with WiFi port, a
wireless access to the status web site and a user specific measurement data visualization is supported.

Refer to 9.2 IPEconnect (Online display with Smartphone or tablet) for details
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3.3.6 Logger system with CAN modules

All IPETRONIK CAN modules (M-Series, SIM-Series, CANpressure, MultiDAQ, High Voltage Iso DAQ ...)
are connected to the data logger with corresponding system cables.

Connecting the modules

» Daisy-chain the modules among one another
and connect the system with its
respective cable to the logger.

» The end of the module chain has to
be terminated with a termination
plug.

» Using M-LOG or S-LOG the 2nd
CAN bus socket has to be
terminated also
> use M-CAN or SIM-CAN
termination plug.

Usually all IPETRONIK CAN modules are connected to the logger through the system
connectors M-CAN resp. SIM-CAN with S-LOG. Thus they can be detected and configured by
IPEmotion in a user-friendly way. Besides this, it is also possible to connect IPETRONK
modules, as well as, non-IPETRONIK CAN modules to a free CAN measurement input.
Please note, that you need a separate cable to supply the modules with power for this.
Configuration of the modules is done manually or by importing a CANdD file.
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Detecting modules, creating test configuration

1. Select the CAN input to which the devices are
connected to (CAN 01 is recommended because
it is connected with the M-CAN or SIM-CAN
socket at the logger).

2. Select Extras from the context menu (right
mouse button).

3. Select Detection to detect the connected
devices and to transfer the current settings to the
configuration.

MultiDAQ is detected as IPETRONIK CAN device
from TESTdrive V03.22!

» Execute Detection of connected modules as described.

» Configure the modules and the logger (activate channels, set signal
scaling, select sample rates, create storage groups, ...)

» Save the current project.

» Initialize the Logger (working Ethernet connection required) or transfer
the configuration per USB stick to the logger.

To display measurement data acquired by the logger using the Ethernet connection, you have
fo add an XCP service at first. Assign all signals to the DAQ lists of the XCP service which you
want to be displayed.

The Options setting Automatic service administration will automatically create an XCP
service and assign all active signals to the DAQ lists.

3.3.7 Access to data stored on the logger
The logger stores all data in a Zip archive on internal storage medium (cF card, resp. SD card with IPElog).
MEA_xxxx.zip measurement data + header file + current configuration

LOG_xxxx.zip logfile with status reports of the data acquisition

A measurement file (archiv file) is empty, if the sum of the file contents calculated from the files
listed below is 0. In this case, the respecitve zip archive will be deleted.

- all files containing storage groups except the DAT files
- all trace files (BD...)

- all statistic files except the DAT files

- Min/Max statistic file (STG)

- Audio/Video files except the DAT files (AVI,WAV,IMG)
- Traffic files (BIN, Quickstart)

- LOG file

- Measurement status file

- PPP debug file (PPP...)

Access (= data transfer to a PC or FTP server) to data stored on the logger is supported:
» per USB stick

» through an Ethernet cable connection

» using COMgate or an internal/external WiFi client

» using COMgate WAN or an internal/external modem
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Using a LAN cable connection

Import measurement files / log files

1. Select Signals navigation tab.

2. Select logger in the left Systems
overview.

3. Transfer the current data (internal
memory) in the Signals navigation tab to
PC with Import > Measurement files.

4. Transfer the current data (internal memory
+ pre-/post-trigger data)) in the Signals
navigation tab to PC with Import >
Measurement files (incl. ring buffer).

5. Transfer the current TESTdrive log files in
the Signals navigation tab to PC with
Import > Log files.

6. Select the target directory or crate a new
folder to save the respective data.

With USB stick

Plug in the USB stick to the running logger. The logger stops data acquisition, saves data, log files and the
related configuration to the stick. If the yellow LED is not permanently on, disconnect the USB stick. The
logger runs now in acquisition mode..

Please note that data can only be imported via USB if no LAN connection to the logger is
activated. Disconnect the logger with the logger context menu.

3.3.8 Synchronizing the logger time
» Mark the logger at the left hand structure top area.

» Right click to the logger entry and select
Extras > Synchronize logger time from the context menu.

Time data of time stamp and log messages have been normalized. Now time stamp output is
local time (former UTC). Time stamps reported in XML files always indicate the offset (time lag)
to UTC time, e.g. <startdate>2012-04-25T09:30:10+01:00</startdate>

In order to ensure a correct time interpretation of recorded data, the IPETRONIK data converter
IPEconverter V02.13 is required.

3.3.9 Readout Hardware and license information
Using the Ethernet connection (LOG2PC)

» Select the data logger on the top left area.

» Select Extras > Hardware and license information from the context menu by right-clicking.

Hardware and license information file (hw_descr.xml)

» Select the data logger on the top left area.
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»

»

Select Extras > Hardware and license information from file from the context menu by right-clicking.

Look for the file hw_descr.xml locally or on a USB stick.

Plug a USB stick into the running data logger to retrieve the license file (together with
configuration and acquisition data). Unplug the USB stick from the logger and plug it into a PC.
Go to the directory named with the logger’s serial number, then go to the DEVICE subdirectory.
The zip file TSTdrive contains the hardware/license file hw_descr.xml.

3.3.10 Updating the measurement application (TESTdrive) per USB stick

Measurement application TESTdrive

»

Copy the file MLogger.rtb (standard, inclosed in the TESTdrive_xxx.zip) or Logger.prg (for M-
VIEWgraph, inclosed in the Setup_xxx.exe of the respective Plugln) to the subdirectory named with the
logger's serial number on the USB stick.

Power up the logger and wait for the yellow LED which indicates data acqusition.
Plug in the USB stick to the logger, program update will start automatically.

Wait until the yellow LED lights no longer and unplug the USB.
The logger executes a reboot and starts measuring operation with the new application.

Measurement configuration (logger specific)

»

»

4

Copy the file TSTdrive.mcf to the subdirectory named with the logger's serial number on the USB stick.
Power up the logger and wait for the yellow LED which indicates data acqusition.

Plug in the USB stick to the logger, configuration update will start automatically. As soon as the update
has been completed successfully, the TSTdrive.mcf will be deleted from the USB stick.

Wait until the yellow LED lights no longer and unplug the USB.

Measurement configuration (single USB stick used for different loggers)

»

»

4

Copy the file TSTdrive.mcf to the root directory on the USB stick.
Power up the logger and wait for the yellow LED which indicates data acqusition.

Plug in the USB stick to the logger, configuration update will start automatically. The TSTdrive.mcf will
remain on the USB stick, whether the update has been completed successfully or not.

Wait until the yellow LED lights no longer and unplug the USB.

Repeat this procedure for any other logger update relating to this configuration

Serial number specific update

When updating via USB/FTP, the system checks, if the file name consists of a 8 digit serial number. Update
is executed when the serial number matches with the logger, the file is deleted from the source directory
afterwards. In case of missmatch, the latest valid file is used. Files with invalid serial numbers will remain in
the source directory.

When the file contains no serial number information, the standard update process is executed (equal to
previous TESTdrive versions).
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3.3.11 TESTdriveCMD.xml

The file TESTdriveCMD.xml controls user access of the logger. If the restriction has been activated, the
logger searches for the TESTdrivecmd.xml at the root directory of the USB stick. Measurement will not be
started when the file is missing.

Activate the use of the TESTdrive commands at IPEmotion Options > Plugins > IPETRONIK LOG >
Settings e > Options > Activate TESTdrive access restriction.
The following templates are located at:

..A\IPETRONIK\IPEmotion PIugIn IPETRONIK {#= IPEmotion settings - IPETRONIK LOG
LOGV03.xx.00\Data\TESTdriveCMD\[language]

Guest (directory ,,guest®)

Options | Components

General
4 Copy data Activate TESTdrive access restriction:
» External Storage Encoding of the configuration files: O
User (directory ,,user®) Encoding password: ~ |Eeesssss
» Update measurement configuration SELJiEsss i O
Complete system configuration files: O

» Update measurement configuration, Copy data

. . Create status file:

» Update measurement configuration, Copy data .
incl. PostMortem NoValue alarm timeout [s]: 2
MNoValue start delay [s]: 0

» Update measurement configuration, Move data

» Update measurement configuration, Move data,
incl. PostMortem

» Start logger in FTP mode

» Set the logger's system time
Administrator (directory ,,admin®)

» Update measurement application

» Update measurement application, Delete data

» Update measurement application, Update measurement configuration, move data
» FPGA update

Parameter of the “dataTransfer” service

<meaNumber>

If this parameter has not been defined, all data will be transferred. Valid values of this parameter are "all"
(not case sensitive) and a number between 0 and 9999. This parameter can be used multiple times. The
applied sequence has no effect on data transmission. The data transfer starts with the measurement data file
named with the lowest number in ascending order.

The file TESTdriveCmd.xml will be deleted from the server as soon as it has been transferred successfully. It
will be deleted from the local source if all <meaNumber> entries have been processed. The file name prefix
“TESTdriveCmd" is required, the file extension has to be“xml”. If the file name consists an 8 digit number
(e.g. TESTdriveCmd_12345678.xml) the logger will take this as serial number. The file will accepted only if
the serial number from the file name fits to the loggers serial number. If not, the file will be ignored and
remains on the FTP server.

The existing parameters <zip>, <crypt>, <split>, <move> and <useTimeDir> will be ignored. They will be
considered only if this service is applied by an USB stick. In this case, the TESTdriveCmd.xml remains
unchanged, as usual before and it will not be deleted.
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<transfer>

This parameter controlls the data transfer following to the data post processing (zipping, splitting, copying).
Valid values are "true" and "false". If the parameter is not configured, its value is set to "true" per default.

"true" Zipped and splitted (if required) files are copied to the USB stick.

"false" No measurement data is copied to the USB stick.
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4 External connection

41 Grounding

It is absolutely necessary to connect the logger case with a suitable ground pin within the
overall system. Without this grounding, EMV disturbances and uncontrolled voltage
interferences can restrict the measuring process.

4.1.1 IPElog, M-LOG grounding connection

IPElog and M-LOG provide a grounding tap by a blade terminal.
Use a 6.3 mm blade receptacle to connect the grounding tap.

4.1.2 FLEETIlog grounding connection

FLEETlog2 has four M4 threaded holes at each side which are
used to tighten the mounting brackets. We recommend to use an
appropriate ring tongue terminal with one of the side screws for
grounding the logger case. A fork tongue terminal can also be used.

4.2 PWR /Remote connection

4.2.1 PWR/REM cable 620-574 PWR+

PWR-

REM

Shield

Always switch on and off the logger using the REM (ignition line 15) connector, never by
switching the PWR+ line!

Never disconnect the PWR- (GND) line while the logger is running, because this will damage
electronic circuits. Switiching-on/off the logger via PWR- (GND) is absolutely not allowed!
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4.2.2 Remote connection

| |
[
| 1 2
[
[
: Remote  —< [
[
[
| electron. control
| | —~ Il e g. ECU of the
| vehicle
[
: Power IN + —< :
: min.6 Vv (9 V) | al al
| max. 55 V I T - o
[ : T PWR
| PowerIN- — | — . o
| ' i

The logger has internal buffer capacitors to avoid a data loss due to sudden voltage losses. The
regular shut-down is executed via remote and not by switching-off the excitation!

The activating via a remote impulse (impulse length > 20 ms) is also supported. But the
continuous remote signal must be received within 60 s, otherwise the logger is shut down by
the watchdog.

Example:

Start of measuring system with opening the vehicle door. The continuous remote signal is
received at motor start and the system continues measuring. If the continuous signal is not
received (no motor start), the logger shuts down after 60 s.
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4.3 Digital input/output connection

potential free contact with
external excitation up to 42
V without any resistor or
voltage divider

LOG-PWR switched logger excitation (not stabilized)
The excitation is supplied, as soon as, the logger is activated.
4.3.1 Connecting example digital input
external switch external switch + external switch +
(potential-free) external voltage external voltage
up to 42 V max. above 42V
LOG-PWR H vce
c —o0
~
I = 5 MA : vCce
L1 rd o
I \Y
L DIN-1
|y | 4 gBIH:%; Additional
r DIN-4 bridge from
| DIN-GND to
C PWR-GND at o o
DIN-GND PRNN PRN1I GND GND

Terminal 15 of the board
electrics (all vehicle power
supplies up to 42 V without
any resistor or voltage
divider)

The digital inputs are electrically isolated but the respective DIN-GNDs are all connected to one

PIN of the Sub D socket! This PIN has a direct connection to PWR-IN GND with the PR0O3,

PRO04, PR05, PRO06 port replicators!
The inputs are protected by an internal 5 mA current limitation.

Required minimum values at the input for a clean functionality:
Unin =3V bzw. I, = 2 mA

4.3.2 Connecting example digital output

external LED or
external relay +
external voltage
up to 42 V max.

external LED, or
external relay
(potential-free)

LOG-PWR
,
Y

I 7 30 MA X N vee

—i—{"1—o
DOUT-1
| LERE

GND (ground) switched
Ri=20Q

~
v | LI\_L DOUT-4
—_— _( O
DOUT-COM | GND
¢
C
DIN-GND

external LED or
external relay +
external voltage
u 42V

external LED, or
external relay
(potential-free)

V+ (excitation) switched
Ri=20Q

pto max.
DIN-GND X
e Ll
~ ™~
o = 30 MA GND
e [1oR] —] 1+Pt—o
1 DOUT-1 W
DQUT-2
Y &| (DQUT-3
AUAS | LI |:| gooum
—_— \_L_( O
DOUT- COM | oo
e
~
LOG-PWR

The digital outputs are electrically isolated and can operate bipolarly but the respective COM

ports are all connected to one PIN of the Sub D socket!

IPEmotion Plugln IPETRONIK-LOG IPETRONIK GmbH & Co. KG

ipetronik.com

39/ 175



External connection

4.3.3 Connecting example external status LED

external LED
(potential-free)
LOG-PWR

LED-1 > green

(LED-2 > yellow)
SZ:{K (LED-3 > red)

I = 30 MA
e

— r
— AS

SMD 0.1 A XX

e 11
~ T~
DIN-GND

4.4 Bus inputs

4.4.1 Connecting example CAN bus

4.4.2 Connecting example LIN bus

CAN input

CAN+ N
7 1
R120 :".
Term.L‘;'
CAN- - N

4

CANGND

”

Vehicle

L— Shield/Chassis

Due to the galvanic isolation, the transceiver of the LIN measurement input must be power supplied by an

external source. This can be:

1. Connection of the vehicle’s bus power supply (Vesupply)

or

2. Connection of the logger’s power supply (bridge from PIN 5 to PIN 1)

Variant 1: Connect Vg of the external LIN bus

IPEmotion Plugln IPETRONIK-LOG

Variant 2:

IPETRONIK GmbH & Co. KG

Supply via logger

(bridge from PIN 5 to PIN 1)

ipetronik.com

40/ 175



Configuration with IPEmotion (extract)

5 Configuration with IPEmotion (extract)

The IPEmotion software is required for configuring a logger measuring system and the corresponding
IPETRONIK devices. The software must be installed on the notebook/PC, which is used to configure. (See
the instructions in Commissioning). IPEmotion also supports the online data measurement with using the
XCP service. You can find a detailed description of IPEmotion in the manual, which can be opened in the
software as a PDF.

5.1 First steps
5.1.1 Main dialog

After the start of IPEmotion, the following screen appears.

Main Navigation Tabs Quick Access Bar

~

Main window at selected tab “Signals”

Message window

IPEmotion automatically detects all available hardware connections at starting.

If you want to reduce the required time, select Options > Pluglns for deactivating those
interfaces, which are not used.
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5.1.2 The Title Bar

The title bar contains the quick access bar, the software name, as well as, a tool bar with the following

functions:

E Help — Open the documentation IPEmotion.pdf where you can find useful information for a

and clean application of the software.

= Minimize — Minimize the application window of IPEmotion and place it in the task bar of your
desktop.
El Maximize — Make the application window visible on your desktop and refit the prior size.

E Close — Close the application of IPEmotion.

5.1.3 The file menu

The file or application menu contains basic functions as: New, Open, Save, Save As,
Runtime version, Print and Close, as well as, further properties such as View,
Options, Support file and About.

The right partial view of the application menu contains a list of the recently used
projects.

The View function contains the menu points Message window and the Reset
command. Show or hide the message window and reset the displaying configuration to
the default parameters.

5.1.4 Using the options

With the Options entry, you have the ability to edit user defined settings. You can
define the following options:

» Frequently used
» Basic settings
» View

» Data manager

» Analysis
» Units
» Plugins

The following section offers you a detailed overview over the available setting options.
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Frequently used

Activate or deactivate Start with the latest configuration and define the settings for the automatic
hardware detection. Activate or deactivate the automatic hardware detection at start of IPEmotion and
select a possible standard command after successful detection:

Basic settings
Select a preferred configuration type: Hardware configuration or signals configuration

Activate or deactivate the options: Accurate acquisition chain required and Expert mode.

Expert mode

The protocol nodes of imported description files (CANdb, A2L, FIBEX,...) are visible, this
means, the user has access to the signal properties.

With the protocols CCP and XCP the DAQ lists are displayed and can be processed (delete,
move signals).

With the release of IPEmotion V01.07.00 internal channels (-> Variables) for temporary storage
tasks have been implemented. Managing this variables is only supported with an enabled
Expert mode.

Activate the Automatic service administration option to automatically import the active channels into the
DAQ lists of the XCP service. These channels are then available in online view.

Please note the restrictions depending on the Ethernet interface of the PC and the number of
active channels. In this case, it is recommended to manually import the required channels info
the DAQ lists of the XCP service (deactivated Automatic service administration)
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View

Define your view settings according the following listed points:

Language selection Skin selection Displaying tooltips

Font size of the visual elements Transparency of configuration dialogs (0 — 30 percent)

Activate or deactivate the use of the Windows standard dialogs for the file and directory selection.

Data manager

Define the Time channel format as Relative or Absolute (This setting is currently not supported for the
export into external formats!) and activate or deactivate the option: Merge time channels with equal
acquisition rate.

Analysis

Select the points per diagram graph. Define if all signals are considered in the analysis diagrams at
drawing the graph or only the samples. Move the bar accordingly to the preferred speed or quality.
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Units

Get an overview according the common physical values and their respective unit and edit them.

Activate this Plugln for all logger
applications.

The corresponding TESTdrive
Plugins version must be available at the
logger!

Activate or deactivate the hardware systems to be used.

Clicking the wrench symbol o enters the dialog for Plugin specific settings provided by the tab Options
and Components.

Components

With the Settings button, you have the ability to define the components (module type and priority, e.g. for
the type selection of the Dry configuration) of the respective hardware system and to edit additional options
settings.

The selection of the hardware components for the configuration by using a signal library is based on the
Priority. This preselection with a priority assignation of the system components facilitates the device
selection and improves the system speed.

The High priority defines a preferred use of the corresponding hardware component at configuring with a
signal library. The hardware components, which are defined with the Not used priority, cannot be selected
for an acquisition.
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Options

= IPEmotion settings - IPETROMIK LOG

Cptions | Components

General Detection mode
Ackivate TESTdrive access restrickion: | () Logger with serial number:
Encading of the configuration files: O @ Selection by dialog

&l logagers

Encading of the system files: O Importing mode
Complete system configuration files: O ) Move
Create skatus file: O g ;:noqpufre

Mo alue alarm tirmeout [5]:

Maoalue skark delay [s]: ,D—| Extended

| Open syskem setup

anooo00n

Tirne Zone
Time zone: |(GMT+DI:DD) Alsterdam, Berlin, Bern, Rome, Stockholm, Yienna - |
Surmmer birne aukomatics O

CE

| | Cancel |

Extended options

Pz Extended options - 0O x

Video input |

Maximum memory space: | 1000 MB

Maximum memory space (external): | 1000 MB
Maximum file length: | 1000 MB

Audio input |

Maximum memory space: | 40 MB
Maximum file length: | 6 MB
Sensitivity: | 67

Audio output |

Volume: | B7
Delete audio files: |+

Other 4
System check enabled:
Use serial number as export file name:
Show export dialog:
Handle limits synchronausly: [+

Waiting time for audio and video trigger: | 1,55

Postprocessing delay: | 1 ms

Start processing delay: | 20s

Retry processing delay: | 15 min
ECU init timeout: | 10 s
Extended comments:
Use project parameter names:
Transfer TSTdrive.zip to USB: |+

Power out for display: | Undefined -
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Pz Extended options - O x

Retry processing delay: | 15 min

ECU init timeout: | 10 s
Extended comments:
Use project parameter names:
Transfer TSTdrive.zip to USB: |+

Power out for display: | Undefined -
Activating this check box will execute
IPETRONIK CAN an automatic CAN ID assignment
Activate auto CAN ID after detection: < starting with the predefined ID for
Start CAN ID: | 10 connected and identified modules.
IPEconf2 conform CANdb export:
CSV import mode: | Default A

Channel comments:

XCP service L. .
Data transmission rate settings
2o | - slow: 1..5Hz
Medium rate: | 10 Hz € medium: 10 ... 50 Hz
Fastrate: | 100 Hz - fast: 100 ... 1000 Hz

Send categories
Category 1: | Category 1
Category 2: | Category 2
Category 3: | Category 3
Category Off: | NoTransfer
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5.1.5 Creating a support file

With the Support file entry of the application menu, you
have the ability to create a support file and add and/or edit
own comments and error descriptions.

Enter in the appearing Create support file screen an error
description. Accept the default location for the file. To
select another location click on the = symbol.

After you have specified the location and a user defined
file name, click Save to return to the Create support file
screen.

== Create support file E

Description:

File:

OK Cancel

After clicking on OK a zip file is generated that contains the error description, as well as, the following

information:

» System information (Windows version, computer name, free memory on the local drives, ...)

» Current configurations (acquisition, online view, script configurations)

» Trace files (NET, C++)

If you have any problems while working with IPEmotion, send us this support file at

support@ipemotion.com.

IPEmotion Plugln IPETRONIK-LOG
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5.1.6 IPEmotion working areas (main navigation tabs)

The main navigation tabs allow a quick activation of the different main functions of IPEmotion. A tab
displayed in light blue indicates an active function.

IPEmotion is designed to follow the main navigation tabs from left to right. Use this reasonable order like a
read thread, which guides you step-by-step to a successful acquisition.

Project | Signals

Acquisition | View Data Analysis | Reporting | Scripting | Info
manager

Project
Signals
Acquisition

View

Data manager
Analysis
Reporting
Scripting

Info

Project

Define your general user defined project data.
Configure the connected acquisition systems and modules.
Configure the desired storage groups and channels.

Take a measurement defined by the connected hardware modules and the set
configurations.

Manage your stored acquired data in all the supported formats.
Visualize your channels with diagrams.

Create reports and project documentations.

Automate your acquisition sequences.

Get a basic overview and general support.
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Signals

System tree

5.1.7 Info

The chapter offers a basic overview of the IPEmotion software. In addition, it shows useful advices and tips
and tricks on how to use IPEmotion.

The view Info is divided into the following menu points:

4
4
»

IPEmotion Plugln IPETRONIK-LOG

Welcome

Release Notes (only in English)
Red thread

Tips and tricks

Keyboard handling
Documentations

Contact and support

Channels

Configuration dialogs

IPETRONIK GmbH & Co. KG ipetronik.com
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5.2 Logger settings
General

\

Highlight the logger in
the system overview to
fade in the configuration
tabs

Extended
General Extended System activated Data manager Loqg file cateqories
Front number: | 1109
TESTdrive version: Update
Appendix; Remove
Rescue configuration:
Time zone: |From options

Surnmer time automatic:

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG
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Front number:

TESTdrive version:

Appendix:
Rescue configuration:

Time zone:

Summer tine automatic:

System activated

Switch-on condition (WakeonCAN):
Timeout:

Mew measuring file number:

Start with number:

Follow-up time:

Transfer unit switch-on condition:

Cydical data saving:

Switch-on condition (WakeonCAN):

Timeout:

Switch-off condition:

New measuring file number:

Start with number:

Follow-up time:

Transfer unit switch-on condition:

Cyclical data saving:

IPEmotion Plugln IPETRONIK-LOG

The last four digits of the logger serial number.

Version of the TESTdrive application running on the logger. With a hard-
ware detection through a LAN/WLAN connection, the current version is
indicated. A mouse click to Update will upload the latest version.

Transfer a user specific file to the logger.
Store rescue configuration on the logger (fall back)

Applying the Plugin settings defined under Options > Plugins
> Plugln-specific settings > Time zone

Automatic switch-over winter time <> summer time

Extendec System activated Data manage Log file categories

Start-Stop Switch-off condition:

s

| Open the dialog for WakeupOnCAMN and NML configuration

10s

Postprocessing i

Selecting the CAN bus(es) to be used for boot up the logger by
the WakeonCAN feature.

The logger waits this period for the remote signal resp. bus activity.

User defined condition (trigger, formula) to be used to switch-off
the logger. In case a remote signal (REM = ignition line 15) is still
high, the logger will shut down and power up again.

Consecutively numbering of measurement data files beginning
with the predefined start number.

Start number for the consecutive measurement file numbering

When the switch-off signal has been identified, the logger waits this
period (and keeps on operating) before shut down.

Switch on the WiFi client respective the modem for wireless data
transfer by the logger.

Acquired data is continuously stored to the measurement data file
(not only by stopping the measurement).
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Data manager

-

=t vetem 3

|Ipdate connection parameters:
Compress files:

Indude configuration file:
Indude log file:

Parallel data transfer:

Data interface:

Update connection parameters:

Compress files:

Include configuration file:
Include log file:

Parallel data transfer:

Data interface:

Log file categories

MoTransfer:
Category 1: |+
Category 2:

Category 3:

NoTransfer:
Category 1:
Category 2

Category 3:

tivated Data manager

i

v Configuration

| Configuration of connection parameters

* LAM
WiFi

Enables the access to connection parameters settings by use
of the Configuration button.

Activated the compressing of measurement data files

Includes the DAQ configuration (CFG_xxx.isf) in the measurement
data zip file xxx_MEA_xxx.zip.

Includes the DAQ log file (MEA_xxx.log) in the measurement
data zip file xxx_MEA_xxx.zip.

Enables data transfer simultaneous to a running data acquisition

Selection of the communication interface (LAN, WLAN)

Select the Data manager
tab and click Configuration

Senera Medium selection LAT Maodem Categories
Medium Category 1 Category 2 Category 3
Modem | ™ 1

Exclude selected data from transfer.
Assign storage groups, log file, ... to the data transfer category #1
Assign storage groups, log file, ... to the data transfer category #2.

Assign storage groups, log file, ... to the data transfer category #3

Data groups can be linked with a single or multiple data transfer categories.

Although a single or multiple data transfer categories can be assigned to a data transfer
medium (LAN, modem), a specific category can be assigned to a single medium only.
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6 Basic functions

6.1 Switching-on / switching-off

Description of the supported switching-on / switchting-off modes

6.1.1 Ignition line 15

Remote 1 (Ignition line 15) o
n
z & TS 5
(O] oo E T ow
QJ.E CIJ-E O g @
55 56 3o
5% 5% 522
xr e x o =00

Status

V)
o]
o
=5
=}
©

Measurement running

Zip, split, encode files

transfer data

(depends on settings)

Follow-up time - Post processing

SW Emergency switch-off
(Communication Timeout)

R b Mol ettt

-=4--=4-====d-==---}-----—-—--  Ready for operation

| s

i !

: !

i 1

i 1

i 2h -
HW Emergency switch-off*** 'r i [
(Power Management) ! !

I | :
Follow-up time : : :

i i i !

L 1 1
Variant t 1 [ B i |

i K

Continuous Remote |r> " ms:‘—i E e 4.4. E
Variant 2* Y_I ! i - ] :
ON pulse + - _I H -l L !

Continuous Remote**

Timeout

*Variant 2: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
***HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

of the remote signal.

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG

ipetronik.com

54/ 175



Basic functions

6.1.2 WakeOnCAN

o =
. . o 28
WakeOnCAN, Ignition line 15 o = P
pei o =
o 2 g 5
5 -5 o g5
T ! E QO ©
) oo ;OO
§ £2 : e g
= C 3 @ oS o
0] x e = NEsZ
3 2 1 L 3
Status - Booting Measurement running | Follow-up time - Post processing -
1
1
1

SW Emergency switch-off
(Communication Timeout)

—mmmmmede e m e ———————~  Ready for operation

I 1

I 1

I 1

I 1

I 1

I 1

L 1

1 1

i 2h : >

i _Z
HW Emergency switch-off*** ' H 1
(Power Management) T ! ! T

E E— i
Follow-up time ! ! | :

: : | !

i i

WakeOnCAN* _— ! !

I i q—1s —Pp 1

i i it 1 i
Continuous Remote**  _____ e [ H mmmal 000 eee-. !
Timeout I -

*WakeOnCAN Ign. 15: Switch-on condition (WakeOnCAN) enabled, continuous remote signal required before timeout expires
jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOnCAN)!

**Conitnuous Remote: If a remote signal (duration > 1 s) is identified during post-processing, the logger will stop this task and start a new acquisition.
***HW Emergency switch-off: The logger will be absolutely switched-off by the power management 2 h after the previous falling edge

o —
- o 0
WakeOnCAN without 5 o = 2
Ignition line 15 © » g B
@« = ®
c O
5 & 5 g . S25
T ! ©
2 8 2o o =78
S 5 5307 32§
2 g 2523 2 a
z @ 2020 g3
0] nd h="W3o NEZ
Status - Booting Measurement running Post processing -

SW Emergency switch-off
(Communication Timeout)

1
HWW Emergency switch-off imactive
I

HW Emergency switch-off***
(Power Management)

Follow-up time inactive

Follow-up time

WakeOnCAN* —j

Switch-off condition true

]

*WakeOnCAN without Ign. 15: Switch-on condition (WakeOnCAN) enabled,, Switch-off condition configured,,
HW Emergency switch-off and Follow-up time out of operation, Timeout inactive
Jumper Pin 3-6 and Pin 8-9 at respective CAN input to indicate bus traffic (WakeOnCAN)!

Switch-off condition ~  -----------------——-———mmmm oo
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6.1.3 WakeOnRTC (IPElog/IPElog2 only)
With TESTdrive 3.52 and higher versions, IPElog supports switching on by its internal real time clock (RTC).

Supported events:

» Once start only one single time.
» Cyclic absolute cyclic start e.g. every hour (duration --> 1h), date/time stamp defines initial start up.
» Duration start e.g. every hour without predefined start-up.
If WakeOnCAN, WakeOnRTC or WakeOnSMS is configured with IPElog, the Ethernet status
LEDs (LINK, ETH1, ETH2) will light green, even if the logger is in standby mode.
IP= StartfStop configuration = || = E
Conneckar WakeOnCAaN ML
CAN 01 [ ]
CaN 02 O O
CAM 03 O O
AN 04 O ]
CAM 05 O O
CAM 06 O O
Cal 07 O O
CAM 0 O O
CAN 09 O O
ol CAN 10 O O
wilic
Duration E:: i; g g
\
. Highlight the logger serial number at the
left system structure.
. Select Start-Stop from the tab System WakeOnRTC
activated. P
. Activate WakeOnRTC from the Start/Stop :
configuration Mode: |Duration -
. Select a start function from the drop down DiateTime: |02.06,2014 2042145
field Mode I r—
. Define a Start time and/or Duration Duration: [1,00:00:00
depending on the selected mode. Measure:
. Enable the check box Acquisition to
automatically start a data acgiusition with
the start-up procedure. Ok Caneel
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6.1.4 StopStart event (Logger processing)

The StopStart function closes the measurement file and after that immediately starts a new measurement.
This function is triggered by a user-defined event and starts without switching off the logger.

1. Select Event handling from the left-hand
menu.

2. Select Components > Event from the tab

menu or by right-clicking.

Choose the new event.

In the Event tab, choose StopStart.

In Trigger tab, define a triggering

condition (e.g. the formula:

"DIN 01" AND "DIN 02").

akow
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6.1.5 Use Cases
WakeOnCAN with ignition on/off
Application

Test run with continuous measurement via signal “Ignition on / ignition off* (remote); The logger is being
started using bus traffic (WakeOnCAN) in order to acquire the entire starting process. After test run, CAN

activity is to be acquired using the condition ,Ignition off“.

Requirements
» Data logger supporting WakeOnCAN feature

» Recognition communication stop on vehicle buses:

> |PElog or MLOG with 4CANQS cards and FPGA as of 1.08.01, TESTdrive as of 3.52.00

Sequence

IPEmotion Plugln IPETRONIK-LOG

Logger turned off

!
Remote control Central locking
!
Vehicle buses wake up
!
Logger boots
!
TESTdrive is started

!

Ignition on
!

Drive begins
!
Test run

!

Drive ends
!

Ignition off
!

ECUs still communicate

!

Bus is idle
!

Follow-up time (if configured)

!

Data post-processing
(Zipping, copying,... if configured)

!
Data transfer (if configured)

!
Logger turns off
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WakeOnCAN (bus activity)
Application

Monitoring of vehicle component on CAN, i.e. measurement as soon as/as long as the component is active,
independent from ignition state.

Requirements
» Data logger supporting WakeOnCAN feature

» Recognition communication stop on vehicle buses:
> |PElog or MLOG with 4CANQS cards and FPGA as of 1.08.01, TESTdrive as of 3.52.00

» Alternatively for other logger types / firmware versions:
> Use of switch-off condition or WakeOnCAN timeout

Sequence
Logger turned off
!
Vehicle buses wake up
!
Logger boots
!
TESTdrive is started
}
Bus is idle
!
Follow-up time (if configured)
!

Data post-processing
(Zipping, copying,... if configured)
!

Data transfer (if configured)

!
Logger turns off
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WakeOnRTC
Application

Independent from ignition state and bus traffic, the logger should start at 04:00 am every night, acquire data
via connected analog modules for 2 minutes and switch back to idle state.

Requirements

» IPElog with TESTdrive as of 3.52.00

Sequence

IPEmotion Plugin IPETRONIK-LOG

Logger turned off
!
WakeOnRTC at 04:00 am
!
Logger boots
!
TESTdrive is started
!
Configured turn-off condition becomes TRUE
!

Data post-processing
(Zipping, copying,... if configured)
!

Data transfer (if configured)

!

Logger turns off

IPETRONIK GmbH & Co. KG
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6.2 Triggering

The logger acquisition program offers 4 trigger conditions for every storage group to control the data
acquisition. The trigger conditions can be deduced from acquired signals, as well as, from calculated
channels. All data is written into the memory (RAM). If a storage condition is met, the data is asynchronously
written from the cache into the open measuring file on the flash card.

6.2.1 Start-trigger

Start of data storage if trigger condition (impulse) is met. Stop of storage with (correct) logger shut-down
(Power down). A defined follow-up time extends the data acquisition for x seconds.

6.2.2 Stop-trigger

Begin of data storage with logger switch-on (Power up). Stop of data storage if trigger condition (impulse) is
met. A defined follow-up time extends the data acquisition for x seconds. If no trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

We recommend to use the function VALID(x ; y) in order to avoid irregular NoValues which
may influence a correct triggering.

Example:
Start-trigger: VALID(,Channel01“> 15; 0) Storage as soon as Channel01 > 15
Stop-trigger: VALID(,Channel01“> 15, 1) Storage as long as Channel01 > 15
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6.2.3 Start- and Stop-trigger
Begin of data storage if start-trigger condition (impulse) is met. Stop of data storage if stop-trigger condition
(impulse) is met.

A defined follow-up time extends the data acquisition for x seconds. If no stop-trigger event is set, data is
recorded until “Remote OFF” or end of the follow-up time.

6.2.4 Stop is inverted start

Data storage for the time of meeting trigger condition (status).

A defined follow-up time extends the data acquisition for x seconds. If trigger status does not change after
successful trigger condition, data is recorded until “Remote OFF” or end of the follow-up time.

The Follow-up time may not be mistaken for the Post-processing time. Both settings must be
coordinated. The maximum post-processing time is set with Logger > Settings > Data transfer
timeout. This setting limites the switch-on duration after successful “Remote OFF” signal. The
logger is regularly shut down after this time even if the data post-processing (zipping, splitting,
sending) is not yet completed. The post-processing value must be at least 5 min greater than
the currently set follow-up time!
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6.2.5 Save trigger channel

If Save trigger channel is activated, trigger status and some additional information are stored in an implicit
channel (Word data format) in every storage group.

Bit coded information in trigger status channel

Bit No. Description Description (if bit value = 1)
0 Pre-Trigger Pre-trigger time running
1 Between start and stop Trigger signal status

This bit is set during the whole acquisition in Continuous
acquisition mode.

2 Post-trigger Post-trigger time running

3 Trigger Event This bit is set for the time of one signal at every Low > High of the
trigger signal. It is set once at acquisition start in Continuous
acquisition mode.

4 Maneuver Maneuver recording running (No NoValues available anymore)

5 Res Currently not used!!

6 Res Currently not used!

7 Res Currently not used!

8 Res Currently not used!

9 Res Currently not used!

10 Res Currently not used!

1 Res Currently not used!

12 WakeOnCAN WakeOnCAN ist active

13 Power Bad The logger is disconnected from the power supply.

14 Power Good Buffer capacitors loaded

15 KL. 15 Debounced remote signall (terminal 15)
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6.3 Data groups (storage, e-mail, traffic, statistic, novalue)
TESTdrive 3,55 supports 5 different types of data groups:

» Storage groups time related data storage on the logger
» Mail groups send data snap shot at trigger event per e-mail
» Traffic groups event related (time stamp) data storage on the logger (trace data),

license required

» Statistic group STG file (Statistic Group) containing min, max, mean values of the
respective signals created at the end of each measurement

» NoValue group NoValue monitoring of defined signals

TESTdrive supports various data groups to merge signals (direct signals, as well as, calculated channels) for
further data processing. Storage groups can have an own storage rates — independent from the signal rate.
This storage rate can be valid for all signals in the group, i.e. the signal is detected with the set sampling rate
and recorded with the storage rate or the individual signal sample rate is used for storage.

The maximum storage rate of a group is defined by the signal with the highest sampling rate. The frequency
for online calculations corresponds to the highest sampling rate in the calculation.

Each data group has its own trigger condition (see 6.2 Triggering) which can be individually defined by the
user. This offers the possibility to process (storage, sending) selected signals dependent on specific events
occurring, which may reduces the amount stored data and provides an easier offline data analysis.

Overview
Data group  Settings Trigger Category Remark
Storage storage rates, time stamp and different trigger Yes time related cyclic
groups trigger channel, NoValues, modes available, data acquisition
enable external storage medium , formula to define
storage group name = mea prefix | trigger condition
Traffic enable external storage medium , | different trigger Yes time stamp related
groups storage group name = mea prefix modes available, bus trace acquisition
formula to define
trigger condition
Mail recipients, subject line formula to define  No signal snap shot at
groups trigger condition trigger event as
status information
Statistic none none Yes min/max /average
group values at
measurement stop
Novalue none formula to define  No log file reporting
group trigger condition

Categories (Data transfer category)

Data groups that create measurement data files can be assigned to data transfer categories 1, 2, 3 or they
can be excluded from data transfer. Each category can be linked with a single data transfer medium,
whereas all three categories can be assigned to the same data transfer medium.

Refer to 11.2.3 Data transfer & communication
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6.3.1 Storage groups 1

Storage group

Select Signals navigation tab.

. Select Storage groups.

3. Select Add component > Storage
group from the tab menu or the context
menu (right mouse button).

4. Enter a name and a description in the

General tab.

Activate the storage group

Select Add component > Channels

from the tab menu or the context menu

(right mouse button).

Select the signals and confirm with OK.

Define additional parameters with

Settings und Triggering.

2D &1

OB

Ring buffer group

General | Settings | Triggering General | Settings | Triggering

Storage rate: i

Time stamp channel:
NoValues:

Save trigger channel:
Prefix:

External storage:

Storage rate

Time stamp channel

NoValue

Storage rate: |From channel -

O Time stamp channel:
MoValues:

O Save trigger channel:

O Prefic: []
O Ring buffer

Ring buffer size; |1s

Selection of a fixed storage rate or a channel related storage rate (From channel).
Using the setting From channel means, .the channel with the highest sample rate
within the storage group will determine the storage rate.

The measuring data contain the absolute time channel (logger time).

The NoValue between the trigger events, which is defined in the respective chan-
nel, is added with Format.
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Save trigger channel The trigger status channel is added to the storage group and recorded. This
channel contains additional information, which is saved with the single bits in the

data set.
Prefix The storage group name ist used for the measurement data file name.
External storage Data storage on external USB storage medium.

Refer to 6.5 USB medium for external storage for detailed information.

Ring buffer size Defines the size of the ring buffer for measuring. If the max ring buffer size is
reached, the memory is overwritten beginning with the oldest data.

Use the ring buffer group to record data that are only needed in case an unknown event

happens, e.qg. in the event of a fault. The ring buffer group contains all selected signals of a

defined period before end of measurement.

Choosing ring buffer size, consider the number of channels and defined data rates

6.3.2 Mail groups

IPEmotion Plugln IPETRONIK-LOG

N~

oo

o N

Select Signals navigation tab.

Select Mail groups.

Select Add component > Mail group
from the tab menu or the context menu
(right mouse button).

Enter a name and a description in the
General tab.

Activate the mail group

Select Add component > Channels
from the tab menu or the context menu
(right mouse button).

Select the signals and confirm with OK.

Define one or more recipients using
Settings and define the start condition
under Trigger.
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General | Settings | Trigger

Subject: |Exceeding temperature limit!

Enter the logger settings Data manager > Configuration > E-mail to set the e-mail recipient
and the mail server.

Creating mail groups is independent from a status e-mail.
The e-mail from the mail group configuration is send, as soon as the trigger event occurs. In
case of activated e-mail delivery using the data transfer configuration, a status e-mail is send at

the end of each measurement.
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6.3.3 Statistic group

Components

Statisic groups contain min, max and mean General tab.
values of the respective signals stored in the STG file, 5. Activate the Statistic group.
which is created at the end of each measurement. 6. Select Add component > Channels from the

Please also refer to
12.5.1 Data types > Min-Max list (STG file)

—_

Activate the Signals tab.

2. Highlight Statistic group.

3. Select Components > Statistic group from
the tab menu or the context menu (right
mouse button).

4. Enter a name and a description in the

tab menu or the context menu (right mouse
button).

7. Select the signals and confirm with OK.

8. Definie a data transfer categorie to be used
under Categories.

You can now add your statistic information easily into a new created statistic group. You can create several
statistic groups which can be transferred through different means.

Using the “Components” button, you can open the channel selection window to select the channel you would
like to include in the Min-Max statistic calculation.
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6.3.4 NoValue group

A NoValue group serves for monitoring invalid values occuring during data acquisition. Each NoValue event
(means that a sequence of valid signal values is interrupted by one or more invalid values) creates a log file
entry. You can use specific triggers to activate the NoValue group (for example: “CPU load” > 30 %).

Refer to 7.1.3 NoValue and timeout settings
6.3.5 Traffic groups

Time stamp related storage of CAN bus and/or LIN bus messages.

Refer to 8.2.3 Traffic acquisition

For explanations on cyclic and event-controlled data acquisition refer to 7.8 Event controlled measurement
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6.3.6 Trigger settings

Mode Select the trigger mode from Continuous acquisition (no trigger), Start-trigger,
Stop-trigger, Start- and Stop-trigger, Stop as inverted start (see Triggering)

Pre-trigger duration Data recorded before the trigger event

Post-trigger duration Data recorded after the trigger event

Start-trigger Value, which starts the data storage of the respective group.
Stop-trigger Value, which stops the data storage of the respective group.
Scaling Triggering the physical value or the raw value of the numerical value calculated

with the formula.

Define the triggering conditions as formula from the system signals and calculated signals. You
can optimize your data recording with a clever configuration of storage groups and triggering
conditions to record signals at a high storage rate only if required. This method reduces the
data volume, saves memory, and facilitates the final analysis!
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6.4 Status channels
6.4.1 Logger, Logger processing

6.4.2 Video recording
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6.5 USB medium for external storage
TESTdrive supports USB sticks and USB hard disks for storage on external drives in two different modes:
» External USB medium as alternative storage (solely saving on internal drive OR external drive).

» External USB medium as supplemental storage (depending on data type settings saving on internal drive
OR external drive).

6.5.1 External medium is the data drive of the logger

The USB medium is the data drive of the logger. Data is stored on this storage type exclusively. TESTdrive
creates the standard folder structure on the USB drive. Depending on the current settings, data post
processing and shutdown will be executed in different ways.

Because of data loss, do not disconnect the USB medium during measurement!

Behaviour with FullPostprocessing
Since TESTdrive V03.23.00 this is the default setting when using an USB data drive.

Requirement

The non-bootable USB device has to be insert before starting the logger (refer to 6.5.2 External USB
medium as supplemental data drive for preparing the device). There should be no TESTdriveCmd.xml
available on the USB medium.

Utilization

During boot-up, the logger identifies the USB medium and reports “USB drive is data drive”. Measurement
data is stored to the subdirectory named with the logger’s serial number on this storage medium. The
FullPostprocessing procedure starts with the RemoteOff condition.

Behaviour without FullPostprocessing
This is the former procedure used for USB data storage until TESTdrive V03.22.01.

Requirement

The non-bootable USB device has to be insert before starting the logger (refer to 6.5.2 External USB
medium as supplemental data drive for preparing the device). There should be no TESTdriveCmd.xml
available on the USB medium. With TESTdrive version V03.23.00 and subsequent releases the following
command line has to be added to the dev_ctrl.xml in order to acitvate the usage:

<fastUsbDatatDriveChange>1</fastUsbDatatDriveChange>

Utilization

During boot-up, the logger identifies the USB medium and reports “USB drive is data drive”. Measurement
data is stored to the subdirectory named with the logger’s serial number on this storage medium. The
RemoteOff condition starts the following jobs:

» Checkdisk
» Preparing the directory structure on the USB medium
» Deleting temporary files and directories

» Power down

Independent from any data transfer settings, measurement and configuration data will not be
transferred for data drives without postprocessing.
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6.5.2 External USB medium as supplemental data drive

The USB storage medium is used in addition to the internal data drive of the logger. Depending on the
current settings, data is stored either to the internal drive or to the external medium. TESTdrive will create
the directory structure in any case.

The following data types are supported on the external USB medium:
» as of TESTdrive V03.52 storage and traffic groups
» as of TESTdrive V03.58 storage, traffic groups and USB video records

Requirement
The non-bootable USB storage medium has to be formatted correctly!

The Windows console software diskpart can be used to prepare a non-bootable USB drive for external
storage.

Please take care that you select the correct drive of your PC when using diskpart!

Formatting an incorrect (internal) PC drive may cause serious problems or damage the
computer!

DiskPart commands and meaning

DISKPART?> list disk — Listing available drives

DISKPART> select disk 8 — Selecting the respectiv drive (here disk 8)

DISKPART> clean — Cleaning the selected drive

DISKPART?> create partition primary — Creating primary partition using the full drive size

DISKPART> format fs=exfat — Fast formatting with the exFAT format and USB stick name
label=ExtStorage quick ExtStorage (label is an optional parameter)

DISKPART> exit — Closing DiskPart

Sample screenshot showing list commands
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Upon completion of this preparation, the USB medium is ready for use with IPElog and
M-LOG V3, but not with M-LOG, as the BIOS of the logger types are different!

For usage with M-LOG, the MBR (Master Boot Record) of the USB medium has to be deleted.

Once the MBR of the medium has been deleted, it can be no longer used with IPElog or
M-LOG V3!
We recommend to prepare separate USB storage devices for the respective logger types.

Deleting the bootloader requires a determination of logical and physical drive!

The tool Hex Workshop can be used for deleting the bootloader,
as it supports access to the physical part of the drive.

The tool is available for download from:

http://www.hexworkshop.com/
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The MBR (Master Boot Record) is the physical drive area. The bytes asigned to address range 0x000 to
0x01B7 (Bootloader) have to be deleted, this means set to 0.

The TESTdriveCmd.xml with the contents listed below has to be copied to the USB medium:

<TESTdriveCmd>
<Authentication>
<user>guest</user>
<password>ipe_guest</password>
</Authentication>
<OnConnect>
<JobList>
<Job>
<Name>startExternalStorage</Name>
</Job>
</JobList>
</OnConnect>
<OnDisconnect>
<JobList>
</JobList>
</OnDisconnect>
</TESTdriveCmd>

Using a TESTdriveCmd.xml with other commands will execute these jobs and waiting for
disconnecting the USB medium.
The storage to the external drive will not be started in this case.
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In addition to an appropriate TESTdriveCmd.xml, the correct settings for storage and/or traffic groups or USB
video recording are required — Activate External storage.

SEMEra Settings | Triggering ategories
Storage rate: | From channel -
Time stamp channel; [+
MoValues: |+
Save trigger channel;
Prefix:

Prefix preview:

External storage: |+

With USB video recordings, the total memory space available on the USB device can be limited by Plugin
specific settings.

(Options — Pluglns — IPETRONIK LOG Plugln-specific settings — Extended — Open system setup).

P2 Extended options - O x

Video input
Maximum memory space: | 1000 MB
Maximum memory space (external): | 1000 MB
Maximum file length; | 1000 MB

Application

Storage on external USB device is supported for triggered measurements as well as continuous
measurements (TESTdrive V03.54.00 or a newer release required).

The USB medium can be connected to the logger before boot up or when the measurement has been
already started (TESTdrive = V03.54.00). TESTdrive writes data directly to the external USB drive.

If the start trigger for data storage is active but no USB device available, the logger will report the respective
warning:

"No USB-Stick with TESTdriveCmd. Storage group [Name] cannot be stored externally.”
"No USB-Stick with TESTdriveCmd. Traffic group [Name] cannot be stored externally.”
"Video(/Nummer]): No USB-Stick with TESTdriveCmd. Video files cannot be stored externally.”

The external storage has to be stopped before unplugging the USB medium. We recommend to end the
complete measurement (not only USB storage) as the operating system could respond unforeseeable on
unplugging the USB medium. If this procedure is not possible, a stop trigger has to be configured to end the
data storage regularly.

Unplugging the USB medium while external storage groups are active causes data loss!

Configure stop trigger conditions or end the measurement (power down) to unplug the USB
medium from the logger without data loss.
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7 Standard functions

7.1 Calculations

TESTdrive supports the online calculation of the signals acquired in the system. The desired calculation is
defined with the corresponding software dialog — manually or with the formula editor.

IPEmotion Version 1.03 and Plugin IPETRONIK-LOG = V03.20 offer a shared formula editor, i.e. the
following calculation functions are available in IPEmotion, as well as, in TESTdrive.

Calculations, which are based on each other, must be run in the same cycle rate to get a
correct result! If, e.g., the result of a calculation with low cycle rate is used in a calculation with
higher cycle rate, a time offset results, which can influence the result according to a signal
change (amplitude). In that case, the signal sampling rate of the first calculation must be raised.

@, “ 9

The formula editor requires the use of the semicolon “;” instead of the comma *,” as variable
separator.

If a value within a calculation is “NoValue®, the calculation result is “Novalue®, too.

7.1.1 Mathematic functions and operations

1 Basic operation
Operator Name Syntax Example Result
+ Addition “Temp01“ + “Temp02°“ 15+ 10 25
- Subtraction “Temp01“ - “Temp02“ 15-10 5
* Multiplication “Temp01* * “Temp02“ 15*10 150
/ Division “Temp01* / “Temp02“ 15/10 1.5
MOD Modulo, Division rest “Temp01“ MOD “Temp02* 15 MOD 10 5
ABS()  Absolute value of a number ABS(“Temp01*) ABS(-15) 15
SIGN()  Sign of a number SIGN(“Temp01%) SIGN(15) 1
SIGN(0)
SIGN(-15) -1
NEG() Negation of a number NEG(“Temp01%) NEG(15) -15
NEG(-15) 15
( Begin bracket term (“Temp01“ + “Temp02)*2  (15+10) * 2 50
) End bracket term (“Temp01“ - “Temp02“)*2  (15-10)* 2 10
2 Power, Square root, Exponential and Logarithm functions
Function Name Syntax Example Result
A Power “Temp01“ * 2 1512 225
SQRT() Square root SQRT(“Temp01*) SQRT(25) 5
EXP() Exponential function of basis e EXP(“Temp01“) EXP(5) 148.41
LOG() Logarithm of basis 10 LOG(“Temp01%) LOG(5) 0,4771
LN() Logarithm of basis e LN(“Temp01%) LN(5) 1.0986
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3 Trigonometric functions, Hyperbola functions
Function Name Range of values in radiant
SIN() Sine +/-3.99 rad
COS() Cosine +/-3.99 rad
TAN() Tangent +/-3.99 rad
ASIN() Arc sine +/-1.0 rad
ACOS() Arc cosine +/-1.0 rad
ATAN() Arc tangent +/-1.0 rad
SINH() Sine Hyperbolicus +/-1.99 rad
COSH() Cosine Hyperbolicus +/-1.99 rad
TANH() Tangent Hyperbolicus +/-1.99 rad
4 Comparative operations (comparison of variable values)
Function Name Syntax Example
= Equal “Temp01“ = “Temp02* 15=10
15=15
<> Unequal “Temp01“ <> “Temp02* 15<>10
15<>15
< Less than “Temp01* < “Temp02“ 10<15
15<15
> Greater than “Temp01* > “Temp02“ 15>10
15> 16
<= Less than or “Temp01“ <= “Temp02* 10<=15
equal 15<=15
20<=15
>= Greater thanor  “Temp01“ >= “Temp02“ 15>=10
equal 15>=15
15>=20
IF(;;) Iffunction IF(“Temp01“ >= “Temp02%; x; y) x=1,y=0
“Temp01“ =15
Query to a specific status. “Temp02“ =10
If Occurrence > action 1, otherwise action 2 “Temp01“ =10
Example: IF(“Thermo_channel3* > 30; 1; 0) “Temp02“ = 15
If Temperature > 30, Result: 1 otherwise 0
Action 1 and 2 can also be calculations.
5 Logic operations (comparison of signal states)
Function Name Syntax Example
AND And “Temp01“ > “Temp02“ AND “Temp01“>10 15>5
15>10
10>5
OR Or “Temp01* > “Temp02“ OR “Temp01“ > 10 15>5
10>5
10>10
XOR Exclusiv or “Temp01“ > “Temp02“ XOR “Temp01“>10 15>5
10>5
15>15
10>10
NOT() Not NOT(“Temp01* > “Temp02) 15>5
(inverse state) 15>15
5>15
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(] Boolean operations (bitwise comparison of signal states)
Function Name Description Example Result
ANDB And bitwise  Bits which are set in operand1 and in 27 ANB 12 8
operand2 will be set in the result 11011 ANDB 01100 01000
(bit = 1), all others will be not set (bit = 0)
ORB Or bitwise Bits which are set in operand1 or in 26 ORB 8 26
operand2 will be set in the result 11010 ORB 01000 11010
(bit = 1), all others will be not set (bit=0) 27 ORB 13 31
11011 ORB 01101 11111
XORB  Exclusive or  Bits which are set only in operand1 or only 26 XORB 8 18
bitwise in operand2 will be set in the result 11010 XORB 01000 10010
(bit = 1), all others will be not set (bit=0) 27 XORB 13 22
11011 XORB 01101 10110
NOTB  Not bitwise Bits which are set in operand1 will be not  NOTB 27 4
set in the result (bit = 0), all others willbe  NOTB 11011 00100
set (bit = 1)
7 Statistic functions
Function Name Syntax , Description Example Result
MIN() Minimum MIN(“Temp01%) 4112132517 3
MAX() Maximum MAX(“Temp01*) 4112132517 25
MEAN() Average Average from all valid values
MEAN(;) Average from Average from n valid values
n values
MINOR( ;) Less value MINOR(“Temp01*; “Temp02) 4112 4
MAJOR( ;) Greater value MAJOR(“Temp01*; “Temp02) 4112 12
FLOOR() | Roundinteger FLOOR(“Temp01%) 13,72 13
off
CEIL() Round integer CEIL(“Temp01%) 13,41 14
up
ROUND() Roundinteger ROUND(“Temp01%) 13,41 13
13,72 14
LIN(;;;) Linearization LIN(*Temp01%
x node-1;y node-1;
X node-n; y node-n)
Runs a linearization with the defined
nodes. Betweenn=2and n =16
nodes can be defined.
8 Other functions
Function Description
EDGE_POS() Detect positive edge
1 if current value is > 0 and the previous one <=0
EDGE_NEG() Detect negative edge

1 if current value is <= 0 and the previous one > 0
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Function
DIFF()

INT()

INT_ADD( )

INT_UP()
PREV( )

(, Temp1® +
(PREV (, Temp1“))
+ (PREV
(PREV(,,Temp1“)))
)/3
SHL(;)
SHR(;)

TESTBIT(;)

TESTMASKS( ; )

TIME( )

TIMER(; )

VALID()
VALID(x; y)

ISNOVALUE(x; y)

RADIUS(y; 2)

ANGLE(y; 2z)

IPEmotion Plugln IPETRONIK-LOG

Description

Runs a differentiation of an operand acc.to:
(Opr1(t) — Op1(t-1)) * DeltaT

Calculates the integral of an operand acc. to:
"((Op1(t) + Op1(t-1))/2) * DeltaT"

Calculates the integral of an operand acc. to:
"((Op1(t) + Op1(t-1))/2) * DeltaT" and adds the
result to the previous value

Calculates the upper integral of an operand acc.
to: "Op1(t) * DeltaT"

Outputs the previous value.

Floating average from the current value and both
previous values

Shift value bitwise to the left.
Shift value bitwise to the right.

Checks the value (0, 1) of the defined bit. If the
bit described by operand 2 is set, result = 1,
otherwise result =0

(Counting order starting right hand with 0)
Makes a comparison with a user definable
bitmask. If at least one bit is set in operand 1 and
also in operand 2, result = 1, otherwise result = 0
TIME(“Temp01*)

A counter that adds the time intervalls of the
corresponding sample rate continuously and
outputs the sum as long as the operator's value
is>=0.5

In case the operator's value is < 0.5, the counter
is reseted and 0 is output.

If no new value is received from the channel
defined as Parameter1 within the timeout
(Parameter2 in seconds), the output value is "1".
Check for validity

Example Result
PREV(“Temp01“) 4 |
1213]25] NV|12]3
1 SHL 2 4
001 SHL 2 100
12 SHR 1 6
1100 SHR 2 0110
TESTBIT(1101; 3) 1
TESTBIT(1101; 1) 0
TESTMASKS(27, 6) 1
TESTMASKS(27, 4) 0

1 if value is unequal to NoValue, 0 if value is NoValue

Avoid Novalues

x if value is unequal to NoValue, y if value is NoValue

Delay of a NoValue identification (x: signal value, y: optional time delay)
If y is not set resp. its value is 0, the result is true, as soon as x = NoValue
Is y # 0 the result is true, as soon as x = NoValue for a minimum duration of y seconds.

Is x # NoValue, the result is always false.

Radius calculation polar coordinates (r = V(y*2+ z/2)

= SQRT( Ilphi_yll * llphi_yll + Ilphi_zll * "phi_zll )
Angle calculation in polar cordinates

= IF( "phi_z" >= 0; ACOS("phi_y" / "Radius" ) * 180/PI; -1 * ACOS("phi_y" / "Radius" ) *

180/PI + 360)
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7.1.2 Constants

9 Constants
Constant Description
Pl Pi > 1 = 3.141592654 ...

SYSTEMRATE TESTdrive internally works with a fix system rate. This rate depends on
the configuration (Channel with highest sampling rate) and can be used
for calculations. The system rate can be compared with the timer ticks of
a PC clock and is set in Hz.

The system rate relates to the working frequency of the PC/Notebook (=
Frequency of the High-Performance-Counter).

SYSTEMTIME Reciprocal value of the system rate (=1/SYSTEMRATE) and is set in
seconds.

Please note at using a system rate in the MHz range that the system time
can only be correctly displayed if sufficient decimals have been defined
and Automatic has been selected in Display > Formatting.

SAMPLERATE Channel sample rate in Hz

SAMPLETIME Channel acquisition intervall in 1/s

7.1.3 NoValue and timeout settings

In order to differ invalid and valid measurement values, the user can select —FullScale, Null or +Fullscale (for
analog inputs) to be identified as invalid value (NoValue). A signal value at the upper or lower limit range
could be invalid, as it can not occur really. Another used case are missing messages at the CAN bus. An
expired fimeout can be used to indicate invalid values.

Settings possibilities
Measurement input
General | Format | Scaling || Display | Thermo || Limit value

Data type

Type: |16-Bit integer signed - Task: |Mothing -

MoValue [ DefaultValue

Value: |IETH=E + | [] Deactivate MoValue and use Default Value
Channel type Tl D}
+rullScale
Input: o

The setting for the signal input (e.g. IPETRONIK CAN measurement module) or the CAN signal input defines
the invalid value (NoValue) within the measurement range (selection -FullScale, Null, +FullScale).

If this function is deactive, the measurement value is used (e.g. -60 °C with M-THERMO), NoValues are
suppressed in this case.

A NoValue alarm can be activated for every signal within the Format tab.
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IPEmotion Options
The IPEmotion Options Expert settings (select Basic

settings > Expert mode) provide a No value timeout for the
online data acqusition. If values are missing with a cyclic data
acquisition, subsequent samples will be output as NoValue if

the timeout range has expired. The setting range for the No
value timeoutis 0 ... 5 s.

This setting has no effect on the data acquisition by the logger.

Please use the Plugin Options for this.

Plugln Options

Entering the IPEmotion Options, the options tab of the
Plugln IPETRONIK LOG (select current Plugin >
Options > NoValue-Alarm Timeout (s)) provides the
logger acquisition timeout. . If values are missing with a
cyclic data acquisition, subsequent samples will be output
as NoValue if the timeout range has expired.

The setting range for the No value timeoutis 0 ... 120 s.

Conditioned by different delays during initialization
(modules, logger) when measurement has been started,
NoValues can occur during this phase.

Use the setting NoValue start delay (s) in order to avoid
NoValues at measurement start.

The setting range for the No value start delay is 0 ... 600 s.

IPEmotion Plugln IPETRONIK-LOG
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= Expert settings

General options

Additional warnings: []

Configuration options
Variable configuration:
Extended tabs:

Data acquisition options
Maximum size of acquisition data files:
Mo value timeout: |0 s

Limit message duration: |5s

Description files import options
View protocols:
Edit protocol channel scaling:

View diagnostic jobs:

OO0 O®

Ignore verbal tables:

[

Max. poling lists:
Use characteristics:
Suppert J1239: []

Logging import:

0K

== IPEmotion settings - IPETRONIK LOG

Options | Components

General

Activate TESTdrive access restriction:
Encoding of the configuration files:
Encoding password:

Encoding of the system files:
Complete system configuration files:
Create status file:

MoValue alarm timeout [s]:

MNoValue start delay [s]:

ipetronik.com

100 MB

i

for calibration -

Cancel

xxxxx
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CAN input

Each CAN input of the logger provides timeout settings with an adjustable delay time (select for example
CAN 02 > tab Extended > Timeout value 2 s). If the CAN input do not receive messages anymore and the
timeout period has expired, the logger starts writing NoValues to the data record.

Log file entries

If the NoValue monitoring is activated and NoValues are occuring, the system will record the series of
NoValues itself (instead of the signal value) and the corresponding log file entry.

Example
NoValue monitoring at CAN 01 Timeout value 20 s

Log file entry: D CAN signal measurement timeout (no valid ID) on CAN 01 (t > 20000 ms)
9
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7.1.4 Calculation examples

Greater comparison ,,>“

Syntax >
Description = Compares the current value (of a channel or a calculation) with a user defined constant or
variable. The result is 1, as long as the comparison is true, otherwise the result is 0 (for a
false comparison).
Example ,Channel01“ > 2 Comparison with a constant
»,Channel01“ > ,Channel02“ Comparison with a variable
Constant
Signal
Results
Time=
Variable
Signal : : : :
Result 3 ,—l
‘ ‘ ‘ Time=

Less comparison ,,<“

Syntax <
Description = Compares the current value (of a channel or a calculation) with a user defined constant or
variable. The result is 1, as long as the comparison is true, otherwise the result is O (for a
false comparison).
Example »,Channel01“ < 2 Comparison with a constant
,Channel01“ < ,Channel02“ Comparison with a variable
Constant
Signal
Result
Time=
Variable
Signal : : : :
Result —l
‘ ‘ ‘ Time®
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Counter (without reset)

Syntax

Description

Example

Tip

,counter01“ + x
VALID(“Counter01”; 0) + x

Counts continuously with the current sample rate, i.e. the counter value is increased by x
with each sample. The rise of the counter slope depends on the currently configured
sampling rate and the counter step. A measurement stop resets the counter to 0.

,Counter01“ = ,Counter01“ + 1 Accumulates 1 with each sample
,Counter01“ = ,Counter01“ + 10 Accumulates 10 with each sample

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function:
»,Counter01“ = VALID(,Counter01%; 0) + 1

The Valid function sets the initial counter value to a defined value (here 0) in case the current
value is invalid.

Counter with counting condition

Syntax

Description

Example

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; ,,Counter01“ + y; ,,Counter01“)
IF(“Channel01” > x; VALID(“Counter01”; 0) + y; VALID(“Counter01”; 0))

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter remains unchanged. As son as
the condition is fulfilled again, the counter continues with the previous value. The rise of the
counter slope depends on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

,Counter01* = IF(“Channel01” > 5; "Counter01“ + 1; ,Counter01“)
Accumulates 1 with each sample as long as "Channel01“ is greater than 5.
Stop counting and holding the latest value, as soon as ,,Channel01“is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

T T L
10 20 30 40 50 60 Sampling time
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Counter with counting condition and reset

Syntax

Description

Example

Tip

Counter

Constant
Signal

Trigger

IF(“Channel01” > x; ,,Counter01“ + y; 0)
IF(“Channel01” > x; VALID(“Counter01”; 0) + y; 0)

Counts continuously with the current sample rate, as long as, the current value of
"Channel01" is greater than x. The counter value is increased by y with each sample, as long
as "Channel01" fulfills the condition. Otherwise the counter will be reset to 0. As son as the
condition is fulfilled again, the counter restarts with 0. The rise of the counter slope depends
on the currently configured sampling rate and the counter step.

A measurement stop resets the counter to 0.

,Counter01“ = IF(“Channel01” > 5; ,Counter01“ + 1; 0)
Accumulates 1 with each sample as long as "Channel01“ is greater than 5.
Stop counting and reset to 0, as soon as ,Channel01“is less than 5.

Used with TESTdrive (logger application) this recursive formula will result in valid values as
the initial value for variables is set automatically. Used with IPEmotion (Acquisition >
Calculations > Formulas) the respective formula has to be completed with the Valid function.

»

T T Ll
10 20 30 40 50 60 Sampling time

Validation check ,,VALID*

Syntax

Description

Example

Tip

IPEmotion Plugln IPETRONIK-LOG

VALID(x)
VALID(x;y)

VALID checks the current value (of a channel or a calculation) for validity, i.e. if the variable's
status is ,invalid“ (NoValue).

With the VALID(x) function the result is1, as long as x is valid and changes to 0, as soon as
the x has the status NoValue.

With the VALID(x;y) function the result is x as long as x is a valid value. As soon as x will be
an invalid value (NoValue) the result changes to y. In case y is a variable (instead of a
constant) the result of VALID(x,y) will be NoValue, as soon as x, as well as, y are an invalid
value.

VALID(,Channel01*) 1 if ,Channel01*s NoValue, 0 if ,Channel01“ = NoValue
VALID(,Channel01%4) ,Channel01“if ,,ChanneIO1“={= NoValue, 4 if ,Channel01* = NoValue

When using a measurement value within a recursive formula (x = x + y) we recommend to
use the VALID(x; y) function in order to avoid invalid values (NoValue). Even if the
measurement signal becomes valid values, the recursive formula will not be calculated
correctly, once a NoValue occurred.

We recommend to use the VALID(x; y) function for any signal which serves as a trigger for a
storage group. An invalid trigger signal could prevent the start of the data storage even if the
trigger signal will become temporarily valid.
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Mean value (averaging) ,,MEAN*
Syntax MEAN(x)
MEAN(x; n)

Description = MEAN(x) continuously calculates the moving average from all valid measurement values.
MEAN(x; n) berechnet continuously calculates the moving average from n previous
measurement values.

Example MEAN(,Channel01%) moving average from all values of a measurement
MEAN(,Channel01%; 10) moving average from 10 values at a time
Tip The diagram shows the differences of the MEAN functions with a rectangle signal
(clock 5 Hz)
Square red origin signal
Mean Square blue  moving average
Mean_5 Square green moving average from 10 values at a time
1 -
0,84
0,6
0,4
0,2
D -
0 1 2 3 4 5 & 7 [sl] g 10 11 1 13 14 15
— Sguare — Mean Sguare —— Mean_5S Square

Linearization ,,LIN“
Syntax LIN(Operand; x-Node01; y-Node01; x-Node02; y-Node02)

Description  Runs a linearization with user defined nodes. Between n = 2 and n = 16 nodes can be
defined. The scaled values (Y-axis) are calculated from the original measurement values (X-
axis) using factor and offset of the partial linear slope between two nodes.

Example LIN(,Channel01“; 0;-0,5; 2;1; 4;2; 8;2,5)

Tip The linearization enables a non-linear scaling (multipart scaling) used for physical graphs
without having a mathematical equation.
Using this multipart scaling an approximation of a mathematical equation is more precise as
more nodes are used.
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7.1.5 Calculation

Select Signals navigation tab.

Select Calculations.

Select Add component >

Calculation from the tab menu or

the context menu (right mouse

button).

4. Activate the calculation.

5. Enter a name and a description in
the General tab.

6. Enter the calculation in the Formula

tab.

@N =

—l
Enter the calculation formula
manually or use the Formula editor
f(x).
8. Move signals and operators in the
entry field by using Drag&Drop.
9. Confirm with OK.
f 10. Enter the value range and the
() . . :
decimals in the Display tab.
11. Define additional limit values and/or
a NoValue.

Calculation rule: 80002367 2| (EH
"DIN 01" OR "DIN 02" -
Operand Description Reference Source | Operator Description =
:DIN 01 1 ( Begin of bracket block
DIN 02 Define external trigger (e.g... |DIM 02/800... | 2/DIN/300 ) End of bracket block
DIM 03 Define external trigger (e.q... DIM 03/800... | 3/DIN/&00 I+ Addition
DIMN 04 Define external trigger (e.g... |DIM 04/800... | 4/DIN/200 H Subtraction
DOUT 01 Digital output DOUT 01/8... | 1/DOUT /& 3 Multiplication
DOUT 02 Digital output DOUT 02/8... | 2/DOUT /8t Potentiation
DOUT 03 Digital output DOUT 03/8... | 3/DOUT/8E ! Division
DOUT 04 Digital output DOUT 04/8... | 4/DOUT/0 = || || MOD Modulo operator
4 m (3 ABS() Absolute value hd

Define external trigger {e.q. for a storage group).

Pool oK Cancel
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7.2 Digital inputs and outputs
7.2.1 Digital inputs

Activate the Signals tab.

Select DIN in the system overview.

Activate the desired digital inputs.

Enter a name and a description in the

General tab.

5. Enter the value to be interpreted as NoValue
in the Format tab. (Value out of the valid
range)

6. Enter the value range and the decimals in
the Display tab.

7. Define the lower and upper limit value with
Limit value.

8. Enter the output/display of invalid value with

NoValue.

Eall e

7.2.2 Digital outputs : -
Activate the Signals tab.

Select DOUT in the system overview.

Activate the desired digital outputs.

Enter a name and a description in the

General tab.

Enter the value to be interpreted as NoValue

in the Format tab. (Value out of the valid

range)

6. Enter the upper and lower acquisition range
with Scaling.

7. Enter the value range and the decimals in
the Display tab.

8. Define a formula to control the output with
Calculation.

9. Define the lower and upper limit value with

Limit value.

PLON~

o
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Sampling rate DOUT

The logger's digital outputs (DOUT) support
a definable sampling rate (cycle rate) of up
to 100 Hz.

Frequency output DOUT

If the frequency output is activated, a square
wave voltage is sent. The signal frequency
can be configured.

IPEmotion Plugin IPETRONIK-LOG

Gereral | Format | Scaling | Display | Calculation | Fregquency cutput
Bickive:
Marme: DOUT 01
Description:  |Define a command to activate the digital output,
Reference:  |M-LOG (4 CARD

Sarmpling rate: 10Hz =
1Hz
ZHz
S Hz

Z0Hz
S0 Hz
100 Hz

General Formak Scaling Display Calculation Frequency aukput
Frequency oukpuk ackive:
Frequency output configuration

Frequency: |10 Hz

IPETRONIK GmbH & Co. KG ipetronik.com
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7.3 WakeOnCAN

The WakeOnCAN function switches the logger on as soon as the respective CAN bus is active, i.e. when
messages are transferred.

7.3.1 ON via WakeOnCAN, OFF via Ignition 15

If there is no Switch-off time configured, the remote signal (e.g. terminal 15) must be active within the set
timeout to permanently switch-on the logger. The logger is turned off if the remote signal is not received after
the timeout. The logger stays in operation mode as long as the remote signal is high. As soon as remote is
low, the Follow-up time will start and the logger is switched-off when datat postprocessing is finished.

Bridge Pin 3 (CAN2/6-GND) > Pin 6 (PWR-GND) General | Extended | System | Data manager
Bridge Pin 8 (WaOnCAN) -> Pin 9 (UB-OUT+) Sl ol e
Timeout: |1 min

Depending on the CAN card/Port replicator, the
WakeOnCAN function supports

- only at CAN 2,

- at CAN 2 and CAN 3

- at all CAN inputs (special version)!

7.3.2 ON via WakeOnCAN, OFF via Switch-off condition

With a configured Switch-off condition the Timeout setting has no influence. The logger stays in operation
mode as long as the Switch-off condition is false.

General | Extended | System | Dakta manager

Switch-on condition (WakeonCan: Switch-off condition: "DIN 01" =1

Timeouk: |1 min

If a temporary remote signal (duration > 1 s) is identified in this mode, the Follow-up time starts
with the falling signal edge and the logger is switched off (when postprocessing is finished),
even with a false Switch-off condition.
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7.4 CAN-Send: Output signals to CAN bus

The CAN-Send feature outputs measured signals, calculated channels and status signals using a common
data rate up to 100 Hz. You can use the automatic CAN ID assignment or you may enter individual settings
for each channel. Save the current signal settings to a CANdb file (*.dbc) for a quick and easy exchange with
the external application using the CANdb export feature.

Requirements: CAN board with FPGA version > 1.04.00
CAN-Send support for one CAN bus of the logger only

At least one CAN participant must be connected to the CAN interface to transfer data to the CAN. If this is
not the case, TESTdrive reports the following:

E Error sending CAN message in CANSendWorkStation. Counter = 1

Just after successfully connecting a CAN device data output to the CAN bus is startet, even
when TESTdrive reports “Maximum number of error messages has been reached”.

Creating CAN-Send, Adding channels

1. Highlight a CAN input (CAN 01)

2. Select Components and then CAN-Send
from the tab menu or from the context menu
(right mouse button).

3. Now, the system structure shows the new
entry CAN-Send below the CAN input.

120 4. Select the channels you want to output to
CAN bus.

5. If there are no active channels available,

mouse button).

please activate some first and highlight CAN-
Send. Select Components > Channels from
the tab menu or from the context menu (right
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CAN settings

General | Settings

Sending fr

equency: (10 Hz -

First CAN ID: | 100 h

Automatic CAM ID placing:
Send counter:

Send counter start bit:

Sl E O

Send counter bit count: |16

Send counter data format: |Intel RS
Sending frequency common output rate of all signals: 0.5/ 1/ 2/ 5/ 10/ 20/ 50/ 100 Hz
If the data output rate is greater than or equal to the acquisition rate of source channel, this error report is
written to the log file:
D ERROR in CCANSendWorkStation::Put() Fifo full!
First CAN ID Define the first CAN ID used for automatic CAN ID placing
Automatic CAN ID placing Padding of CAN messages with selected signals and automatic

Send counter

CAN ID assignment to the respective message

Counts up the sending tasks

Send counter start bit Start bit used for the send counter value within the CAN message
Send counter bit count Data length of the send counter value
Send counter data format Data format of the send counter value (Intel, Motorola forward)

With automatic CAN ID placing, the first CAN message contains the value of the send counter
(depending on data format byte 1 to 4).

Monitoring the send counter by the receiver is a simple way to verify a correct CAN

communication.
General | CAN
Channel settings CAMN message: |Message_100
CANID: |100 h
Start bit: |16
Bit count: |16
Tab view in expert mode
Extended tabs activated under Options > Basic
settings > Expert mode
CAN message Name of the CAN message
CAN ID Identifier of the CAN message (standard ID and extended ID supported)
CAN LSB Start bit within the CAN message of the signal to be output
Extended settings (Expert mode only)
Start bit Start bit within the CAN message of the signal to be output
Bit count Number of bits per signal within the CAN message

Data format

Data format of the signal value (Intel, Motorola forward)
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Exporting the settings to a CANdb

Export the current CAN send settings to a CANdDb file after you finished the system configuration. This makes
is easy to configure an external CAN device (notebook, or CAN data display) in order to acquire/display the
signals streamed by the logger.

1. Highlight CAN-Send from the system
structure at the left side.

2. Select Export > CANdb export from the
tab menu or from the context menu (right
mouse button)..

3. Select destination and file name (*.dbc) to
save your export.

4. Confirm by clicking the Save button.
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7.5 Log file output via Hyperterminal

The logger status messages can be displayed online with a RS232 PC or notebook connection. The
MLOG.ht file is copied into the following directory:

C:\Documents and Settings\[user]\Startmenu\Programs\Accessories\Communikation\
HyperTerminall\....

Prior to this, a hyperterminal connection must be created.

Or create a new hyperterminal connection:

® @

The following components are required for the
connection of M-LOG and PC: @

for PCs with serial interface: P e e e =~

1 x USB to RS232 converter ’ N

1 x Null modem cable / '
1 x Gender Changer ,’ “
for PCs without serial interface: | 1
2 x USB to RS232 converter ‘\ ,'
1 x Null modem cable ' /
1 x Gender Changer N /

The components for PCs without serial interface are ~ -
available as an optional package (M-LOG-OPT-086).
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7.6 Send e-mail with status information

If this function is activated and the logger has an internet connection (LAN, WiFi, modem), it sends a status

e-mail after acquisition stop with the following content:

» serial number and number of the current acquisition in subject line,

» attached log file

» attached measurement status file if activated

» attached STG file (Statistic Group, resp. Min-Max list) if activated

F= Data transfer configuration: 80002367 == ES

General | Medium selection | E-mail

Emergency switch-off after:

Activate data remote transfer:
Time synchronization via SNTP:

Activate e-mail delivery:

Import

IP= Data transfer configuration: 80002367 = | = E
General | Medium selection | E-mail
To: |support@ipetronik, com; info@ipetronik, com; sales @ipetronik. com|
Subject: |Logger [SeriaMumber]:Measurement no. {MeasurementId} finished
Fram:
Logger: [SerialMumber]Measurement; {MeasurementId}Attachment: {Attachment}
Server settings
Server name: Authentication: [
Server IP address: |0.0.0.0 User:
Password:
Import Export CK Cancel
To E-mail address of recipient
Subject Subject line for serial number and mesaurement number file
From E-mail address of sender (any text)
Description field Description of serial number, measurement file number and attachement
Server IP address IPE address of outgoing mail server (to e-mail account,

Server name

-
o
1
-

File encoding:

Ooao
w

[
N

Select Activate e-mail delivery.

Mail tab.

. Select the logger in system overview.

2. Activate the Data management tab.

. Activate the Update connection
parameters > Configuration to change
the settings for data transfer configuration.

5: Define the corresponding setting in the E-

Export oK Cancel

e.g. smtp.mail.proivder.com) for sending

Alternative input of server name of outgoing mail server

Authentication Access authorization to user e-mail account
User User name
Password Password
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7.7 Output messages to CAN/LIN

With the Logger Plugln V03.21.00 / TESTdrive 3.21 and higher an output of user defined messages to CAN
bus or LIN bus is supported.

The output timing can be selected from:
- one-time, at start measurement,
- one-time, at stop measurement,
- cyclical every x ms.

An external file with the *.DAT extension is used to configure the settings for the messages.
A sample file is available from:
c:\Programs\IPETRONIKNIPEmotion Plugin IPETRONIK LOG V03.xx.xx\Data\Channel.dat

The header of this files contains detailed information regarding to the usage of the parameters.

The screenshots below show the implementation of the external file in IPEmotion configuration.

Skatistic
External programs

Event handling

|
k] " g TN

Multiple selection. ..

1. Select Data processing in the left
Systems overview.

2. Select Add components > External
programs from the tab menu or from the
context menu.

3. The new entry External programs has
been added to Data processing.

& Runtime library

Multiple selection. ..

4. Select External programs in the left
Systems overview.

5. Select Add components > External
programs from the tab menu or from the
context menu.

6. Chose additional settings in the tab
Extended.

IPEmotion Plugln IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 97/ 175



Standard functions

General | Extended

External library: |6678\DatavChanneldccess.dim (==e Remove

Configuration file: | Build 16678\ DatalChannel dat | === Remove Extended (Runtime library)

Message cycle bime: |10 ms -

External library
File location of the external application (DLM)

Configuration file
File location of the configuration (DAT)

Message cycle time
Ouput rate of the message (repetition rate)

Example Offset adjust for IPETRONIK modules connected to the logger’s CAN input

The message output feature offers the possibility to broadcast an offset adjust command to IPETRONIK
CAN modules with adjust function.

The sample file OffAddStart.dat contains the adjust commands for task Manual and Group 1-4.
The sample shows a manual adjust on CAN 01 with a baud rate of 500 kBit/s, executed with a time delay of
2.5 seconds from start measurement.

Brief description of the parameters (see header of the sample Channel.dat for detailed settings):
// Hardware initialization <---Basic setting of CAN/LIN input

[Init]

// Channel, ChnType, Chnindex, ChnMode, Baudrate

CANO, 1, 0, 1, 500000
<emmeee ChnType LIN=2 /CAN=1, Chnindex Nr 0...11=Input , ChnMode 29Bit=2 11Bit=1 / Baud rate

/I List of messages (send/receive)

[Messages]

/[ Name, ID, Length Bytes <------ ID CAN/LIN -ID; Length= Number of bytes; Bytes = Message
1l

Manuell_1, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0x80, 0x80 <----Manual
Manuell_2, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0xCO0, 0x81

Manuell_3, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0x40, 0x8C

Manuell_4, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0xCO0, 0x8D

Manuell 5, 0x0, 8, 0x00, 0x91, 0x02, 0xCA, 0x3F, 0x00, 0x00, Ox8E

Group1_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x80, 0x80 <-----Group 1
Group1_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xC0, 0x81

Group1_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x40, 0x8C

Group1_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0xCO0, 0x8D

Group1_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC5, 0x3F, 0x00, 0x00, Ox8E

Group2_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x80, 0x80 <-----Group 2
Group2_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0xCO0, 0x81

Group2_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x40, 0x8C

Group2_4, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0xCO0, 0x8D

Group2_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC6, 0x3F, 0x00, 0x00, Ox8E

Group3_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x80, 0x80 <-----Group 3
Group3_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, O0x3F, 0x00, 0xCO, 0x81

Group3_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x40, 0x8C

Group3 4, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0xCO, 0x8D

Group3_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC7, 0x3F, 0x00, 0x00, Ox8E

Group4_1, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x80, 0x80 <-----Group 4
Group4_2, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0xCO, 0x81

Group4_3, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x40, 0x8C

Group4 4, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0xCO0, 0x8D

Group4_5, 0x0, 8, 0x00, 0x91, 0x02, 0xC8, 0x3F, 0x00, 0x00, Ox8E
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[Conditions]
/I Name Condition

/ Messages which have to be send at measurement start <---- The output sequence is defined by the
sequence of the list

[OnStart]

/I Time, Channel, Message

2500000, CANO, Manuell_1

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_1
2500000, CANO, Manuell_2

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_2
2500000, CANO, Manuell_3

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_3
2500000, CANO, Manuell_4

<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_4

2500000, CANO, Manuell_5
<-- 2500000 ps after Start /CAN input/ To adjust a group, replace with Group1_5

Refer to the header of the *.DAT file for further parameter settings.

7.8 Event controlled measurement
7.8.1 Possibilities for data acquisition

For measurement signal acquisition and storage in electronic systems, analog signals need to be digitalized,
first. This is done by taking discrete measuring values from the continuous signal sequence (Sample & Hold)
and recording them cyclically. Cyclic recording is also used for native digital signals, e.g. for measuring data
packages from bus systems.

For some applications, it is useful to not record CAN bus data cyclically but event-controlled.

In the following, the basic features of both data acquisition types are described.
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7.8.2 Cyclic data recording of continuous signals

Features of cyclic data recording (Plugin IPETRONIK-LOG)

» time-based recording in a fixed time grid, e.g. sampling rate 100 Hz

» different storage groups allow different data rates for recording

» individual time channel for each storage group in measurement data set

» continuous recording in equidistant intervals

» suitable for analog signals

» improved time accuracy due to increased sampling rate (oversampling)

» clear comparability of different signals using a synchronization clock (Master Sample Clock MSC)
» protocol measurement during data acquisition using bus systems is possible (CCP, XCP, FlexRay, ... )
» bus signals are allocated to the respective time grid (sampling rate)

» (time) differentiation of two signals is not possible in the time grid

» sampling points without real signal value are indicated with "NoValue" (invalid) in data set
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7.8.3 Event-controlled data recording of bus signals
Sample graph

Features of event-controlled data recording (Plugin IPETRONIK-LOG)

» event-controlled recording without fixed time grid for bus signals, e.g. CAN bus

» all signals of a message are provided with an exact time stamp, as with traffic measurement
» individual time channel for each message in measurement data set

» discontinuous recording without defined time grid

» suitable for measurement of bus signal differences and of sporadic or single signals

» measuring values in different messages feature different time stamps > in the result graph, the time
stamps do not lie on the same x-values any more

» no protocol measurement possible (CCP, XCP; FlexRay, ... )
» determination of exact time difference between signals (difference between time stamps)

» "NoValue" entries indicating the absence of signals are avoided
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7.8.4 Setting up event-controlled data recording (Plugin IPETRONIK-LOG)
General

Event-controlled measurement, available from TESTdrive 3.51.00 onwards, features the benefits of signal
measurement and traffic measurement:

Signal selection is already interpreted (name, scaling, unit,...). Yet, measurement is not performed cyclically
but with "real" time stamp. Signals are only recorded if they really are present on the CAN bus. Using the
exact time stamp.

Event-controlled measurement appears like a signal measurement on the configuration surface and in the
measurement file. Loggers process the respective storage groups in traffic measurement mode.

Configuration settings

The respective signals must not be recorded cyclically.
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In the storage group, the storage rate has to be set From channel. It should not be a fixed storage rate.

As a result, sampling rate is Event controlled and storage rate is Auto.
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Measurement file

Event-based signals are recorded in an event-based storage group TS_xxxxxx.DAT. A signal-based storage
group DOxxxxxx.DAT with cyclic storage rate cannot contain event-based signals since event-controlled or
cyclic recording types are properties of signals and not of storage groups.

There are two types DAT files:

»  DOxxxxxx.DAT for storage groups with

cyclic storage rate and signals with fixed,

cyclic sampling rate

> TSxxxxxx.DAT for storage groups with
event-controlled, non-cyclic signals without
fixed sampling rate

Conclusions

» Each message that is recorded event-
controlled receives an individual time
channel

» In DAT format of the logger measurement
each message creates an own internal
storage group (TSxxxxxx.DAT)

» In order to ensure strong system
performance, it is useful to check the
number of event-controlled measuring
signals according to the application
(necessary number of storage groups).

Measurement data set

In table view, it becomes obvious that

time intervals are not equidistant any more and
messages (signals) are no more identical. Each
value is measured and saved at the time it
actually occurs on the CAN bus.
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7.8.5 Practical example: Determination of the latency of two signals
Task

An electronic system (ECU) receives messages via CAN bus (input signals) and sends them out again on
the CAN bus, e.g. as forwarding or after calculation (output signals).

Processing time = response time of the system is to be determined.

Realization

The response time results from the time difference between input and respective output signal. Since both
incoming and outgoing CAN messages are provided with a time stamp, the exact time difference can be
determined through event-controlled measurement.

Advantages:
» No event gets lost (not fixed to a sampling rate or to several signals within one sampling interval).
» Unique time stamps from TESTdrive are used.
» Event-controlled measurement is based on traffic measurement > traffic group.

» Each ID generates an event with a new signal value.
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8 Options (license required)

8.1 Hardware options (internal)

M-LOG and S-LOG can be extended by 3 slots with different IPETRONIK cards. Max. 3 cards can be
combined depending on the assignment to the extension slots and the port replicator. The active CAN cards
support a highly accurate 1 ys time stamp. This time stamp is synchronous for all inputs within a card.

8.1.1 CAN cards

The following CAN cards with galvanically isolated high speed inputs acc. to ISO 11898-2 and low speed
acc.to ISO 11992-1 are available:

» 2 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
» 4 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer

» 3 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+ 1 x CAN Low Speed (5 V, fault-olerant)

» 3 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+ 1 x CAN Low Speed (24 V)

8.1.2 CAN/LIN cards

The following CAN LIN combination cards with galvanically isolated inputs are available:

» 2 x CAN High Speed, WakeOnCAN functionality, active data preprocessing and message buffer
+2xLIN

» 2 x CAN Single Wire (GMW 3089 V2.1) + 2 x LIN

» 1 x CAN Single Wire (GMW 3089 V2.1) + 1 x CAN High Speed, WakeOnCAN functionality, active data
preprocessing and message buffer + 2 x LIN

8.1.3 Ethernet cards
The following ETH card with galvanically isolated inputs is available:
» 2 xETH 10/100 MBit LAN, e.g. as input via XCPonEthernet or FlexRay-Ethernet converter
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8.2 Software options

8.2.1 Import signal description files

IPEmotion supports the import and management of signal descriptions from CANdb (*.dbc), ASAP2 files
(*.a2l), and diagnostic description files (*.idf).

The contents are read and managed by importing the original files into a database (Microsoft SQL-Server).
The original files are therefore not longer required. Please note at updating the CAN system or the control
unit that the current description file must be reloaded to update signal descriptions, if required. An export of
the signal settings changed with IPEmotion into the original description file is not possible.

Import data from a description file: CANdb
(*.dbc), ASAP2 (.a2l), LINdb (*.1df)

1. Select a CAN input (here CAN 01).
2. Select Import from the tool bar.
3. Select the directory and the type of the
decsription file to open.
dbc defines CANdDb files
a2l defines ASAP2 files
Idf defines LINdDb files (LIN Description File)
4. To import an A2L file, select the
communication protocol first
Confirm with OK.
The imported signals (Pool) are displayed in
a table.

P &

General signals at CAN 01 cannot be configured if CAN 01 is already used for IPETRONIK
devices!

Importing signal descriptions from ASAP2 or CANdb is the easiest and most secure method to
configure signals.

Signals can also be manually created at an input (without description file). Select Add
components > Standard CAN from the tool bar within the Signals navigation tab.
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Import CANdb file
Open file E3
Search in: |C:‘l,l..lsers‘Puinc‘lDomments‘l,IPl:‘I‘RDNIK‘l,IPEmotion‘l,Import - | ™ E!r
| ven | Mame Size Changed on: Extension
|7] camdb 5 Log 137 CANZ v4.dbe 2178 05.06.201309:59:42 | .dbc
IPEmotionDema.DEC 1319 03.05.2013 17:19:36
|7] 1PESPeed.dbe 3174 03.05.2013 17:19:36
File name: |IPEn'|otior1Demo.DEC |
File type: |candb (=.dbc) - |
[[] show system files Cpen | | Cancel |
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Import signal descriptions from the CANdb

Signals in data source Select signal Properties of highlighted
signal (Front_right)
/ / <
{#= CANdb import: CfAN 01 \ E3
Drag a column hfader here to group by that colup Project -
Project numb
Name Selection | Sampljpfg rate  Physical range Description Project wersic
o Protocok FreeRunning -~
Protocol FreeRunning
Pressure_Abs = Hz Obar ... 2bar e 10
Pressure_Rel [ -2 bar ... +2 bar CAN baudraty 0Bd
[ Obar ... 3bar 11933 (]

x 5 CURT N P || vesseoe -
Front_left Ll |iHz 50C .. 4200C iR SIM_51459955. .
Front_right O |iHz S0C .. +200C ST alh
Rear Jeft O |iHz 50C . +200C Length :

Sampling rate 1Hz
Read_right O 1Hz S50 C ... +200C —
Exhaust_1 O 1Hz -50C ... +1200C Signal -
Exhaust_2 O 1Hz -50C ... +1200C Mame TPS_Volt
Display identi
Byte order INTEL
Data type 16-Bit integer u...
Bit count 16
Start bit 43
Bit mask fff | h
Physical minin -8
Physical maxi 8
Unit
Factor 0,000244144
Offzet -3
CAMID a|h
4 m | P
Importer i

In this dialog, all signals that can be imported from the description file are displayed.
In the left table, all signals, where the "selection” checkboxes are selected, will be marked for import.
In the right table the properties of the selected signals, the control unit and the protocol are displayed.

Depending on the protocol, a sampling rate or the DAQ list to use, can be assigned to the signals. In the case of a protocol using DAQ
lists (CCP, XCF), you can specify via the column selection dialog, if the signals are configured by the sampling rate or a DAQ list. To
achieve this you should open the column selection dialog, via the context menu of the table header, and then drag the desired column
("sampling™ or "DAQ list™) from the column selection dialog to the table header. The other column is removed automatically.

If in & protocol based on DAQ lists, sampling rates are used for the signal configuration, during import the signals are assigned to the

available DAQ list with the most suitable sampling rate.

Select all IPEmotionDemao.DBC - 4 of 10 signals selected.

OK | | Cancel
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Import ASAP file

Open file E3
Search in: |C:‘,IJsers‘lPuinc‘,Domments‘l,IPI:‘I'RDNIK‘l,IPEmoﬁon‘l,Import - | ™ E‘!r
ven | Mame Size Changed on: Extension
L]
File name: |IPE|110ﬁonDemo.aZi| |
File type: |ASAM MCD-2MC (*.a2) - |
[ Show system files | Open | | Cancel |

= Select protocol == ES

Several protocols can be imported from the description
file, Flease select the protocol to work with,

CCP : 14 signals
KWP on CANM : 14 signals
¥CPonCAN @ 14 signals
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Import signal descriptions from A2L

Signals in data source Select signal Properties of highlighted
signal (Front_right)
T AZC TNEOTC TR O
Drag a column header hefe to group by that column
MName Selection | Sampling rate | Physi Description
T
~
Voltage_1 0V .99 my Test voltage 1 = T
Voltage_2 0V .. 996 my Test voltage 2 E
Voltage_3 -10V .. 49,993 ¥ Test voltage 3 El a 0
Temp_1 1Hz 0*=C .. 255,995 °C Temp measuring value 1 ECU wersion 1.0
Temp_2 1Hz 60 °C . +1370°C | Temp measuring value 2 Protocol: CCP ~
IS : Protocol ccp
Meaval_1 O 1Hz Omjs? . 127,5mfs? |Sample measuring value
Meaval_2 O 1Hz 0mjs2 ... 100 m/s2 Sample measuring value :
Meaval_3 O 1Hz Omfs2 .. 127,5mfs? | Sample measuring value
Meaval_4 O 1Hz 0m/s2 .. 100 mfs? Sample measuring value ¢
Meaval_5 O 1Hz 0mjs2 ... 127,5mfs2 |Sample measuring value £
U_Batt O 1Hz 0V ..255V Battery voltage C
BatTemp O 1 Hz -20 °C ... +107 °C Battery temp O
StrgTemp O 1Hz =20 °C .. +107 °C ECU temp 0
Station ID 12ed
DAQ lists -~
Polling ~
4 m ¢ Polling | +
Importer Sl
In thig dialog, all signals that can be imported from the description file are displayed.
In the left table, all signals, where the "selection” checkboxes are selected, will be marked for impart. =
In the right table the properties of the selected signals, the control unit and the protocol are displayed.
Depending on the protocol, @ sampling rate or the DAQ list to use, can be assigned to the signals. In the case of a protocol using DAQ lists '—
(CCP, XCP), you can specify via the column selection dialog, if the signals are configured by the sampling rate or a DAQ list. To achieve this
you should open the column selection dialog, via the context menu of the table header, and then drag the desired column ("sampling” or
"DAQ list™) from the column selection dialog to the table header. The other column is removed automatically.
Select all IPEmotionDemo.a2l - & of 14 signals selected. OK Cancel

CCP protocol settings Resume active

The ECU can be disconnected and and reconnected to
the CAN bus. Data acquisition is continued after
reinitialization.

Seed & Key

Authentication procedure used for restricted access to
ECUs. A program file provided by the ECU manufacturer
is required to proof access authority.

EPK check
Compares the checksums of the configuration (A2L file)
with the respective sums stored with the ECU.

Use optional commands

Enables optional commands provided by the ECU.
Commands are listed in the A2L file and make the
communication more comfortable.
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You need to copy the Seed&Key file which relates to the ECU to one of the these
subdirectories. If the file is missing the authentication procedure fails.

C:\Users\Public\Documents\IPETRONIK\IPEmotion\Import
C:\Users\Public\Documents\IPETRONIK\IPEmotion\Custom\SeedAndKey

Import PDX file

In order to align the version of the A2L file with the contents stored in the ECU, several PDX files can be
imported at a single CAN knot. Each ECU requires its corresponding PDX file.

The PDX file contains all necessary information to request program and data version from the ECU. After the
import of this information, the logger reads the corresponding data from the ECU using the UDS protocol. A
matching algorithm compares the contents of the relating *.a2l file with the data read from the ECU.

Depending on the result of the comparison, measurement will be resumed, stopped totally or partial, e.g.
with protocol measurements with a CAN, FlexRay or Ethernet ECU.

Program an data version information imported from the ECU will be stored in the log file and the
measurement status file. Tasks that require a Java script are not implemented.

Supported physical connection are: Diagnostic CAN, OBD2 connector, standard CAN tapping point.

Import properties — DAQ list fill level (numerical, graphical)

Highlight the respective DAQ list (e.g. 100 ms sync event channel) and right click with the mouse to open the
context menu, select Import properties.

& Import: 100 ms sync event channel

ODT count: 10

First PID: 255
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Import Diagnostic file

Open fie Es
Search in: |C:‘,IJSErs‘lPuinc‘,DommentsHPH'RDNIK\JPEmoﬁonHmport v| ™ Efr

ven | Mame Size Changed on: Exte... T

B FEmotionDemo.idf Jidf

D IPEmotionDemo_KWPonCAM.idf 5474(03.05.2013 17 .df

D IPEmotionDemo_UDS.idf 8013|03.05.2013 17:... |.idf
File name: |IPE|110ﬁonDemo.idf |
File type: |Diagnosﬁcs (*.idf} - |
[[] show system files Cpen | | Cancel |
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Description file synchronizing

The synchronization feature provides the possibility to compare existing signal descriptions (imported
previously) with the respective entries of a modified description file.

{ Differing properties = | = ES
Property Qld walue e value Transfer =
7 L
4 =
Missing signal handling | Remove Keep
4 Missing signal; IPEmotionDemoz | FreeRunning | SIM_50199999 D11 | Exhaust 2
Missing signal handling | Remove Keep -

0ld file name: C:'\ProgrammelGemeinsame Dateien\IPETROMIKNPEmation\Import\IPEmotionDemo. DBC
Mew file name: C:\Programme\Gemeinsame Dateien\IPETRONIKNPEmotion \Impor t\IPEmaotionDemo 2. DBC

Export (04 Cancel

Possibility 1: Channels within a description file have been modified

Previously a description file has been imported and signals have been assigned to the CAN measuring input.
Now, a new description file containing modified scaling settings of several signals should be used.

Highlight the description file at the CAN input in the left hand system structure and select Import >
Synchronize from the main menu or from the context menu. Search for the modified description file on your
computer and confirm your selection with OK. The new settings will we used for the current configuration.

Possibility 2: Channels have been added to a description file

Previously a description file has been imported and signals have been assigned to the CAN measuring input.
Now, a new description file containing additional channel settings (signals have been added) should be
used.

Highlight the description file at the CAN input in the left hand system structure and select Import >
Synchronize from the main menu or from the context menu. Search for the modified description file on your
computer and confirm your selection with OK. The CAN input will be synchronized with the new settings.
Even if you open the import module again, new channels will be displayed in the left hand area. Select the
channels to import the related settings into the current configuration.
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8.2.2 Detection mode and cycle rate
. 10 ms sync event channel

Polli ng 100 ms sync event channel

Polling functionality is supported by A2L for CCP and XCP, i.e. no DAQ lists are seq sync event channel

required.

IPEmotion offers three different speeds for data requests. The times are reference values because the
values must be individually requested at the control unit and create a high bus load.

SLOW 1000 ms MIDDLE 100 ms FAST 10 ms

Example:  If 5 values are detected in the SLOW polling mode, the 1% value is requested by the control unit
a 2" time after approx. 6 s.

DAQ list or polling?

Communication via CCP protocol takes place by sending the data cyclically or triggered by an
event after the first inquiry. The send rate is defined in the respective DAQ list, e.g. 10 ms, 100
ms or synchronous to an event. Not all control units support this mode or the DAQ lists are not
included in the A2L file. In this case, the signals can be sampled individually with the polling
mode. But this method causes a much higher bus load and therefore longer response times.

8.2.3 Traffic acquisition

The CAN traffic acquisition (also CAN-Trace) allows high-capacitive recording of CAN and/or LIN messages
(total bus traffic) with the CAN/LIN controller of each measuring input. Due to the fact that a huge amount of
data can result from this method within a short time, data acquisition can be restricted with definable ID
triggers (measuring input) and admission filters (traffic group).

Using the tab Triggering a trigger condition can be defined for each traffic group to control data recording
individually.

Filters and triggers

The Traffic id trigger at the respective CAN input of the system structure provides 6 individual ID triggers.
As soon as at least one of the trigger conditions is fulfilled, traffic recording is started (logical OR function).
Without any Traffic id trigger, traffic recording is started immediately after measurement start. Each id trigger
can consist of a single identifier or an identifier range (First/Last CAN ID). Within the trigger definition, each
of 8 bytes from the CAN message can be compared with a reference (supported operators: =, <, >, <=, > =,
< >). Ony if all conditions defined by the tab ID-Trigger are fulfilled, the respective ID-Trigger becomes active
(logical AND function).

Status channels of Traffic id triggers can be used in calculations, e.g. only if a specific id trigger indicates
status 1, traffic recording is started. Without any use of the Traffic trigger status, activate the checkbox
Trigger direct under the tab ID-Trigger to start the traffic acquisition properly.

Data format and conversion

Traffic data is saved in a binary file with header (description) and the actual data, e.g. TD001234.bin. To
generally use the data (e.g. import in CANalyzer), data is converted into the ASCII format with the data
converter.

Use the IPETRONIK data converter version 2.xx IPEconverter WIN with graphical user interface (requires a
license ) or the version with the command line IPEconverter CMD (no license required).

The software, as well as, the documentation are saved at the IPETRONIK CD:

..\IPETRONIK_SoftwareProducts\Tools\DataConverter\...
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Configuring traffic acquisition

[N

Select a CAN input (CAN 02).

2. Select Traffic recording from the main
menu Components or with the context
menu and right mouse button.

3. Now the tree structure shows the new arm
Traffic recording at the respective CAN
input.

4. Select Filter and/or ID-Trigger from the

main menu Add components or with the

context menu and right mouse button to
restrict the recording to the required data.

Marie Active | Description | First CAM ID [hex] | Lask CAM ID [hex]  Operator For Byte 1 Value For Byte 1 [hex] | Data For Bwvte

ID-Trigger 02 I-Trigger

O A A Off 0
1D-Trigger 03 [ ID-Trigger o A | OFF o
1D-Trigger 04 [ ID-Trigger A A | OFF o
1D-Trigger 05 [ ID-Trigger o A | OFF o
1D-Trigger 0A [ ID-Trigger A A | OFF o
4 m (3
General | ID-Trigger
First CAM ID: | A& h Last CAMN ID: |A h
Byke 1; |OFF + | |0 d | |255 d Bwke 55 |OFf ~ | (0 d | [z=5 d
Byke 2: |OFF + | |0 d | |255 d Bwke &; |OFf ~ | (0 d | [z=5 d
Byte 3 |OFF ~ | |0 d | [255 d Bivke 7: |OFf ~| (0 d | |255 d
Byte 4 |OFF + | |0 d | |255 d Bwke 8; |OFf ~ | (0 d | [z=5 d

Trigger direck:
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Creating a traffic group

1. Use Components to create a Traffic
recording. You can add Traffic recording to
any free CAN input.

2. Highlight Traffic groups from the left hand
system structure

3. Select Traffic group from the main menu
Components or with the context menu and
right mouse.

4. If needed, create further traffic groups and
activate all CAN inputs you want to record
traffic data from. You may use traffic data
from a single CAN input in different traffic
groups but recorded dependent on different
triggers.
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Traffic group and ring buffer traffic group settings

Traffic group Ring buffer traffic group
General | Settings | Triggering
Cuick. skark: []
Prefix: []
Ring buffer
Gereral | Settings | Triggering Ring buffer size: @) Duration ls
) Messages

Cuick start: []

Prefix: []

External storage: [

Quick start

Prefix

External storage

Ring buffer size

Triggering

Mode

Pre-trigger duration
Post-trigger duration
Start-trigger
Stop-trigger

Quick start data (which is recorded during logger boot-up)
is identified by a negative time stamp within the traffic data file.

The storage group name ist used for the measurement data file name.

Data storage on external USB storage medium.
Refer to 6.5 USB medium for external storage for detailed information.

Defines the size of the ring buffer for measuring. If the max ring buffer size is
reached, the memory is overwritten beginning with the oldest data.

Continuous acquisition
Skart-trigger
Skop-trigger

Stop is inverted skark
Inactive

Select the trigger mode (depending on the traffic group) from:
Continuous acquisition (no trigger), Stop is inverted start

Traffic group only:

Start-trigger, Stop-trigger, Start- and Stop-trigger (see Triggering)

Data recorded before the trigger event (duration = seconds or messages)
Data recorded after the trigger event (duration = seconds or messages)
Value, which starts the data storage of the respective group.

Value, which stops the data storage of the respective group.
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Using the Start-Stop condition, storage data will not be saved if the stop condition is already

fulfilled at measurement start!
We recommend to define suitable events used for start- and stop-trigger. To guarantee
acquisition start (data storage) in any case, you can set ,1“ as start-trigger condition.

To evaluate quick start data in relation to cyclic data of a storage group, you have to activate
Time stamp channel (for the absolute time) from the settings tab of the respective storage

group.

Filtering

User definable pass through filters enable the filtering of defined areas out of the data stream. This provides
an ID filtering like: Traffic group 01 using ID 100[hex] while Traffic group 02 uses other filters or no filters.
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8.2.4 Statistics calculation

The frequency of signals is counted and evaluated with classifications. To do so, the acquisition range is
divided into equal (equidistant) zones (classes). The current values is assigned to one class at every
sampling and the frequency is counted (see figure).

Advantages Disadvantages

Much less storage required than with a time No original value
related acquisition

Very suitable for statistical analyses (e.g. life  No time reference of the signal
cycle tests)

Classification methods

Different classification methods have been developed in the past whereof IPETRONIK supports the most
common methods (acc. to DIN 45667, FVA sheet):

» Random sampling counting

» Level crossing counting

» From-To counting

» Edge counting

» Rainflow method (available upon request)

Please find further information in the Classification.pdf document (Classifying with KIM/KAR and DIS) on the
IPETRONIK CD or at the FTP info server.

Requirements

Hardware M-LOG, S-LOG, FLEETIog, IPElog
Configuration IPEmotion
Software TESTdrive V03.06 or V03.18 (IPEmotion) or V03.50 (IPElog) or higher

It is recommended to use the latest software version for guaranteeing a clean functionality of all
components..
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Configuring statistic / classification

1st Step Creating configuration
» Start IPEmotion and load an existing configuration or create a new configuration.

» Import the corresponding signal descriptions (CANdb or ASAP2) and/or configure additional
IPETRONIK devices.

» Activate the desired inputs and run the required scaling.

» Select a sampling rate or accept the default sampling rate. Please note that the sampling rate, which is
selectable in the classification, cannot be higher than the maximum sampling rate.

2nd Step Defining storage group (if time related data is also required)

» Create a new storage group with Storage groups and the context menu
Add components to also record the time related signals.

» Assign the desired signals to the corresponding storage group.

3rd Step Defining classification

» Select Data processing in the system structure and select Statistic
from the main menu Add components or with right mouse button
> context menu.

» Select Statistic in the system structure and select Components >
Channel from the main menu or with right mouse button > context menu
to create channels.

» Define additional classification settings within the tabs General,
Settings, and Trigger.

Reset behaviour Data is written into a new classification
file at changing the configuration or at
starting acquisition.

Sampling rate Data storage rate of classification

Trigger (Statistik) General trigger, defines start- and stop- v
trigger, value range 0/ 1

Classification

Name any name for classification
Mode selected classification method )
General | Settings | Trigger
Trigger defines start- and stop-trigger of the active Mode: [Random sample dassfication ~

channel (classification start and stop

From-Tao

Edge counting

Level crossing counting
Rainflow

Time at level
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8.2.5 Operating in FTP mode (terminal server)

TESTdrive version 3.09.00 allows starting M-LOG as FTP server. Data can easily be transmitted with a FTP
software (e.g. Total Commander or WS_FTP). Depending on the user rights, data can additionally be
deleted or written. A separate USB flash drive incl. TESTdriveCmd.xml file is required for this functionality.
The running acquisition is stopped and the log file saved with connecting the USB.

If the TESTdriveCmd.xml file includes the "StartFTPServer" OnConnect job, there is no post processing.
TESTdrive reads the corresponding parameters and starts the FTP server.

Server access requires the following user data:
Version User Password Access rights
V03.09.00 guest none Read to TO directory

A reboot is automatically running at connecting USB flash drive to correctly stop the service as FTP server.

Procedure:
1. Switch-on M-LOG
2. Connect USB flash drive with TESTdriveCmd.xml
3. Connect Ethernet cable between M-LOG and PC, e.g. 600-591.xxx (M-LOG PRO05, S-LOG)
4. Configure network settings of PC, create additional "Alternative configuration”
User defined
IP address: 192.168.0.1 (Example)

Total Commander settings: Server name: 192.168.0.2, Enter user name and password

8.2.6 Recording audio and video data

Recording video data

Data logger supports recording video or single shots with a camera. The camera is connected to the logger
USB port.

Following settings are available:

Resolution Defines the image quality
"Low" 160 x 120 Pixel (B x H) 30/20/10/5 images per second
"Standard" 320 x 240 Pixel (B x H) 30/20/10/5 images per second
"High” 432 x 240 Pixel (B x H) 30/20/10/5 images per second
"Ultra” 640 x 480 Pixel (B x H) 30/20/10/5 images per second

Max. recording timeDefines the recording duration
Frame rate Defines the number of images per second

All three options directly influence the required memory.

Trigger A trigger condition must be defined to start recording.
Trigger mode Triggering to raw data or scaled values

Raw Triggering to raw data

Phys. Triggering to physical values (acc. to scaling)
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Recording audio data

Data logger (M-LOG, S-LOG) supports recording audio signals (sounds, speech) with a microphone at the
audio input.

Following settings are available:
Bit rate Defines the audio signal quality
22050 Bit/s (FM radio), 11025 Bit/s (AM radio), 8000 Bit/s (Phone quality)
Max. recording timeDefines the recording duration
Both options directly influence the required memory.
Trigger A trigger condition must be defined to start recording.

Trigger mode Triggering to raw data (Raw) or scaled values (Phys)

8.2.7 OBD-2 measurement

With releases of the Plugin IPETRONIK-LOG / TESTdrive = V03.22 data acquisition using the OBD2
standard (CAN bus) supported.

The OBD-II international standard details a list of 96 predefined
signals and measurement parameters which makes it easy to
acquire provided operating data by a data acquisition system.
This standard is mandatory for petrol engine cars since 2001
respective diesel engine cars since 2003 and trucks since 2005.

B (] O, a
AOEEEDSE VB A NN OORE - == /el
File: Project | Signals | Acquisition  Wiew  Datamanager  Analysis  Reporking  Scripting Info « e
B Ree [
System  Componments  Impork  Export Check  Adjust Detect  Initialize  Display Details
Configuration Access Yiew
W03.53.00 Marne: Active | Unit | Phys Min | Phys Max | Sensor Min | Sensor Max | Sampling rate
Name 5 |ile -
OBD pracessing O 0 1 [1} 1 10Hz
4 o 50002367 o 001 - Mumber of emission-related DTCs O 0 1z7 0 1z7 10Hz
[ Project settings o 001 - Malfunction Indicator Lamp (MIL) ... O 0 1 0 1 10Hz
4 3 CAR 01 0 001 - Misfire monitaring supporked O 0 1 0 1 10Hz
— L > EDUI - Fuel system monikoring supporked &[]
T AN 0 1
5T e 0 001 - Comprehensive companent monit. .. O o 1 o 1 10Hz
-1_5- 001 - Compression ignition maonitaring ... O 1] 1 o] 1 10Hz
T canns i
] o 001 - Misfire monitoring ready O 0 1 0 1 10Hz
L]
2 pour ol|| 001 - Fuel system monitaring ready m] i 1 0 1 10Hz
Q USE 0 001 - Comprehensive companent monit. . O 1] 1 o] 1 10Hz
ETH a 002 - DTC that caused required freeze ... O 0 65535 0 65535 10 Hz v
& COM-t 0
R General | Format | Scaling | Display | Limit walue
-
= oMz o
Audin 1 active: []
Ch Display 0 Marme: 001 - Fugl systemn manitaring supporked
A |y Logger processing 0 B o el " tori ted
- escription:  Fuel system monitoring supparte
B status 0 P ¥ e
EE Storage groups o Reference:  |001 - Fuel system manitaring supportedy 1 /OBD-2f80002367
=8 Malgroups 0
=B Traffic groups 1}
g Calculations a

b [
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General  Trigger | Diagnostics || Extended

Formula: | 1

fil>)

General | Trigger = Diagnostics | Extended
Trace mode: | Standard -

Trace Format: |Standard -
General | Trigger | Diagnostics — Extended

=

Stored error codes:
Single PID requests:

Wehicle identification number: Request delay: (50 ms

Sporadic error codes:
O
O

Software version:

OBD-2 Extensions (TESTdrive V03.52)

»

»

»

Selectable data rate 1/ 10/ 100 Hz (depends on the ECU)
Measurement start by trigger event

Support of Extended IDs (29 Bit)

PID single request support (each request to the ECU with a PID)

Request delay (delay time between data receipt and sending the following request)
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8.2.8 UDS protocol (Unified Diagnostic Services)

UDS protocol combines KWP2000, GMLAN, and DiagnosticOnCan in one protocol. An advantage is the
clear session handling (higher compatibility of different control units). Furthermore, UDS supports modern

memory structures, which require a > 32 Bit addressing.

The corresponding description file has the ODX extension.

Control units of some manufacturers already support UDS, which will be used as standard diagnostic in near

future.

Jobs overview

TESTdrive V03.15 supports the following jobs, which can be read via UDS:
» FS_READ

» FS_READ_DETAIL

» IDENT
» READ_DATA REFERENCE
» FG_READ

» DYNAMICALLY_DEFINE_LOCAL_ID

These jobs can be defined with an *.idf file.

Storing data

The results are optionally stored as binary file (*.CSV and *.J**) or as trace and binary file (*.CSV, *.J** and

*T*).

The files are identified as follows:
Single data detected via KWPonCAN: BDKxxxx.CSV bzw. BDKxxxx.Jxx
(former description) BDJxxxx.CSV bzw. BDSxxxx.Jxx
UDS data detected via trace mode: BDUxxxx.txx

Selecting protocol

The UDS protocol is selected with the corresponding tab in the import module.

Read more details on the UDS protocol and relating applications from this document:
Manual ECU Diagnostics.pdf
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8.3 Recording GPS-Data

The GPS receiver GPS 18 and the NMEA protocol option, M-LOG, S-LOG, as well as, FLEETlog WAN with
integrated GPS receiver support the continuous recording of GPS data with the global satellite navigation

system. This functionality allows positioning and logging of test routes with a data rate of 1 Hz.

Marne Ackive 1t Phees Min
7 [m]

GPS status ] ]

GPS latitude O | -3,4E+36
GPS longitude O | -3,4E+38
5P speed O  |kmfh [-3,4E+38
GPS altitude ] |m -3,4E+38
GPS sakelibes nurmber O -3,4E+38

e precir EENEEEN

4
General | Format | Display | Limicwaloe | MoValoe
Activer [
Mame: |GPS precision
Descripkion: | Precision
Reference:

Sampling rake: 1 H:z

Phys Ma

1
3,4E+35
3,4E+35
3,4E+35
3,4E+35
3,4E+38

Predefined settings are available to configure the acquisition. The single channels are activated as required.

The accuracy of the positioning data is considerably defined by the number of received

satellites (12 satelites are in the geostationary orbit).

Due to physics, the accuracy of the height acquisition (Altitude) with this method is considerably

lower than that of the length acquisition (Latitude = geographical width, Longitude =
geographical length).

Different altitude signals with FLEETIog STD and FLEETIog WAN.

Depending on the GPS hardware of FLEETIog, the logger acquires altitudes which may differ
from the reference height (geographic NHN). This behaviour is caused by the use of the

"ellipsoidal height" for the height reference.

Please execute a calibration measurement on a heigh which is known exactly to verifiy GPS

data of your logger system.
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8.4 Remote data transfer

The logger offers the availability of wireless data transfer by corresponding options. Single vehicles, as well
as, entire vehicle fleets can be managed from one or several bases. Due to the worldwide good to excellent
GSM network coverage, regional and global test drives can be managed from any base.

8.4.1 Transferring data using GPRS and Internet to FTP server

GPRS3G/CDMA + Internet

\\
Upload ( \

current configuration
+ mesurement data ( )

v,
N -

Download
new
confi guration

.
o

.
o

Node point of the Internet
GSM network server

Components
» M-LOG/M-LOG V3, S-LOG, FLEETIog2, IPElog/IPElog2

User 1

User 2

User 3

Server/ PC with
internet access

» M-LOG, S-LOG with GPRS data transfer option with COMgate WAN, antenna, data transfer

software or with modem, antenna, data transfer software
» Connecting cables

» SIM card for modem (depending on provider)

Functional principle

A logger in measuring mode continuously stores data as defined in the configuration. If the test series is
completed (status of remote signal is inactive, e.g. terminal 15), data is packed and transferred via GPRS in
GSM network to the next node point. This data is then transferred via internet to a FTP server for being
available for download. All data transfer settings are defined in the IPETRONIK software.
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8.4.2 Transferring data using Wireless LAN to netzwork server

WiFi + Local Network

|
|
®
\\\ — User 1
( N —
v —
v -
\\\ | ] U 5
1 ser
WiFi
Client
|
|
]
- User 3
WiFi Network Server/ PC with
access point server network access

Components
M-LOG/M-LOG V3, S-LOG, FLEETIog2, IPElog/IPElog2

»

»

M-LOG, S-LOG with WiFi data transfer option with COMgate, antenna, data transfer software or with
client, antenna, WiFi software

Connecting cables
WiFi access point to connect with network (M-LOG, S-LOG)

Funktional principle

A logger in measuring mode continuously stores data as defined in the configuration. If the test series is
completed (status of remote signal is inactive, e.g. terminal 15), data is packed. If the vehicle is within reach
of an access point (up to 300 m outdoors), data is transferred via WiFi to the access point. This data is then
transferred via local network to a server. If the local network is connected to the internet, data can also be
transferred to a FTP server for being available for download. All data transfer settings are defined in the
IPETRONIK software. Due to multiple encoding options (transmission protocol and user), a very high degree
of security against unauthorized access is guaranteed.
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8.4.3 Data transfer configuration

Activate Update connection parameters to enter the data transfer settings using the
Configuration button.

To ensure an accurate data transfer after TESTdrive update to 3.52.01 or higher, you have to
click this check box also, even if no modification has been made. (The current settings will be
transferred to the logger in any case.)

IP= Data transfer configuration: 80001707 = =|ES

General | Medium selection

—
o
4

Emergency switch-off after:
File encoding:
Activate data remate transfer:

Time synchronization via SMTP;

OoOoao

Activabe e-mail delivery:

Imnpart Export QF, Cancel
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8.5 Configuring COMgate

COMgate transfer

Modem (3G/HSPA/UMTS)
Data transfer by internal modem (COMgate WAN
only). IP= Data transfer configuration: 80001707 == ES

Wireless LAN (WIFI) General | Medium selection | COMgate transfer | COMgate - Maodem
Data transfer by internal WiFi client.

Access Point (AP)
COMgate operates as WiFi access point.

Madem {36HSPALUMTS):
Wireless LA (wiF: [
ficcess Paint (ap1: [
Hotspot
Hotspot (public WiFi access point, e.g. T-Mobile for
Germany) to connect the internet.
(Only with Wireless LAN activated!)

Cisco VPN Import Export K Cancel
Encrypted data transfer through VPN tunnel.

Hokspak:

Cisco vPH: [

COMgate - Modem

Predefined provider IP= Data transfer configuration: 80001707 = |[=] E
Select a predefined provider from the drop down list
(use of provided standard settings).

Provider: T-Online, Vodafone, O2, E-Plus

General || Medium selection | COMgate transfer | COMaate - Modam

Predefined provider: [fonline P
PIN code
Identification number of the SIM card
Authentication FIN code:
Access authorisation by User name and Password. Authantication:
Access point (APN) User narme: [internet

Name of the access point for the modem connection
(APN = Access Point-Name).

Data roaming off
Data transfer enabled only for the defined provider
(radio network availability provided) Prowider (MCC+HMNC):

Provider (MCC+MNC)

Mobile Country Code and Mobile Network Code are
required identification numbers for manually setting of
the radio network provider.

Password: |b-dl
Access poink (APMY: |inkernet.t-d1.de

Daka roaning off: O

Import: Export [w]'s Cancel
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COMgate transfer

Modem (3G/HSPA/UMTS)
Data transfer by internal modem (COMgate WAN
only).

Wireless LAN (WiFi)
Data transfer by internal WiFi client.

Access Point (AP)
COMgate operates as WiFi access point.

Hotspot

Hotspot (public WiFi access point, e.g. T-Mobile for
Germany) to connect the internet.

(Only with Wireless LAN activated!)

Cisco VPN
Encrypted data transfer through VPN tunnel.

COMgate - WiFi

SSID
Net work name of the related access point
(Service Set IDentifier)

Security
WiFi transfer protocol WPA, WPA2,
Radius, MSCHAPV2

Password
Password for user access.

User identification
User name for user access.

Certificate
File providing the certificate for the respective
network connection.

DHCP
Automatic handling of IP addresses (IP assignment)
in the network by a server supporting DHCP.

IP address
Manually assigned client IP address

Sub net mask
IP address range of the sub network

Standard gateway
Network address of the standard gateway

Preferred DNS server

Address of the 1st name server (DNS =

Domain Name System) to link the host name, in case
that only the name of the target server has been
entered.

Alternative DNS server
Address of the 2nd name server as fall back, in case
the 1st DNS server is not available.

IPEmotion Plugln IPETRONIK-LOG
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IP= Data transfer configuration: 20001707

=/ =

General | Medium selection | COMgate transfer | COMgate - WiFi

531D Security Password | User identification | Certificate

Add Up Down

Import Export [o]'4 Cancel

=/ =

COMgate - WiFi

IP= Data transfer configuration: 20001707

General | Medium selection | COMgate transfer

DHCP IF address Sub net mask, Standard gateway

4 m 3
Add Up Down

Import Export [o]'4 Cancel

=/ =

COMgate - WiFi

IP= Data transfer configuration: 20001707

General | Medium selection | COMgate transfer

Standard gateway | Preferred DMS server | Alternative DNS server

Add Up Down

Import Export [o]'4 Cancel
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COMgate transfer

Modem (3G/HSPA/UMTS)
Data transfer by internal modem (COMgate WAN
only).

Wireless LAN (WiFi)
Data transfer by internal WiFi client.

Access Point (AP)
COMgate operates as WiFi access point.

Hotspot

Hotspot (public WiFi access point, e.g. T-Mobile for

Germany) to connect the internet.
(Only with Wireless LAN activated!)

Cisco VPN
Encrypted data transfer through VPN tunnel.

COMgate - Access Point

SSID
Net work name of the related access point
(Service Set IDentifier)

Password
Net work password

IP address
COMgate IP address

Sub net mask
IP address range of the sub network

WiFi channel
Selection of the WiFi channel and the associated
carrier frequency.

Activate DHCP server
COMgate acts as host with automatic IP address
assignment for the clients.

First available IP address
Lower bound of the IP range, e.g. 198.164.0.101

Last available IP address
Upper bound of the IP range, e.g. 198.164.0.110

Security
WiFi transfer protocol WPA2

Encoding

Security protocol (Temporal Key Integrity Protocol)

IP= Data transfer configuration: 80001707

Gereral || Medium selection | COMgate transfer
Madem (3GHSPaIMTS:: [
Wireless LA (wiFi):
Access Point (AP):
Hokspat:

Cisco YPM:

Irnpart Expaort

IP= Digta transfer configuration: 20001707

General | Medium selection | COMgate transfer

5510

Password; | FsE

IP address: (1.0.0.0

S~ |

CiOMgake - Access Poink

ok Zancel

==&

COMgate - Access Poink

Sub et mask: | 255,255,255.0

WiFi channel: |1
Activate DHCP server:
First awailable IP address:
Last available IP address:
Security:

Encoding:

Irnpart Expaort

ok Zancel

COMgate also provides XCP data transfer from the logger system to a mobile device (with
Android operating system) by a WiFi connection. Please read more details regarding to the
online data visualization (using XCP service) with the IPEmotion App in this manual:

IPEmotion-App-V02.xx.pdf .
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COMgate - Hotspot

Predefined provider

IP= Data transfer configuration: 20001707

General | Medium selection

Modem {3G/HSPAUMTS):
‘ireless LAR (WiFD:

Access Paint (AP

Haotspaok:

Cisca WPM:

Imnpork Export

IP= Data transfer configuration: 80001707

General || Medium selection

Select a predefined provider from the drop down

(use of provided standard settings).
Provider: T-Online

Provider
Name of the provider (entered manually)

User name
User name to access the account.

Password
Pass word to access the account.

LoginCommand
Login command to to access the account.

COMgate - Cisco VPN

Gateway IP address
Network IP address of the gateway used
for data transfer.

User ID
User identification

Key (PSK)
Pre-shared key used by two different peer
systems identifying each other.

User name
User name to access the account.

Password
Password to access the account.

IPEmotion Plugln IPETRONIK-LOG

Predefined pravider:

Provider:
User narne:
Password:

LoginCommand:

Irnpork Export

P2 Data transfer configuration: 80001707

General || Medium selection

Miodem {3G/HSPAUMTS):
‘Wireless LAR (WIFD:

Arccess Point (AP
Hotspak:

Cisca WPN:

Impart Export

COMgate transfer

CioMagate kransfer

CioMaate kransfer

S |

Z0Mgate - WiFi | COMgate - Hobspoak

(a4 Cancel

==&

CioMgate - WiFi | COMoate - Hokspat

Peer
User
Password

Login Cormmand

oK Cancel

S

COMgate - WiFi | COMgate - Cisco WPN

O

OF Cancel

IP= Data transfer configuration: 80001707

eneral | Medium selection | COMgate transfer

Gateway IP address: [0.0.0.0
User ID:
Ky (PSI):
Llser name:

Password:

Imnpart Export

IPETRONIK GmbH & Co. KG
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COMgate - WiFi | COMgate - Cisco YRR

[ul'4 Cancel
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9 Display modules

9.1 M-VIEWfleet

M-VIEWfleet is a alphanumerical data display, which is connected to the USB of the logger. M-VIEWfleet
provides different displaying modes besides four status LEDs and buttons. The number of displayed
channels is only limited by the processor load.

Only connect M-VIEWfleet
to the logger if logger is
switched-off. In case
M-VIEWfileet is connected to
logger during operation, the

620-578.030 angled USB interface can be
[:] damaged.
M-VIEW freet

620-574.015

Power + Remote
620-500.003, M-CAN

Termination (600-830.005, SIM-CAN)
620-500.002, M-CAN
(600-830.003, SIM-CAN)

L) E M-Module

Terminatior

M-LOG PR05

S-LOG
M-Module

cANt
CAN4 DI/O

M-LOG-OPT-030
dovetail adapter

M-LOG-OPT-031
mounting plate

620-324.xxx open

600-580.xxx
D Sub D open

M-VIEWfieet is connected to M-LOG with an USB 2.0 interface. A second USB port of the logger is available
at the display. USB 2 is used for e.g. a program update or to exchange measurement or configuration data
via USB flash drive. USB connections are designed for a maximum length of 5 m. Display settings are
defined in the system configuration.
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9.1.1 Keys and LEDs

Operating status LEDs Value status LEDs
Red Error For induvidual control by
Green M-VIEW detected by logger

Value display
2-lines display of

user .
sianal and value
DATA/PWR socket
Cable connection to
logger

—

Light sensor
For brightness control

Audio input

To connect a
USB socket / microphone
For data exchange with
USB flash drive /

Status line

With additional
On/Off / information

Out of operation

Menu OK Up/Down
Start/Stop acquisition Switch, Scroll, Buzzer Manually scroll display
off, Clear alarm

Status line

The scroll mode MANUAL (with Up/Down keys) or AUTO (automatically) is displayed in the right zone of the
staus line. The following informatiojn is alternately shown in the left zone:

DATAFILE Name of current data file
TIME LEFT Available time in days (D) and hours (H) for data recording

DRIVER Selected driver

SHIFT Selected shift (track or road sections belonging together)
OK

Function in standard display

1. Display Min/Max Press longer than one second

2. Back to standard display Press longer than one second

Function in standard display in scroll mode AUTO:

(Changed from AUTO to MANUAL with Up/Down keys)

1. Back to auto scroll mode Press longer than one second

If the key is not pressed, the display changes after 30 s into auto scroll mode.

Switching from MANUAL to AUTO is only possible if auto scroll mode has been activated!
Function at configured alarm limit values:

1. Buzzer off Shortly press to switch-off buzzer

2. Clear alarm Press longer than one second, Back to standard view

If the alarm has already been cleared 5 times, a final message appears to definitely delete the alarm.

Up/Down A V

One line up A

One line down v

Switch AUTO > MANUAL A or V if AUTO (Auto scrolling) has been activated in configuration
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Menu
Stop acquisition -> Press longer than two seconds

Start acquisition -> Press longer than two seconds

The option Allow start and stop of acquisition must be activated in the configuration. The
measurement file number is increased by one at every acquisition start. If the option Track or
Track/Driver (List type selection) is additionally selected, files can be merged to one file until
the final end of data recording.

Devices connected to the logger remain switched-off until acquisition stop.

Operating status LEDs
Red 1. Error

2. Logger is booting, initializing M-VIEW
Green Operation, M-VIEW detected by logger
Value status LEDs

The 4 status LEDs can be controlled with calculations. Additional limit violations can therefore individually be
displayed.

9.1.2 Configuring M-VIEWfleet
» Select Display in the tree structure.

» Select Add components.

» Select M-VIEWfleet.

» Select the desired signals.

» Confirm the desired signals with OK.

- Ch_ Display 4|l General | Settings
4 _J M-YIEWFleet M-YIEM Fleet 4 Tremale
!
- (@) TransFer fram channel configuration
e LEDs 4 - o} 5
N (1 Manual
A [ﬁ='§| Data processing 1z

Define the alarm values for the upper and lower signal limit, if desired. If the current signal reaches the alarm
limit, the display changes into the message window and the buzzer sounds. Clear the alarm with OK.

Activate the detection of the minimum and/or maximum values for the respective signal. With pressing OK,

the display changes into showing the minima and maxima. If the detection has not been activated, ====== == is
shown. Pressing OK again changes back to standard display.
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Define status LEDs for limit display

The 4 status LEDs can be activated by separate and user-defined calculation formulas. Additional thresholds
can therefore be defined and reaching these limits can optically be signalized. In addition, the LEDs can be
used as status display for the 4 digital logger outputs.

To do so, the following options are available:

» Use the same formula like at the corresponding digital output

» Status query of digital output to 1 (LED ON, for the time digital output = 1)

Setting display modes

Select Active to use M-VIEWfleet in the configuration.

No further settings can be defined without activating M-VIEWfleet! If an existing M-VIEWfleet
configuration is deactivated, the logger display has no function! This is signalized by the red
LED. The red LED is also on if the USB port is damaged during operation by disconnecting the

cable.

4 O pisplay
[-YIEWFleet M-YIEW Fleet

Channels
e LEDs

4 @ Daka processing
f Skatus

@ Local skorage groups

Local calculations

=

IPEmotion Plugln IPETRONIK-LOG

General | Mode

4
K Scroll mode: | OFF
4
4 List tvpe: | QFF
1z fllow start and stop of acquisition: [
12
- Merge measurement Files:
Confirm shiftftrack at stop
IPETRONIK GmbH & Co. KG ipetronik.com
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Scroll mode

Off Manually switching lines with Up/Down

5s Continuous line switching in interval of 5 s, display moves line by line from the bottom up
in order of signal list

List type

Off Neither track nor driver defined

Track Track selection by driver is assigned in data

Track/driver Track, as well as, driver are selected before start and set in data

The text file of the track selection list is defined in:

..\IPETRONIK\IPEmotion MAL-Plugin IPETRONIK LOG V03.xx.xx\Data\MViewfleet\MVIEWfleetTracks.txt

The text file of the driver selection list is defined in:

..\IPETRONIK\IPEmotion MAL-Plugin IPETRONIK LOG V03.xx.xx\Data\MViewfleet\MVIEWfleetDrivers.txt
Changes of the entries can manually be defined in the respective text file.

Allow start and stop of acquisition

Pressing the menu key stops the data storage and the current measurement file is closed.

Pressing the menu key again starts the next data storage and the number of measurement file is increased
by one.

Merge measurement files
This function requires a selected list type!

The end of every acquisition includes the End Shift xxx query. If it is confirmed with OK, all previous partial
acquisitions of one file are merged and the number for the next measurement file is increased by one. If this
function is not activated, an own file is written after every acquisition stop and a following acquisition is
recorded with a new number.

Confirm shift/track at stop
A selected list type is required for this function and Merge measurement files must be activated!
The query runs after acquisition stop:

End Shift xxx! Yes OK? Track is stopped, partial acquisitions are merged in one
measurement file

No OK? Track is continued at next start with same measurement file
The query runs after acquisition start:
Shift xxx Good Trip! OK? Currently saved track is continued with new acquisition file

Change OK? Track and driver can be selected again

If nothing is entered after a query, an acoustic message sounds after 20 s and the saved
settings are accepted for the next acquisition.

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 138/ 175



Display modules

9.2 IPEconnect (Online display with Smartphone or tablet)

IPEconnect serves as an online display for IPETRONIK data loggers. The system consists of the
components data logger (M-LOG, IPElog, FLEETIog), IPEhub2, corresponding connecting cables and the
mobile device (Smartphone, tablet) with the IPEmotion App.

9.2.1 Overview

»

Smartphone / tablet for online data visualization of the data acquisition running on the logger
WiFi access point IPEhub2 as gateway from the logger to the Android display

System configuration with IPEmotion

Quick installation, easy and stable operation .. .
Minimum requirements

- IPEmotion 2015 R3

- Plugin IPETRONIK-LOG V03.56
- IPEmotion App V02.13

- IPEhub2 Firmware V01.03

- IPEhub2 with IPEconnect license

9.2.2 Features
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Creating the data configuration (online data) based on the logger measurement configuration.
The IPEmotion App imports a new configuration automatically.
Creating the configuration for the online visualization with the mobile device.

The blue LED at IPEhub2 indicates a successful WiFi connection.
Name of the network / SSID: Logger_[Serial_number]

The app configuration on the smartphone / tablet is saved on IPEhub2.
Shortly after the app has been started, it shows all defined values.
IPEhub2 can be connected and disconnected at any time (even during a running measurement).

If a connection is disturbed or interrupted, IPEhub2 will re-establish the WiFi connection immediately.
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9.2.3 Cables

620-689.xxx LOG-VIEW Cable IPEconnect (M-LOG, M-LOG V3, IPElog)

620-691.xxx FLEETlog-VIEW Cable IPEconnect (FLEETlog, FLEETlog2)

9.2.4 Settings
Logger USB interface

- Setup IPEhub?2 at the logger’s
USB interface

4+ @ usB 0
&=  IPEhub2 [ ol
4 ﬁ KCP service 14

%  DaQlistslow 2
%  DAQlist medium 12
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- Assign all required channel to the
DAQ lists

- available DAQ lists:
Slow > 1 Hz data rate
Medium > 10 Hz data rate

App export
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9.2.5 App display

The app shows consecutively signal values as soon as the WiFi connection is established and the logger is
operating in measuremend mode.
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9.3 Connecting displays via openABK

With the implementation of the protocol openABK (short for open display and operating concept) in the
Plugln IPETRONIK-LOG V03.60 (and corresponding TESTdrive V03.60) standard displays that are
supporting this protocol (e.g. the EMBU-Sys displays from the CANDICE series) are supported.

9.3.1 Cable connection

The display can be used for data loggers IPElog2, M-LOG V3 and FLEETIog2 with an USB2ETH cable
connected to the VIEW socket of the logger.

V03.58.00

Mame Front number Z
. . . | 82500000 a 2
9.3.2 Display configuration B rorkersishrgen ;
The configuration of the measurement data visualization is set I - :
by the software of the display manufacturer. For CANDICE the T ocanos 0
EMBU-Sketch software offers an individual configuration of display I cwos o
. . . 7 CANDS 0
instruments and function buttons. Furthermore, the display has to be T ono )
created within the logger configuration by adding an USB component. T ocanes 0
T canos 0
T canm 0
T ocan1 0
i [eT— T ocan12 0
LY Display 0 General | Mode i ’
] Manufacturer: i85  pout 0
J Channels 2% & uss 0
Type: USBoETH 0
|;| openABK a
serial number: | 00- P W=

List type: | Tradk/driver -

Layout file: | :\Users\Public\Document: ---

9.3.3 Use display buttons for triggering
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10 Accessories

10.1 Electrical accessories

10.1.1 COMgate

COMgate is an intelligent extension device for logger and allows remote transmission of measurement and

configuration data.

M-COMgate in mounting enclosure for M-LOG

COMgate is available in 2 versions:

COMgate WLAN acc. to WiFi 802.11 a/b/g

COMgate WAN WLAN acc. to WiFi 802.11 a/b/g
and modem for GSM/GPRS/3G

4 status LEDs

SMA for WiFi antenna

FME for modem antenna

LED status display
LED display
GREEN

ORANGE

YELLOW

Status
PWR ON

MODEM

MODEM

MODEM

WiFi

WiFi

WiFi

\>
i

/

Lemo OB — socket PWR / ETH
Cable 620-614 to logger with
ETH socket Lemo 0B 7-pin

Meaning
Device is ready for operation

(operation: see LED yellow or orange)
Establishing connection to UMTS/GPRS network
Successfully registered to UMTS/GPRS network
Steady connection

Establishing connection to WiFi network
Successfully registered to WiFi network

Steady connection.

Interference, potential reasons are:
- transfer of new configuration

- wrong configuration loaded

- general operating interference

M-COMgate requires additional external cooling on M-LOG at operating in ambient
temperatures > 70 °C (158 °F)!
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10.1.2 Extender
CAN-Extender

f

/'

f

Input with status
LED (Bus traffic)

Operating status
LEDs

ETH/PWR socket
to M-LOG

M-LOG Extender is an extension device with 4 additional CAN inputs. M-LOG devices, which are already
equipped with a LX800 processor board, as well as, the option Input 2x Ethernet, can be extended without
modifying hardware. The extender is screwed to the bottom of the basis device with 4 screws and connected
to the logger with the cable 620-406.002 (here PR08, or 620-404.002 for PR03 and 620-405.002 for PR04).

Requirements

» Data logger with LX800

» Option Input 2x Ethernet (with respective port replicator)

» free Ethernet input

» IPEmotion + LOG-Plugln = 03.19 (Creation and configuration see ETH 01/02 port)

Advices

» The bus inputs of the extender do not support WakeOnCAN and traffic acquisition.

» Data is directly stored on the logger.

» The maximum data rate is 100 Hz.

» The configuration is extended by the additional file *.ecf (Extender Configuration File).

10.1.3 IPEwifi

IPEwifi is as wireless extension for IPETRONIK data loggers (M-LOG, S-LOG)
supporting radio data transfer using the WiFi standard 802.11 b/g.

Status indication

PWR  Ready for use
LINK LAN data transfer
WiFi Wireless LAN data

transfer

|

LAN / PWR
. LAN data transfer and
Measurement data is transferred on command or module power supply
automatically without any cable connection to a
network access point. IPEwifi acts as a communication bridge \

and forwards measurement and configuration data. IPEwifi
itself neither supports router functions nor subnetworks.

Antenna

SMA(R)-UFL connector

L~
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IPEwifi setup via web browser,
» refer to separate manual IPEwifi

Setting up a LAN connection for the logger

IPEwifi operates in bridging mode (means as LAN cable substitution), thus logger settings are similar to a
direct LAN connection to the network connection point.

»

»

»

»

4

Start IPEmotion
Open an existing logger configuration or create a new one
Highlight the logger in the left hand system structure

Move to the configuration dialog (right hand lower area) with the Data manager tab, activate the check
box Update connection parameters and click the Configuration button.

Click to the Medium selection tab and activate the LAN check box.
Activate the check box Get IP address automatically
Confirm and close with the OK button.

Transfer the current settings to the logger.

This settings enable the logger to receive its IP address through IPEwifi using DHCP services of the network
server.

Connecting IPEwifi and the logger with a LAN/PWR cable

»
»
»

Connect IPEwifi with the logger as shown below.

As soon as switched on, the green LED lights permanently.
The yellow LED indicates a properly working LAN connection.
The orange LED indicates a properly working WiFi connection.

Cable 620-614.xxx (PR05, PR08)
Cable 620-051.xxx (PR04)

Depending on the logger settings under COMgate switch-on condition from the System
activated tab, IPEwifi will be supplied with power by the logger

Acquisition during the measurement,

Postprocessing during data post processing, as soon as measurement is stopped,
(follow-up time is running),

Always as soon as the logger has started.

If the logger is not able to communicate with the network, although the settings are correct and
the WiFi connection is steady (indicated by the orange LED), please check the entries of the log
file (MEA_xxxx.log).

As former M-LOG devices with port replicator PR05 have a 6-pin Ethernet connector, a direct
connection (single cable) using the cable 620-614.xxx is not supported. Only devices with 7-pin
Ethernet connector provide the lines (Pin 6 and 7) for the IPEwifi power supply.
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10.1.4 GPS receiver

» GPS mouse for satellite positioning
» Connection to the serial logger interface

» Predefined settings of NMEA protocol configuration software

10.1.5 Bus isolator SAM-CAN-ISO

» High ohm connection of hardware to vehicle
CAN

» Electrical isolation between vehicle bus and
measurement system

» Connection with short stub

» Version “Hear only* to avoid unintended in-

fluencing of vehicle CAN SAM-ISO011-23A0

Has e1 approval (Vehicle Type Approval VCA) for
directly connecting with the CAN bus of public
vehicles without restricting the type approval.

10.1.6 iMIC

» compact multifunction device (1.57 * 1.44 * 0.98 in) (40 * 36,5 * 25 mm)
» Voice recording with audio input

» good voice quality

» illuminated trigger button

» 3 status LEDs (green, yellow, multicolor)

» integrated buzzer

Button (illuminated)

Triggering of data recording and/or voice recording via digital input 1.

Status LEDs
LED Yellow Indicates the status of digital output 2 (LED is on if output is active.)
LED Red Indicates the status of digital output 3 (LED is on if output is active.)
LED Multicolor

green Indicates the status of digital output 1 (green light)

blue Indicates the satus of the yellow LED (blue light)

red Indicates the completed boot process. The excitation of the connected devices (at M-
CAN or SIM-CAN socket) is switched-on.

Buzzer

Acoustically indicates the status of digital output 3 (Buzzer ON if output is active).

The specific functions of the digital inputs and outputs are defined in the measurement
configuration (see Standard functions calculations, trigger, Use of digital inputs and outputs).
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The button functionality, as well as, the LEDs and buzzer functionality also depends on the
wiring / PIN assignment. If another cable than 620-607.xxx is used, functionality can differ from
the one described above.

Cable 620-607.xxx

P1
ST —
\\ P5
—— = TN
,.,>/ ~ < ﬁ_ 3
. | ‘I‘ f Frontseite

| /
| -
/) [Loa -imic
@ ; == {Wic —~  |620-607.XXX

XXX = Lénge [dm]

Frontseite

PIN assignment cable 620-607.xxx

P1
Y
1 DIN-1
2 DIN-2
3 DIN-3
DIN-4
g q DIN-GND - - . P5
D) LOG-PWR +PWR/Multi-LED=Rot —
DI/O 7 H LED1 (grin) Multi-LED=Gridn =7
8 LED2 (gelb) VW LED=Gelb s =g
9 3 LED3 (rot) | LED=ROT+SUMMER]| —
10 H DIN-GND I~ Multi-LED=BLAU ~1 =4 |imMIC
1 DOUT-1 — >
12 DOUT-2 —>
13 DOUT-3 M~ TASTER - I
14 H DouT-4 MIKROPHON =9
DOUT-COM
15 T T =10
o alh i
1l MICR-REF A
Mikro/ 2 MICR-SIG
Headphon 3= HEADPHON-GND
4= MICR-GND
5 HEADPHON
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10.2 Mechanical accessories

10.2.1 Module mounting
Dovetail adapter

Adapter plate for mounting to the right
M-LOG housing for connecting M
devices without tools.

Fastening elements

2 fastening strips for mounting
at the device bottom to screw M-
LOG to an even surface.

Snap-in fastener

2 snap-in holders + 2 fastening strips
for mounting at the device bottom to fix
M-LOG at an even plate without tools.

Snap-in adapter

Mounting plate to use a snap-in fastener to fix M-LOG to plate without tools.

Suction pad holder for M-VIEWfleet / M-VIEWgraph

Suction pad holder with pump for fixing driver display on smooth Figures are
surfaces e.g. at windshield. subject to
change!

Due to safety reasons, the bottom of the display housing must rest on an underlay (e.g.

instrument panel). Avoid a free mounting and do not use the suction pad holder alone for drive
tests.
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11 New features
11.1 Plugin/ TESTdrive V03.56

11.1.1 Measurement data processing

Using several CAN send blocks with a single CAN knot

Data of a CAN knot can be send with different data rates (with the send block) or you can send CAN
messages using different start IDs. CANdb export is supported per CAN knot (a description file containing all
CAN send blocks) or per CAN send block (a description file per CAN send block).

11.1.2 Status information (online)

Web interface

The logger’s service web site shows status information, log file contents and a listing of active signals.
A specific IPEmotion configuration is not required.

When using IPEhub2 (IPEconnect feature), the standard IP address 192.168.232.9 is used.

Alternatively the IP address, that has been assigned to the logger, can be used. Use the Ethernet branch in
the system structure of the logger configuration to enter the IP settings.
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IPEmotion Plugin IPETRONIK-LOG

169.254.128.128

169.254.128.128

€ 10.1.20.125/GUlindex.html#/log

 IP=TRONIK

Log

Status  Signals

2016-06-13 09222730
2016-06-13 09:22:31
2016-06-13 09:22:31
2016-06-13 09:22:31
2016-06-13 09:22:31
2016-06-13 09:22:31
2016-06-13 09:22:31
2016-06-13 09:22:31] | Configuration file: Unnamed1.iwl
2016-06-13 09:22:31] | Measurement start

i | 1 Work tinished -
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[2016-06-13 09:22:33] D Storage group 1 (1 Hz) "Storage group 01" Start (0 ms
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]
[ ]

D Free disk space for starting measurement: 2294 VB
D Stopping measurement below :1911 MB

| Start parsing xml file

| Time for parsing xml file = 114ms

D StartDateTime: 2016.06.13 - 09:22:32

| Datafile: MEA_1096

2016-06-13 09:22:34] | ETH 0: My IP address is: 10.1.20.125
2016-06-13 09:22:34] | ETH 0: My Netmask is: 255.255.0.0
2016-06-13 09:22:34] | ETH 0 Server IP address is” 10.1.1.102
2016-06-13 09:22:34] | ETH 0- Found 1 DNS Server by DHCP
2016-06-13 09:22:34] | ETH 0: DNS Server[0] IP address - 10.1.1.102
2016-06-13 09:22:34] | ETH 0: Found 1 Gateway Server by DHCP

2016-06-13 09:22:34

2016-06-13 09:22:34

2016-06-13 09:22:35

| ETH 0: Gateway Server[0] IP address - 10.1.1.2
| LOGZPCControl - Init
| Telit modem UCBB4E attached

m

Autoscroll

Sign of life and refresh rate

The status bar of the web interface shows the sign of life and the update cycle at the bottom left

corner:

Refresh rate
Sign of live

Web service polling rate (signal request from the logger) in Hz
Text output indicating the connection status (online or offline),

The refresh cycle of the status indication is 10 s. During the status
offline the refresh rate shows 0 Hz and signal values indicate
,Not available”.

The decimal places of the signal values listed in the the web interface are configured by the
respective channel properties. Go to the IPEmotion Signals area, select the channel, open the
Display tab and enter the drop down menu under Formatting fo choose the Decimal places

settings.
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Plugin / TESTdrive V03.57

11.2.1 Measurement data processing
Using last value from previous measurement

For calculations under Logger processing > Formulas, the user can define, if the last measurement value
of the previous acquisition should be used as the first value of the current measurement. This feature is not
supported for calculating trigger conditions (switch-on conditions, activating storage groups). The parameter
Resetting behavior is set for each calculation. Default setting is At acquisition start and corresponds to
the formerly behavior (no use of values from a previous measurement). Selecting At configuration change
means, that the value is not recessed by starting a new measurement, but definitely with a configuration
update.

Release XCPonUDP import for USB2ETH adapter

The import of A2L description
files is supported by an
USB2ETH adapter.
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11.2.2 Data storage
Quick start recording

Depending on the traffic group settings, the Quick start feature records measurement data during the logger
boot-up and between two consecutive acquisitions (previous acquisition is stopped but the following
acquisition is not yet started). The modified function is now providing 3 options:

- Off No Quick start recording
- ON Quick start recording during boot-up and between measurements
- Only at start Quick start recording during boot-up only

The second option (Quick start ON) corresponds to the formerly behavior. Selecting Only at start will
record data only during boot-up, not between stop and restart of an acquisition.

Post processing delay times

If the Postprocessing has been activated, two specific option can be defined.
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» Start Delay The postprocessing starts with a delay of x seconds past to measurement start.
Value has to entered in seconds. Default setting = 20 s. Valid range: 10 s — 5 min.

» Retry Delay Restart of the data transfer in case of the unsuccessful attempt (sample cause: FTP
server unavailable, insufficient data rate, ...):
Value has to entered in seconds. Default setting = 900 s. Valid range: 30 s — 30 min.

To modifiy the current settings, enter the extended systems settings under
Options > Plugins > Plugin IPETRONIK-LOG > Options > Open system setup

11.2.3 Data transfer & communication
WLAN status information

TESTdrive cyclically executes a WiFi SSID scan every 30 seconds in order to report all available WLAN
networks and networks that are no longer accessible. The report only contains changes related to the
previous scan. The log output of new connections is listed with SSID, alle channels and the signal strength
(RSSI in dBm). Connections that are no longer available are listed with the SSID only. The WiFi scan feature
is supported exclusively by data loggers with built-in WiFi device (no support for M-LOG/M-LOG V3 with
COMgate/COMgate V3).

Sample of a log output:
New contact to WLAN network(s) :

SSID Channel(s) (RSSI [dBm])
IPE-TESTING ; 1(-100); 5(-65); 11 (-71);
Hotspot_Xdtfr ; 1(-98); 5(-65); 11 (-71);

Testbench_PT25432 ; 11 (-69);
Lost contact to WLAN network(s):
SSID: IPEhub2_03561

SSID: Testbench_PT25377

SSID: Hotspot_Xdtfr

Category overview

Storage, traffic and statistic groups now provide the new tab Categories. Select a group and assign it to one
or multiple transfer categories. The overview dialog shows all selected groups in the respective category.

Genera Settings Triggering Categories
MoTransfer: =
™ Category 1 b4

Category 1: |+

MName Selection Description Reference
Category 2:

¥ [
Category 3: " f
S I Storage group 01 | Storage group on the data logger Storage group 01/82500000
Storage group 02 Storage group on the data logger Storage group 02/82500000
1 of 2 selected oK Cancel
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12 Appendix

12.1 Cable connection and Pin assignment
12.1.1 M-LOG port replicators

Port replicator PR05 (4x Sub D 9, PWR-IN/REM Lemo 1B 6 pin)

Internal circuits PR05

Portreplikator | M-LOG Grund

8.4V/4.5A '

+Unioc p, l 539
GND___p, 10AFF

2.5A MultiFuse

2.5A MultiFuse

—————————p M-POWER

Modem Power

_E—> GPS Power

0.3A MultiFuse

Cable reference PR05

LOG
Power
0.3A MultiFuse
— p o
0.3A MultiFuse
CAN2
0.3A MultiFuse
CAN3
0.3A MultiFuse
o
0.1A MultiFuse
b—1 ) UBOUT(4x)
0.1A MultiFuse
LED Griin
0.1A MultiFuse
LED Gelb
0.1A MultiFuse
LED Rot

IPEmotion Plugin IPETRONIK-LOG

CAP

3V3

5V/0.5A >

5V/0.003A

e

5V0

IPETRONIK GmbH & Co. KG
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PIN assignment PR05

L : ) WENT WhEg IDETTRRER —
©'00L 0%C-C08 HAQWo HIT a0cosl Bronvoupem| » +1n0 mm“
neie MINOYLId] [Pl evcoer] [Ing=als[ ¢ o-
Bunbsjag/BunuysiszsiLupisuy HIT snanss 3
1-504d Lou_.mv___awgton_ AN 60/ED _._“_mm_ e
M) L0°p08L] 229 =
OOTIN [Fuweq | wmeg [ go0C TTT B33g-3Uy 1102g 34|
—\lmomﬂ_ +1N0-8n=6 {yns “jed  gang)
[NWDUDEM PNVD'NI-LLWEA) uondo=g L NIT + € NvD
5
(N¥OUDEM GNYD'NI-LL¥EA) uondo=s — L NVD + £ NYD
_H-ZTNITIH-ENYO=5 +1nC-an=6
(hSuMe-ZES =0 OND-TNIT//OND m_“wuﬂw“m {NVYOUQEM TNYD) Z_.”.l.q._..”_._m
Juo-ssn=s LIVBA-ZNIIT-ENYD=1 ) ano-y
[LNZI12) +¥1vQ-£95n=s (uns "jod g gans) (NFIUOEM TNV HILLTEN Be
,,“H“mwmmnmm NI+ ¥+ NYD OND-DITNVD=E
-Y1v¥a-z8sn=t J3po ”__“Mnﬂw”w
Oledmd=t 8 NVD + ¥ NYD )
faonsd=c (uns “jod  aans)
B g NVO +Z NVD i
gl JY“.M A_..__.JLm _OQ D_v. m_. O_..Cwl_u (NwDupe —Z(U.Z_.._L.(.m_ﬂ._l_uw_wmo”w
aND-NI-EMd=F MIIA-W ) H-LNYD=L
ONO-NI-EMd=E OND-EMJ=0
+u".wﬁnuw [(NWOUORM GNWD'NI-LLWEA) wondo=¢
Nimmae: H-eN¥D=F
_ ey iinvas ol ab unib
(1009 = ‘Poy “Jod @ g} owaT) aNO“S/tNVO=E mej mm_m_._ s
A1 0WIHNI-=Mmod T-GNYD=1 .
! ! J ! (u1s “lod § Qans) v
G NVD + L NYD J | 7 ]
1-NYD-H=8 —T
H-N¥D-H=3 |
aNa-Hmd-H=1 (wanost) | gsn 79 k
aNa-HMd-H=0
OND-N¥D-W=5 o 0 o
ONAS t
+ONAS-HI=E
SuMd-H=2 ,
Hma-H=L S
(neig’,0¢ = ‘poy “jod g owaT) Y
NWO-IN
00-1N00=51
1Nca=+l
(asyang-vIns) 1noa=el
auUBUY-NYIM - uondo theath
2-NI0=0}
) e-031=8
7-031=8
1-a21=L
NOHZOY3H=¢8 2-901=9
ONS-H2IN=% 9-MN10=8
OND-NOHLO¥3H=E »-Ni=+
=T £-NI1Q=¢
=1 ane-Emd=sl z-Nig=z
(nesBjod g gg owaT) HMd-H300N=s1 ﬁ ot i z_u._v < VGl asn4 ou +HMd-I
auoydpeap/omiy aNDa=z. HAS jod5L dqnsaH . o o e
gxi-Tnoo-1; e-la3vinoamia | == vee vee HMIEAD
=d < VG0 WEET HMd-W3aow
S1O- 00=3%
Einaa vED v ED +HMd-907
20=%
mwm” mmww Y L0 L] 1No-gdn | +NI-dad
R PIUIMMS | |15 1o Y| usBUNIZLIS 1no)  —=—NI

(ssiam‘"jod ;y gp owsa)

JENTLIE!

(asuyong “jod 5Laqns aH)
SAO/NIAONZNODILINOD

YOI 058+ 01 D.0%-
NI LNIHEND "XV

156/ 175

ipetronik.com

IPETRONIK GmbH & Co. KG

IPEmotion Plugin IPETRONIK-LOG



Appendix

Port replicator PR08 (4x Sub D 9, ETH, PWR-IN/REM Lemo 1B 6 pin)

PIN assignment PR08
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12.1.2 FLEETIlog2-01
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12.1.3 FLEETIlog2-03
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12.1.4 FLEETIlog
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12.1.5 IPElog

IPEmotion Plugin IPETRONIK-LOG IPETRONIK GmbH & Co. KG ipetronik.com 161/ 175



Appendix

12.1.6 IPElog2
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12.2 Starting up
12.2.1 Overview Configuration & Measurement

Configuration

Start
Configuration

Create new
Device/System

CANdb
or ASAP2 for
CAN config?,

Yes

Import CANdb or
ASAP2 file

SIM- or
M-Modules and
M-LOG?

Yes

Configure modules
directly or import
CANdb

USB > M-LOG
Measurement data M-LOG > USB

Configuration file

Ll‘
V|‘

[———Measurement

Save Configuration
to USB stick

v

Insert USB stick
to M-LOG

easurement
data on
M-LOG?

No

M-LOG saves data
on USB stick

A

Copy new config.
to M-LOG

v

Remove USB stick
(as soon as yellow LED
is permanently off)

&

Y

USB stick
insert?

Stop Measurement

IPEmotion Plugln IPETRONIK-LOG

Gather and store
measurement data
as configured

IPETRONIK GmbH & Co. KG

Configuration via IPEmotion
(license required)

Create new or read and process
existing configuration.

Configure bus measurement input by
import of the respective description file

Configure via IPEmotion

Save configuration as an MCF file (*.mcf).

In case M-LOG is switched off,
> switch on the module before.
(Do not switch on M-LOG with
the USB stick insert!)

If not already existing, M-LOG creates an
specific subdirectory and saves measurement
data and the latest configuration to the USB stick.
The name of the subdirectory consists of the
serial number of M-LOG.

Transfer new configuration from the USB stick
to M-LOG

M-LOG automatically starts the measurement
application and reads the current configuration.

M-LOG will switch off as soon as the remote
input becomes inactive.
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12.2.2 Flow chart of the measuring process
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12.3 Practical examples
12.3.1 Calculating memory footprint

The memory footprint per storage group results from the following data
» Memory footprint of acquisition channels +
» Memory footprint of time channel (relative and absolute time channel) +

» Memory footprint of header (description file)

Memory footprint of acquisition channels

Acqu. duration [s] x storage rate [1/s] x channel count x 2 Byte = memory footprint in Byte
Memory footprint in Byte / 1024 = memory footprint in kByte

Memory footprint of time channel (IPE:Clock = relative time channel)

Acqu. duration [s] x storage rate [1/s] x 4 Byte = memory footprint in Byte

Memory footprint in Byte / 1024 = memory footprint in kByte

Do not mix the time channel (relative) with the time stamp channel (absolute = Date, time). The time stamp

channel is only recorded if activated in storage group dialog.

Memory footprint of header file

The memory footprint of the header file depends on the size of acquisition configuration (channel count,
sampling rate, different data formats, ...) and cannot be defined by a general formula. The size of the header
file is usually much smaller so that it can be neglected. Exceptations are short acquisitions or acquisitions

with many channels at low storage rate (< 1 Hz).
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12.3.2 Linear signal scaling

The conversion of a raw value (binary value, e.g. in a CAN message) into a physical value (value with unit) is
effected with the scaling. IPETRONIK offers the scaling calculator and supports linear scaling with the line
equation as factor/offset or 2 point scaling.

The scaling of a voltage or current signal (sensor output) into a corresponding physical or percentage value
is effected in the same way. The following examples show the connections.
Mathematical basics for the linear equation

A
y

Point gradient form Two points form
y=m*x+b m = dy / dx
b=y-m*x

m = (y1 —y2)/ (x1 —x2)
m = Gradient (gain)
b = constant (offset) m = Gradient (gain)

Calculation and explanation
1. The linear equation y = m * x + b shows the mathematical connection.

2. Calculate the m gradient within any input range (signal) and the related output range (physical
value).

Calculate the offset b by using the x and y values for a known point.

Calculate, if required, further y values by using the corresponding x values and the equation, e.g. for
calculating the physical values for another input range (Channel min, max).
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Example pressure sensor

A pressure sensor has an output signal of -0.5 to 4.5 V in the acquisition range O ... 20 bar.
The voltage signal is converted to the physical value with the linear scaling.

O
O
O
x1 x2 y1 y2 m b’ b
4.5 -0.5 20 0 4 2 2

Example CAN raw value in the Word unsigned format als temperature

A temperature signal is a CAN message in the Word unsigned format. The value range of 0... 65535 (16 Bit)
corresponds to a temperature range of -50 °C ... +200 °C.

Please note that the output range has an offset of =50 °C. This must be respected at
calculating: (b’ = Offset without output offset, b = Offset + output offset).

x1 x2 y1 y2 m b’ b
65535 0 200 -50 0.0038147 0 -50
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Example CAN raw value in the Word signed format as temperature

A temperature signal is a CAN message in the Word signed format. The value range of -32768... 0 ... 32767
(16 Bit) corresponds to a temperature range of =50 °C ... +200 °C.

Please note that the output range has an offset of =50 °C. This must be respected at
calculating: (b’ = Offset without output offset, b = Offset + output offset).

O
@)
x1 x2 y1 y2 m b’ b
32767 -32768 200 -50 0.0038147 125.0019 75.0019
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12.4 Status messages
12.4.1 Most important status messages

Following message types are defined:

I Information W  Warning E Error D Debug

Type number: XXxX-XXX-XXXX

Number corresponds to the number of the type plate of M-LOG (entry in hw_descr.xml).

Wait max. 3min for write permission (power good)

M-LOG waits until CAPs are loaded (status message "Power good" from PIC). If status is “Power good®, data
is written to flash. If this status is nor reached, (PIC) switches off M-LOG after 3 min.

Power good

Message (from PIC) that CAPs are loaded.

Debounce remote signal 1000 ms
Remote signal must be on at least for 1 s to reach “ON* status. (Debouncing of remote signal)
Remote signal is detected as such if excitation > 6.5 V at PIN terminal:15 of PWR-IN/REM socket.

Watchdog active

PIC transfers control of M-LOG to TESTdrive.

Function: Testdrive cyclically describes a storage range in Powermanagement (PIC) (toggling bit). If
this toggling fails for more than two minutes, M-LOG is switched off by Powermanagement
(PIC).

Free disk space: xxx/xxx

Indicates the available total memory space. TestDrive 3.09 shows a "Free disk space: xxxx" at the left
bottom display window. It shows the available space for data storage (40% of total memory space). Initially,
this value fluctuates intensively but stabilizes with a longer acquisition because it is recalculated
permanently.

Time left: xx xx:xx:xx

Display bottom left in monitor window. Meaning: d hh:mm:ss

Power bad
If excitation is too low, status is “Power bad”.

Info: This message is not concerned with CAPs contrary to "Power good" message.

Can’'t initialize communication mediums

Dev_conf.xml is not included in Config, i.e. no data transfer activated.

Shutdown in 55 min

If data postprocessing (zipping, establishing, data transferring, data sending, etc.) is not completed within 55
min, Testdrive shuts down and data remains on logger.

Emergency shutdown in 60 min

Logger is unconditionally shut down after 60 min. Powermanagement of M-LOG controls the device.
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Time left: xx xx:xx:xx

Display bottom left in monitor window. Meaning: d hh:mm:ss

Power bad
If excitation is too low, status is “Power bad".

Info: This message is not concerned with CAPs contrary to "Power good" message.

Can’'t initialize communication mediums

Dev_conf.xml is not included in Config, i.e. no data transfer activated.

Shutdown in 55 min

If data postprocessing (zipping, establishing, data transferring, data sending, etc.) is not completed within 55
min, Testdrive shuts down and data remains on logger.

Emergency shutdown in 60 min

Logger is unconditionally shut down after 60 min. Powermanagement of M-LOG controls the device.

12.4.2 Warning and error messages after program update

Program options without license

TESTdrive Version 3.17 includes a license software to check the use of logger / TESTdrive options. This
requires sending new license keys to the logger.

After a TESTdrive program update, potential warning messages can indicate locked options. TESTdrive
checks if used functions are really unlocked on the logger. Following warning is written into log file if e.g. all
inputs of a card with 4 CAN inputs is used but only 2 are unlocked.

01.04.2009 14:11:45 W CAN1 : Upper limit of licenced CAN interfaces reached. Max= 2

Please contact the sales team at +49 7221 / 9922 — 222 to assist you with warning and error messages, as
well as, licensing.

TESTdrive V03.22 deactivates the non-licensed functionality and warns with the red status LED
(temporarily at acquisition start). Depending on the missing license, acquisitions are limited
(e.g. possible calculations but no classification) or disabled (e.g. at missing license for
interface).

If an extender is used at the logger, an additional license for the extender is required!

The system shows the following warning if an extender is used with a non-licensed CCP protocol:
16.02.2011 15:36:01 E Extender.80200011: Error reading XML-Buffer at line 11
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12.5 Description of TESTdrive files

TESTdrive provides the measurement files as zip archives. TESTdrive creates separate zip files for every
acquisition:

MEA_xxxx.zip (Acquisition data + header file + current configuration)
LOG_xxxx.zip (Protocol file for data acquisition)

A data set of an acquisition always includes a header file (AABBCCC.DAT), at least one acquisition file in
DIAdem format, as well as, the corresponding acquisition configuration (e.g. IPEmotion.isf).

The names of the single acquisition files are generated according to

the AABBCCCC.DDD structure: After reaching the consecutive file

AA = Data type number 9999 (CCCC), counting starts
again with 0001!
BB = Consecutive number allocated based on all
data types used with the configuration If the file with this number still exists, it
is overwritten with new data!
CcccC = Consecutive number of an acquisition
DDD = File extension

AA data type indicates the type of data:

DO = Data Online (storage group with time channel)

PM = Post Mortem data of a ring buffer group (storage group with time channel)

co = (C) Classification Online (storage group with statistic data, without time reference)
A0 = Audio Online

Vo = Video Online

J = Job data = Diagnostic data

ST = Min-Max list

TBQS, T = CAN/LIN traffic acquisition (during or after boot process)

MV = Maneuver recording

The consecutive BB number clearly assigns data within one data type. Several storage groups for instance
can be detected with real-time data, which are distinguished from each other by this number.

The consecutive CCCC number differentiates between single acquisitions. Each acquisition is therefore
clearly defined.

The DDD file extension defines the data format as follows:

DAT = DIAdem header file

T64 = DIAdem time channel with 64 bit resolution

w8 = DIAdem data with 8 bit unsigned (BYTE)

w16 = DIAdem data with 16 bit unsigned (WORD)

W32 = DIAdem data with 32 bit unsigned (WORD)

116 = DIAdem data with 16 bit signed (INTEGER)

132 = DIAdem data with 32 bit signed (INTEGER)

R32 = DIAdem data with 32 bit in floating point displaying (REAL)
R64 = DIAdem data with 64 bit in floating point displaying (REAL)
WAV = Audio file in WAV format

AVI = Video file in AVI format

Ccsv = Comma Separated Values

Jxx = Binary file with job result
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Recorded signals are divided into different files accordingly to data typet, i.e. all 8 bit signals unsigned are in
a *.Wa8 file, all 32 bit signals signed in a *.I132 Datei, etc.

Important advices:

TESTdrive defines the number of the storage group during the initialization process. An assignment of the
storage group number to the order in the configuration interface is not given.

All information of a storage group is stored in the DAT file. The DAT file has a 8 bit ASCII format (ANSI code
page 1252, ISO 8859-1).

The storage group name can be defined with IPEmotion and is also stored in the DAT file.

All project information are stored in the DAT file (vehicle no., project name, etc.). At working with
classifications, the DAT file contains additional fields to define the classification in detail.

12.5.1 Data types

Time-related data (Storage group)

The header file and the corresponding data files are created for every storage group (= signals with common
storage rate).

Example (Acquisition no. 699 > DOBBCCCC.DDD)

Storage group 1 DO010699.DAT Header
DO010699.R32 32 Bit (Real)
DO010699.W16 16 Bit (Word unsigned)
DO010699.W32 32 Bit (Word unsigned)
Storage group 2 D0O020699.DAT Header
D0O020699.W8 8 Bit (Byte unsigned)
D0O020699.W32 32 Bit (Word unsigned)
Storage group x DO0x0699.DATHeader
DO0x0699.W8 16 Bit (Word unsigned)
Statistics

TESTdrive saves classification data in DIAdem format, which includes all parameters in one header file. This
header file includes additional information about classification description. Corresponding to the storage
groups and the general DIAdem conventions, binary data is included in the same files. These files are
separated accordingly to data type and are defined by an extension corresponding to data type, e.g. *.W32,
*.R64.

The results of several classifications of the same data type are stored in one binary file. Most classification
types create results of the W32 data type. The retention time classification can create different data types.

Example (Acquisition no. 699 > COBBCCCC.DDD)

Header CO010699.DAT Header
Classification m ... n CO010699.W32 32 Bit (Word unsigned), can include several
classifications
C0O010699.R64 64 Bit (Real), can include several classifications
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Audio recording
A DIAdem acquisition and one or several audio files (WAV format) are created with an audio recording.
The DIAdem acquisition contains the trigger event, the WAV file includes the audio data.

Every audio file is assigned to one triggering event. The names of the audio files include the counter value of
the trigger channel to create a direct reference within the acquisition data. The respective audio file is
recorded for the time of an activated trigger.

Example DIAdem file (Acquisition no. 699 > A0O00CCCC.DDD)

Trigger channel AO0000699.DAT Header

A0000699.W16 16 Bit (Word unsigned)

Example audio file (Acquisition no. 699 > ABBBCCCC.WAV)

Audio sequence 1 A0010699.WAV Audio data of 1. trigger event
Audio sequence 2 A0020699.WAV Audio data of 2. trigger event
Audio sequence x A00x0699.WAV Audio data of 3. trigger event

Video recording

A DIAdem acquisition and one or several video files (JPG = single image or AVI = video sequence) are
created with an video recording.

The DIAdem acquisition contains the trigger event, the JPG or AVI file includes the video data.

Every video file is assigned to one triggering event. The names of the video files include the counter value of
the trigger channel to create a direct reference within the acquisition data. The respective video file is
recorded for the time of an activated trigger. Exactly one single image is saved per trigger event,
independent of the trigger duration.

Example DIAdem file (Acquisition no. 699 > V000CCCC.DDD)

Trigger channel 1 (Video) V0000699.DAT Header
V0000699.W16 16 Bit (Word unsigned)
or
Trigger channel 1 (Image) I0000699.DAT Header
10000699.W16 16 Bit (Word unsigned)

Example video file (Acquisition no. 699 > VBBBCCCC.AVI)

Video sequence 1 V0010699.AVI Video data
Video sequence 2 V0020699.AVI Video data
or

Image 1 10010699.JPG Image data
Image 2 10020699.JPG Image data
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Diagnostic acquisition
Error memory and non-recurring data

TESTdrive creates additional files for error memory and non-recurring data. This CSV file (BDJDcccc.CSV)
is an overview and includes all information about the completed jobs. Every successful job is saved in a
binary file (BDS1cccc.Jxx), which contains the actual data.

A CSV file**, as well as, the corresponding jobs are created after the completed acquisition of UDS services.
** A CSV file is only created in binary mode, not in trace modeT.

The names of the single acquisition files are generated according to BDPECCCC.DZZ structure:

BDPECCCC.Dzz with P = U (UDS protocol), P = K (KWP protocol)
BDPECCCC.Dzz with E = ECU number (1 ... 9)

BDPECCCC.DzZzZ with D = J (Job or binary file), D = T (Trace file)
BDPECCCC.Dzz with ZZ = Job number (01 ... 99)

Example non-recurring data (Acquisition no. 699 > BDPECCCC.DZZ)

Trace file BDU10699.T01 UDS protocol, ECU no. 1, Acquisition no. 699, Job no. 1
Binary file BDU10699.J01 UDS protocol, ECU no. 1, Acquisition no. 699, Job no. 1
CSV file BDJD0699.CSV Job overview of binary files

Measurement status file

Measurement status file in XML format offers information about the process of a completed acquisition. This
includes:

- Acquisition start and stop (... in standardized XML format “DataTime”)
- General system information (hardware, TESTdrive version,...)

- Storage group trigger

- Acquisition / Diagnosis information

- Limit violations

- Maneuver detection

Measurement status file is created after acquisition stop and is stored in the zip container of the acquisition
(MEA_xxxx.zip) or attached to the status e-mail if this file creation has previously been activated in
IPEmotion Options > Plugins > IPETRONIK LOG > Plugln specific settings > Options > General >
Create measurement status file.

Example Measurement status file (measurement number 699 > MSxxyyyy.xml)
xx = Append number, yyyy = Measurement number

Measurement status file 1 MS010699.xml
Measurement status file 2 MS020699.xml

If an acquisition is later continued (Append mode), TESTdrive increases the append number in the file name.
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Min-Max list (STG file)

TESTdrive creates a separate statistic file (STG file) to record minimum and maximum values as well as first
and last valid value of selected signals. The STG file is created at the end of each measurement, if the
Logger processing contains a Statistic group containing at least one channel. The statistic file is stored in
the zip container of the acquisition (MEA_xxxx.zip)

Example STG file (Acquisition no. 699 > STBBCCCC.STG)

STG file 1 ST010699.STG Min / Max data of storage / process group 1

STG file 2 ST020699.STG Min / Max data of storage / process group 2

Traffic recording (CAN, LIN)

TESTdrive saves traffic acquisitions in binary format. A traffic acquisition can include two binary files:
- Traffic data recorded by TESTdrive during boot time

- Traffic data recorded by TESTdrive during run time

Advice: Storage of CAN traffic data and LIN traffic data in the same file

The names of the single acquisition files are generated according to TBBBCCCC.BIN structure:

TBBBCCCC.BIN Traffic data recorded by TESTdrive
TBBBCCCC.BIN Consecutive number within an acquisition
TBQSCCCC.BIN Traffic data recorded by micro controller

Maneuver recording
TESTdrive creates a file in ASCII format for maneuver recordings.

The maneuver file functions like a storage group, i.e. the file receives a consecutive number within the
acquisition.

The names of the single acquisition files are generated according to MVBBCCCC.ASC structure:

MVBBCCCC.ASC Name of respective storage group

Example (Acquisition no. 699 > MVBBCCCC.ASC)

Storage group 1 DO010699.DAT Header
DO010699.116 16 Bit (Integer signed)
Storage group 2 DO020699.DAT Header
D0020699.R32 32 Bit (Real)
Maneuver file MV030699.ASC
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